Learning about the Lafayette Polygraph System

Contents

Taking a tour Read this section to become acquainted with the Lafayette Polygraph System.

Using the polygraph system Read this section to learn how to use the Lafayette Polygraph System. Be sure to read Getting Started! to see what you must do to give a polygraph test from start to finish.

Troubleshooting Read this section if you encounter any problems and need quick corrective actions.

Polygraph FAQ Link to polygraph frequently asked questions on the Lafayette Instrument website.

What are the hardware and software requirements?
The Lafayette Polygraph System consists of the following three components:

The PC and software

The Data Acquisition Subsystem (DAS) and sensors

The printer

The PC and Software

The Lafayette Polygraph System consists of a PC running Windows and its peripheral devices. The PC has an optional internal floppy drive (local secondary drive), an internal hard disk (local primary drive), monitor, keyboard, and mouse. The high-resolution monitor provides optimum chart display. The keyboard offers a set of arrow keys, a numeric keypad, and a row of function keys. The mouse can be used to scroll through screens, access pull-down menus, and perform editing functions.

You use the PC and software to create and open polygraph files (PFs), enter and store biographical and exam information, create and edit question templates, record physiological data and print charts and reports.
The Data Acquisition Subsystem (DAS) and Sensors

The DAS is used in conjunction with the PC to record examination chart data by converting physiological signals to digital form. The DAS receives input from the pneumatic respiratory sensors (P1 and P2), the cardio sensor, the EDA sensor, and the auxiliary (e.g., movement) sensors. The DAS then sends the input to the workstation to be recorded and displayed. Before you can record charts, the DAS must be connected to the PC. If it is not connected, you can review and edit existing examination data as well as create new files, but you cannot record new charts.

The following are minimum hardware requirements:

- 1 GHz 32-bit (x86) or 64-bit (x64) processor
- 1 GB of RAM system memory
- 40 GB hard drive (at least 15 GB of available space)
- Windows® 2000, XP or Vista operating system (Windows XP or Vista recommended)
- Super VGA (1024 x 768)
- Support for DirectX 9 graphics with:
  - WDDM Driver
    - 128 MB of graphics memory
    - Pixel Shader 2.0 in hardware
    - 32 bits per pixel
- DVD-ROM or DVD-RW drive
- Audio Output
- Keyboard and Microsoft® Mouse or compatible pointing device
- Available USB Port(s)
- Digital sound card required for multimedia capabilities
- Digital video camera required for video capture.
  - Logitech web camera recommended
- External Microphone may be required for recording audio
The LX4000 comes with the following components:

- LX4000 Data Acquisition System (DAS)
- LXSOFTWARE LX Polygraph Software Including, the Objective Scoring System (OSS) and the Lafayette Drug Reference
- APL’s POLYSCORE® Scoring Algorithm
- Comprehensive Instruction Manual on CD-Rom
- 76513-1G Pneumo Chest Assembly, Gold
- 76513-2B Pneumo Chest Assembly, Bronze
- 76640SO Disposable Ag/AgCl EDA GSR Electrodes
- 76530 Standard Blood Pressure Cuff
- 76506LX Pump Bulb w/ Gauge
- 76642Sp EDA Snap-On Electrodes(Set of Two)
- All Necessary Cabling

You may also use the following optional equipment with the DAS:

- Countermeasure Detection System 76876US
- Fingerprint reader (USB or PCMCIA)
- Web cam, camcorder, or Digital Video Recorder for audio/video capability.
- Piezo Activity Sensor Model 76878US

**Sensors**

Sensors are the detection devices that are attached to the subject and connected to the DAS for input to the Lafayette Polygraph System workstation. You'll work with the following sensors:

**LX5000**

- P1 (Abdominal Respiration)
- P2 (Thoracic Respiration)
- GSR (GSR electrodermal)
- GSR Detrended (GSR electrodermal with the "detrending" filter applied)
- GSC (GSC electrodermal)
- GSC Detrended (GSC electrodermal with the "detrending" filter applied)
- PLE (Plethysmograph)
- **Cardio** (Cardiovascular)
- **Feet** (Feet movement)
- **Seat** (Seat movement)
- **Arms** (Arm movement)

**LX4000**

- P1 (Abdominal Respiration)
- P2 (Thoracic Respiration)
- EDA (GSR electrodermal)
- EDA Detrended (GSR electrodermal with the "detrending" filter applied)
- **Cardio** (Cardiovascular)
- Aux 1 (Auxiliary 1, typically Movement)
- Aux 2 (Auxiliary 2, typically Countermeasure)
- Aux 3 (Auxiliary 3)

**LX5000**

The LX5000 differs from the LX4000 in that the LX5000 consists of small individual modules containing one or more sensors. Whereas, the LX4000 was one module with a fixed number of sensors, the LX5000 is expandable. To add new sensors, just connect another module. When new or improved sensors become available, just the individual
sensor module needs to be purchased instead of buying the entire set of sensors. This allows for easy and inexpensive hardware upgrades.

The LX5000 is a new data acquisition system which provides a suite of individual, highly-configurable modules for measuring physiological responses. The LX5000 provides the following benefits:

- Choice of cutting edge wireless Bluetooth technology or wired USB connectivity on the same module.
- Simultaneous recording of an unlimited number of channels.
- Small, compact design makes transport and storage easy.
- The modular design is completely expandable, allowing for easy and inexpensive hardware upgrades.
- Data sampling rate up to 360 samples per second across all channels.
- 23-bit analog to digital conversion of physiological measurements.
- Extended measurement ranges.
- Wireless module includes rechargeable lithium ion battery.
- Rugged design, yet lightweight.
- Available modules: cardio, electronic pneumograph, pneumatic pneumograph, GSR/PLE, and activity with other modules forthcoming.
- Enclosure with an LX4000 form factor for mounting modules if desired.
- Simultaneous operation of the LX4000 and LX5000 modules.

As mentioned above, the LX5000 consists of individual DAS sensors connected to the computer via USB cables or via wireless Bluetooth technology.

The Bluetooth protocol provides a way to wirelessly connect and exchange information between electronic devices over a secure, short-range radio frequency. A computer must have a Bluetooth adapter in order to be able to communicate with other Bluetooth devices (such as DAS sensors). While some desktop computers and laptops already contain an internal Bluetooth adapter, most require an external Bluetooth dongle which connects to a computer's USB port.

**Note:** Please note in order to use Bluetooth, your computer must first have either an internal or external Bluetooth adapter and be configured to support it. Please consult the adapter's documentation to configure Bluetooth on your computer.

The LX5000 DAS sensors consist of two parts, the sensor and the wireless adapter. The sensor can be connected to the computer via USB cables or via wireless.
**LX5000 - Wired**

The LX5000 may be used in either the wired or wireless configuration. The wired configuration does not use the wireless adapter. Instead, one module is connected to the computer with a USB cable. The DAS modules are interconnected to each other by using a DAS connector cable as seen below.

**Wired Configuration Hardware Requirements**

To use the LX5000 in the wired configuration, the following hardware requirements must be met:

- One or more LX5000 DAS modules
- DAS sensors
- USB cable
- DAS connector cables

**Wired Configuration Setup**

To use the LX5000 in the wired configuration, perform the following steps:

1. Connect the USB cable to the computer.
2. Connect the USB cable to the top of one of the LX5000 DAS modules.
3. Starting with the LX5000 DAS module connected to the USB cable, connect all of the modules together using the DAS connector cables to form a chain of modules.
   - Note: The DAS modules and the connector cable contain two different size connectors, so the larger connector of one DAS will be connected to the smaller connector of the next DAS.
4. Connect the individual sensors to the DAS modules.
5. Attach the sensors to the person being tested.
6. Start LXSoftware and verify that the sensors are connected properly.

The following picture shows a LX5000 DAS module with the two connector types on the top.

**LX5000 - Wireless**

The wireless configuration uses the wireless adapters to send data directly to the computer. The individual DAS modules are not interconnected. Instead, each DAS module has a wireless adapter that snaps onto the module and transmits the data.
Wireless Configuration Hardware Requirements

To use the LX5000 in the wireless configuration, the following hardware requirements must be met:

- One or more LX5000 DAS modules
- DAS sensors
- A wireless adapter for each DAS module
- Fully-charged lithium-ion batteries for each wireless adapter
- Internal or external Bluetooth adapter to receive the data transmitted by the LX5000 wireless adapter
  - An inexpensive external Bluetooth adapter, such as the Kensington Bluetooth USB Adapter 2.0, may be purchased through any computer retail store

Bluetooth Requirements

To use the LX5000 in the wireless configuration, the host computer must have Bluetooth capability. See “Configuring Wireless Devices” on page 10 for details on configuring Bluetooth.

Wireless Configuration Setup

To use the LX5000 in the wireless configuration, perform the following steps:
1. First, make sure that a fully charged battery is placed in the wireless adapter.

2. Slip the wireless adapter over the DAS module until it clicks into place.

3. Turn the adapter on by pressing the power button until the power status LED flashes red then green. The adapter is now on and ready to use.

4. Pair the LX5000 device with the computer's Bluetooth adapter. See "Configuring Wireless Devices" on page 10. Bluetooth devices must first "pair" with one another in order to communicate.
   - Every LX5000 wireless adapter device must be paired with the host computer.
   - This is a one-time process and does NOT need to be performed every time.

5. Start LXSoftware and verify that the sensors are connected properly.
Note: A **Devices** menu has been added to LXSoftware to perform a restart of all devices, to configure wireless devices, and to check the LX5000 module battery levels.

**LX5000 Module Technical Specifications:**

<table>
<thead>
<tr>
<th>Wired (USB) module</th>
<th>Wireless (Bluetooth®) module</th>
<th>Wired (USB) module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size:</td>
<td>1 7/8&quot;W x 1 7/16&quot;D x 2 5/16&quot;H (4.76cm x 3.65cm x 5.87cm)</td>
<td>1 7/8&quot;W x 1&quot;D x 2 5/16&quot;H (4.76cm x 2.54cm x 5.87cm)</td>
</tr>
<tr>
<td>Weight:</td>
<td>0.20 lbs (90g)</td>
<td>0.10 lbs (45g)</td>
</tr>
<tr>
<td>Power Requirements:</td>
<td>Li-Ion rechargeable battery</td>
<td>Receives all required power through USB connection</td>
</tr>
<tr>
<td>Transfer rate:</td>
<td>up to 360 samples per second</td>
<td>up to 360 samples per second</td>
</tr>
<tr>
<td>Resolution:</td>
<td>23-bit analog to digital conversion</td>
<td>23-bit analog to digital conversion</td>
</tr>
<tr>
<td>Temperature:</td>
<td>Operating: 50°F to 95°F (10°C to 35°C), Storage: -40°F to 115°F (-40°C to 46.1°C)</td>
<td>Operating: 50°F to 95°F (10°C to 35°C), Storage: -40°F to 115°F (-40°C to 46.1°C)</td>
</tr>
<tr>
<td>Relative Humidity:</td>
<td>20% to 95% Non-condensing</td>
<td>20% to 95% Non-condensing</td>
</tr>
</tbody>
</table>

**LX5000 Module Sensor Inputs:**

<table>
<thead>
<tr>
<th>Module</th>
<th>Inputs</th>
<th>Type / Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cardio</td>
<td>1</td>
<td>0 to 150 mmHg</td>
</tr>
<tr>
<td>Electronic Pneumo</td>
<td>2</td>
<td>upper and lower chest assembly</td>
</tr>
<tr>
<td>Pneumatic Pneumo</td>
<td>2</td>
<td>upper and lower chest assembly w/ extended pressure range</td>
</tr>
<tr>
<td>GSR / PLE</td>
<td>2</td>
<td>GSR: 8μA constant current, range of 10 K to 2.0 Mohms, 2 KV RMS Isolation; PLE finger clip: 0.1 second time constant, 635 nm</td>
</tr>
<tr>
<td>Activity Sensor</td>
<td>3</td>
<td>0 to 4V Analog Input</td>
</tr>
</tbody>
</table>

**Configuring Wireless Devices**

The LX5000 consists of individual sensors connected to the computer via USB cables or via wireless Bluetooth technology.

The Bluetooth protocol provides a way to wirelessly connect and exchange information between electronic devices over a secure, short-range radio frequency. A computer must have a Bluetooth adapter in order to be able to communicate with other Bluetooth devices (such as DAS sensors). While some desktop computers and laptops already contain an internal Bluetooth adapter, most require an external Bluetooth dongle which connects to a computer's USB port.
Note: Please note in order to use Bluetooth, your computer must first have either an internal or external Bluetooth adapter and be configured to support it. Please consult the adapter's documentation to configure Bluetooth on your computer.

Bluetooth USB Adapter 2.0

Once Bluetooth is configured on your computer, Bluetooth devices must first “pair” with one another in order to communicate. When this happens, the two devices join what is called a “trusted pair.”

The steps involved in pairing are shown below. This is a representative example that will vary per manufacturer of the Bluetooth adapter.

Windows XP Representative Example:

To pair your computer with a wireless DAS sensor:

1. **Turn on the DAS sensor.**
2. If an external Bluetooth adapter is used, then plug it into a USB slot in the host computer.
3. Open your computer’s Bluetooth adapter and select “Find Bluetooth Devices.” Your computer searches for other Bluetooth-enabled devices in the vicinity.

![](image)

3. Your computer detects the wireless DAS sensor. Double-click the sensor icon and enter the requested passkey or PIN. The passkey is a simple code shared by both devices to prove that both users agree to be part of the trusted pair. **Enter the passkey (PIN) 0000.**
4. The wireless DAS sensor accepts the passkey and is now paired with your computer.

5. Select OK.
   
   Once you have paired the DAS sensor with your computer, you must then configure wireless support within LXSoftware. To enable wireless support and search for wireless devices in LXSoftware:

1. Select the **LX5000** as the "Type of DAS" in the Administrator Preferences window.
2. Select the wireless link within the Administrator Preferences window or select **Configure Wireless Devices...** from the **Devices** main menu within the LXSoftware window.

3. The "Configure Wireless Devices" window appears.
4. Select **Yes** to enable wireless support.

5. Select **Search** to search for the wireless DAS sensors.

6. Available sensors will appear in the Device box. If they do not appear, verify that the sensors are turned on and have been paired by selecting "Device Manager."
7. Select **Save** to save the changes or **Cancel** to discard the changes.

**Note:** A Devices menu has been added to LXSoftware to perform a restart of all devices, to configure wireless devices, and to check the LX5000 module battery levels.

---

**The Printer**

You can use a printer to print text, such as biographical data, exam data or reports. You can also print graphics such as physiological chart data. The Lafayette Polygraph System supports a wide selection of Windows printers.

---

**Taking a Tour of the Lafayette Polygraph System**
The Lafayette Polygraph Workstation provides a state-of-the-art polygraph system with all the benefits of a modern personal computer (PC). The Lafayette Polygraph System closely emulates the familiar chart and pen instruments; plus, it introduces the advanced capabilities of a high-speed PC in a user friendly manner. The Lafayette Polygraph System was designed with new computer users in mind; therefore, if you're new to the PC world, you'll have no problem adapting!

Be sure to read the following topics for a general introduction to the Lafayette Polygraph System.

- **What are some features and benefits of the Lafayette Polygraph System?**
- **What are the hardware and software requirements?**
- **What is a polygraph file?**
- **How is information stored?**
- **What is the Chart Display window?**

**What are some features and benefits of the Lafayette Polygraph System?**

The Lafayette Polygraph System utilizes the intuitive, graphical Windows interface and features pull-down menus, mouse capability to initiate commands and functions, easy-to-use dialog boxes, and context-sensitive help. Inexperienced users can learn to use the Lafayette Polygraph System quickly. Experienced users can take advantage of the advanced capabilities of the Lafayette Polygraph System.

The PC provides features unavailable with current analog polygraph systems:

- Physiological waveforms are converted to digital format, allowing them to be recorded and stored on high-density magnetic media (computer disks) rather than on long strips of chart paper.
- All the examination information, including biographical data, charts, and reports are stored on high-density magnetic media, reducing the need for paper files.
- The audio and video can be recorded for the entire examination without gaps. The resulting file becomes an integral part of the examination. When the audio/video file is replayed, it is synchronized automatically with chart playback as appropriate.
- All previously recorded chart sensor data can be displayed and reviewed.
- Sensor Controls provide the ability to adjust the gain for a specific chart trace.
- On-screen buttons, function keys, and user-selectable keystrokes provide alternate methods for entering data and selecting commands.

The benefits of the Lafayette Polygraph System include:

- High-resolution, real-time graphic display of physiological waveforms
High-capacity storage capabilities for subject data and chart waveforms

High-speed networking operation

Customizable chart, trace, examination, and administrator preferences

Advanced printing capabilities

What is a polygraph file?

A polygraph file (PF) is a folder containing a variety of essential information about a test subject and polygraph test results. The PF contains biographical\(^1\) (personal history) information, exam\(^2\) information, questions\(^3\) you've asked, charts\(^4\), that have been recorded, reports\(^5\), that have been generated, as well as any notes in the PF Notes. Optionally, the PF will also contain audio/video files you have recorded as well as fingerprint information for the subject. The PF is the primary element for conducting a test; you must open a PF to use most of the Lafayette Polygraph System functions.

![PF Folder Diagram]

Before beginning a polygraph test, you must either create or open a PF for the subject. Everything about the subject's test is saved in the PF folder. If a PF is open, the PF name appears in the title bar.

**Note:** If a PF is not open, some of the menus are dimmed and unavailable.

How is Information Stored?

All the information on your PC is stored on the hard disk. Think of a hard disk as a type of filing cabinet. Folders are used to store groups of similar information, much like a folder in a filing cabinet. Each folder can contain one or more files or other folders. You

\(^1\) The Personal History contains biographical information about the subject. In the Personal History dialog box, supply information such as Name, Description, and Date of Birth.

\(^2\) PF (polygraph file). Each exam can have multiple associated charts.

\(^3\) A list of questions you ask the subject to answer while recording his or her polygraph chart. Several question templates come with the Lafayette Polygraph System; however, you can also create a new set of questions. You can ask the questions in the set in any order.

\(^4\) A collection of questions, sensor (chart) responses, etc. displayed on the screen between time and amplitude grid marks. All charts for the current PF (polygraph file) are listed in the Chart menu.

\(^5\) The Final Report is automatically generated from a report template. You can edit this document to include test results and comments that pertain to the examination.
can store different types of files in the same folder, such as text documents, graphics, and applications.

The Lafayette Polygraph System files are organized in several folders on the hard disk. For example, question template files are stored in the folder labeled QUESTMPL. The Final Report Template is stored in the folder called rptinfo.

**Note:** To view the contents of a folder, double-click on the folder icon.

For a graphical representation of your hard disk, switch to the **Windows Explorer**.

**For Windows Vista:**
1. From the Windows desktop, use the right mouse button to click on the Start Button.

2. Select the **Explore** menu item. The **Windows Explorer** window opens with a graphical representation of all folders and files on your hard disk. Double-click a folder to view its contents.
For Windows XP:

1. From the Windows desktop, use the right mouse button to click on the Start Button.

2. Select the Explore menu item. The Windows Explorer window opens with a graphical representation of all folders and files on your hard disk. Double-click a folder to view its contents.
What is the Chart Display Window?

The Chart Display window is the **first window** you see when you start the Lafayette Polygraph System. You’ll work with the Chart Display window more than any other window in the Lafayette Polygraph System.

The graphic that follows shows the Chart Display window:

Look in the window’s title bar to identify the **PF**\(^6\).

Look to the far right of the window to identify the sensor controls. You use the sensor controls to reposition a chart trace or adjust the gain for a specific chart trace manually. [Click here to learn more about the sensor controls.](#)

Look in the large center area to view the chart traces\(^7\) for each sensor control.

Look at the bottom of the window to see buttons and controls you’ll use when you record a chart.

---

\(^6\) A PF, or Polygraph File, contains all biographical information on the subject as well as all examination data categorized by exam.

\(^7\) Graphic display of physiological waveforms. Analogous to the ink traces produced on the long strips of chart paper by the mechanical recorder.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question Text</td>
<td>Activate the question text popup menu by right-clicking on the question text in the chart recording window. The menu provides the following options:</td>
</tr>
<tr>
<td></td>
<td>Start Chart – Start recording a chart.</td>
</tr>
<tr>
<td></td>
<td>Stop Chart – Stop recording a chart.</td>
</tr>
<tr>
<td></td>
<td>Stop Question – Stop the question timer.</td>
</tr>
<tr>
<td></td>
<td>Center Traces – Center all chart traces simultaneously.</td>
</tr>
<tr>
<td></td>
<td>Speech Preview – If speech is enabled, select to have the computer speak the current question.</td>
</tr>
<tr>
<td></td>
<td>Speech Enable – Select to enable speech synthesis. When enabled, the computer will ask the questions during the examination and also during chart replay.</td>
</tr>
<tr>
<td></td>
<td>Speech Configure – Select to configure speech synthesis. This will open the Speech Synthesis preferences page.</td>
</tr>
<tr>
<td>Question Ordering control</td>
<td>Select the <strong>Question Ordering control</strong> (small black triangle) to toggle through all question lists associated with this question set.</td>
</tr>
<tr>
<td>Question Ordering grid</td>
<td>Click a Question ID to select a question.</td>
</tr>
</tbody>
</table>

**Note:** When a Question Set for a PF is not selected, the grid is blank.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question Set selector</td>
<td>Click on the open folder button to access the Question Manager and select a Question Set. A question set is a list of questions you ask the subject to answer while recording his or her polygraph chart. Several question templates come with the Lafayette Polygraph System; however, you can also create a new set of questions. You can ask the questions in the set in any order.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> Double-click on the edit box to the left of the open folder button to open the active question set for editing in the default question editor.</td>
</tr>
<tr>
<td>Start button</td>
<td>Click here to start recording.</td>
</tr>
<tr>
<td>Real-Time EDA Display</td>
<td>Real-time Electrodermal (EDA) measurement in Ohms as detected by the EDA sensor.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Real-Time Cuff Pressure Display</td>
<td>Real-time measurement of cardio cuff pressure as detected by the cardio sensor.</td>
</tr>
<tr>
<td>DAS type</td>
<td>Displays the currently selected DAS type. There are three selections:</td>
</tr>
<tr>
<td></td>
<td>LX5000</td>
</tr>
<tr>
<td></td>
<td>LX4000</td>
</tr>
<tr>
<td></td>
<td>SIM = DAS simulator.</td>
</tr>
</tbody>
</table>

### Starting the Lafayette Polygraph System

To start the Lafayette Polygraph System:

1. Ensure all components are plugged in.
2. Turn on the computer.
3. Double-click the LXSoftware icon on the desktop. The Lafayette Polygraph System starts and performs an optional **self-test**.

### Understanding the self-test

When you start the Lafayette Polygraph System, the system performs a self-test (if enabled in the Administrator Preferences). The self-test lasts several seconds and the system counts down the steps as they are performed. If any problems occur during the self-test, a message appears on the screen describing the problem and a corrective course of action.

When the self-test is finished, the **Logon** dialog box appears (provided the “Require User ID and password” option is enabled in the Administrator Preferences), and you’re ready to log on:

![Security](image)

**Note:** If the self-test fails, [exit the Lafayette Polygraph System](#). Check all cable connections before retrying.
Logging On

To log on to the Lafayette Polygraph System:

1. In the **User ID:** box, type your **assigned user ID.** The User ID is the logon name assigned to you by the system administrator which grants you access to the system when used in conjunction with the **Password.** Press the **Tab** key to move to the next field.

**Note:** The default user ID is **admin.** If you are the system administrator, you should **change the User ID** the first time you log on to secure your system.

2. In the **Password:** box, type your **assigned password.** The Password is the logon password assigned to you by the system administrator which grants you access to the system when used in conjunction with the User ID. The characters appear on the screen as bullets to protect your password from onlookers.

**Note:** The default password is **security.** If you are the system administrator, you should **change the password** the first time you log on to secure your system.

**Note:** Use alphanumeric characters only (i.e., letters and numbers). If you incorrectly enter a User ID or password three times, the system locks you out and you must contact the system administrator for assistance.

3. Press the **Logon** button (or press <Enter>). The LXSoftware menu bar appears at the top of the screen and the Chart Display window opens. The sensor traces being received from the DAS appear in the window. [Click here to learn more about the Chart Display window.]

**Note:** If you did not enter your user ID and password correctly, or if the system administrator has not registered you as a valid user, the Logon Attempt Failed dialog box appears: In this dialog box, either re-enter your user ID and password as described previously, or select **Quit** to exit the LXSoftware. You can re-enter your user ID and password only three times. After three failed attempts, the system locks you out and only the system administrator can gain access to the system. If you get locked out, the System Lock Out dialog box appears, and you must contact your system administrator.

Getting Started!

Conducting a polygraph test is easy when you follow these steps:

- **Step 1. Create a polygraph file (PF)**
- **Step 2. Enter the personal history information**
- **Step 3. Select a question set**
- **Step 4. Prepare the subject for the test**
- **Step 5. Enter the exam information**
- **Step 6. Record a chart**
Creating a PF

To create a PF:

1. Select New PF... <Ctrl + N> from the File menu. The New PF dialog box appears.

2. In the PF text box, enter a unique name. The name can be any legal Windows filename that is not a device name (e.g., COM, LPT). The name can contain embedded spaces but cannot contain any of the following characters: \ / : * ? " < > |. Note that the period character (.) can be part of the PF name but may not be the last character in the name.

3. Select OK to create a PF, or select Cancel to close the dialog box and ignore the New PF command.

If the PF name you entered already exists, a duplicate name message appears. At this point, repeat steps 1-3 and enter a unique name in step 2.

**Note:** After you create a PF, the Personal History dialog box appears (if the Personal History check box is selected in the Examination Preferences). You must enter biographical information about the subject in this dialog box.

What should I do next?

You're now ready to enter the biographical information in the Personal History dialog box.

**Note:** If a PF already exists on the hard drive, you can open it using the Open PF command.

Entering the Personal History Information

---

A PF, or Polygraph File, contains all biographical information on the subject as well as all examination data categorized by exam.
The first time you create a PF, the **Personal History tabbed dialog box** appears (if the “Require entry of Personal History” check box is selected in the Examination Preferences). Use this tabbed dialog to enter biographical information about the subject. The subject's age is entered automatically.

**Note:** You can display the Personal History dialog box for the **open PF** at any time by selecting **Personal History** from the **Exam** menu.

To fill in the Personal History tabbed dialog box:

1. Enter information in the spaces provided on each tab. The underlined fields on the **Identification** tab are required.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The subject's name. <strong>You must enter this field.</strong></td>
</tr>
<tr>
<td>Date of Birth</td>
<td>The subject's date of birth. <strong>You must enter this field.</strong> If a 2-digit year is entered, it is assumed to be relative to 1900.</td>
</tr>
<tr>
<td>Age</td>
<td>The subject's age at the time the Personal History was entered. This field is automatically calculated.</td>
</tr>
<tr>
<td>Aliases</td>
<td>Other name(s) by which the subject is referred.</td>
</tr>
<tr>
<td>ID Number</td>
<td>The identification number for this subject.</td>
</tr>
<tr>
<td>Case</td>
<td>The Case Number associated with this subject.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Driver’s License Number</td>
<td>The subject's driver's license number.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The state or province in which the driver's license was issued.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the driver's license was issued.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>The date on which the driver's license expires.</td>
</tr>
<tr>
<td>Description</td>
<td>The subject's physical description, such as hair color, eye color, height, etc.</td>
</tr>
</tbody>
</table>

2. Select the **Fingerprint tab** to scan or verify the subject’s fingerprint.

3. Select the **Signature tab** to scan or verify the subject’s signature.

4. Select the **Photo tab** to capture a still photograph of the subject.

**Note:** In order to use the fingerprint, signature, or photograph features within the Lafayette Polygraph System, fingerprint/signature capture hardware or digital video camera/web cam equipment must be purchased and installed separately.

5. Record any comments pertaining to the personal history in the **Comments tab** or in the **PF Notes**.

6. Review the information and correct any typographical errors.

7. When you are finished entering the biographical data, double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the window.

**Note:** If you did not enter the required information, a message box appears identifying the incomplete field:

Choose **Retry** to return to the Personal History dialog box to enter the required information.

Choose **Close** to close the message box and disregard any modifications made to the exam information. If the Personal History was displayed as a result of the **New PF** command, the PF will not be created.

---

**Printing a customized Personal History**

To print the open PF’s **Personal History**:
1. Select **Personal History** from the **Exam** menu to open the personal history. The **Personal History** window appears.
2. Select **Print <Ctrl + P>** from the **File** menu. The **Print All** dialog window appears.

![Print All dialog window](image)

3. The dialog lists all items within the open PF’s personal history. To select or deselect an item for printing, click on the checkbox next to the desired item. Alternatively, all checkboxes may be simultaneously checked or unchecked by selecting the **Select All** or **Clear All** buttons.
4. Select **Print** to print the checked documents; select **Close** when finished printing or to disregard the **Print** command.

**What should I do next?**

You’re now ready to select a question set.

**Fingerprint Scanning and Verification**

To scan a subject’s registration fingerprint:

1. Select the **Fingerprint** tab from the **Personal History**.
2. Have subject place finger on the fingerprint scanner.
   1. Center fingerprint on fingerprint sensor surface.
   2. Place finger flat on fingerprint sensor surface.
3. The scanner will scan the subject’s fingerprint. If the quality of the scanned fingerprint is low, rescan the fingerprint. Otherwise, fingerprint registration is successful.

**Note:** Digital Persona fingerprint scanners require 4 scans for registration.

Once the **Personal History** window is closed, the scanned registration fingerprint becomes the fingerprint of record. If the **Personal History** window is opened at a later time, the user has the option to verify the subject’s fingerprint.

**To verify a subject’s fingerprint with a previously scanned registration fingerprint:**

1. Select the **Fingerprint** tab from the **Personal History**.
2. Have subject place finger on the fingerprint scanner.
   a. Center fingerprint on fingerprint sensor surface.
   b. Place finger flat on fingerprint sensor surface.
3. The scanner will scan the subject’s fingerprint and verify it with the registration fingerprint.
4. Check the fingerprint verification. If the verification is successful, it will indicate “Fingerprints match.” If the verification is unsuccessful, it will indicate “NO Fingerprint match.”

**Signature Scanning**

To scan a subject’s registration signature:

1. Select the **Signature** tab from the **Personal History**. Make sure that the signature device is connected and ready.
2. Have the subject use the device's writing implement to enter his signature on the scanner's screen. If the signature is illegible or unacceptable, click **Clear Signature** to reenter the subject's signature. If the signature is acceptable, click **Save Signature**. The scanned signature becomes the signature of record for the subject.
Capturing Still Photographs

**Note:** For this feature to be enabled, a web cam or digital video camera must first be attached to your system and the *Enable LXSoftware audio/video capabilities* checkbox must be selected within the *Audio/Video Preferences*.

To capture a still photograph of the subject:

1. Select the **Photo** tab from the Personal History dialog.
2. Click the **Take Picture** button to capture a still photograph of the subject. The photograph will appear in the white square. Multiple photographs can be taken of the subject, with the count of photographs taken shown as **Pictures Taken**.

3. To review the photographs taken and to select a photograph for the subject’s Personal History, click the **Select Picture** button. This will scroll through the photographs taken. This button will only be enabled if more than one photograph has been taken of the subject.

4. Select the **Import...** button to import a photo from an external source into the Personal History. Photos may be in JPEG, GIF, or BMP (bitmap) format.

5. Once the desired photograph is selected, click on **Delete Other Pictures** to delete the unwanted photograph(s) from the Personal History.

6. Continue entering the Personal History.

**Selecting a Question Set**

To select a question set for an open PF:

1. Click on the "Open Question Set" button at the bottom of the screen. The **Question Manager** appears.
2. Select the desired question set from the Question Manager dialog and select the OK button. If you do not see a suitable question set, select the Edit button to modify the selected question set. Two question editors are provided, the LXQuestionEditor and the Legacy Question Editor. The Legacy Question Editor is familiar to users of LXSoftware prior to version 9.9.3. The LXQuestionEditor is new for version 9.9.3.

If using the LXQuestionEditor:

- edit an existing question set
- create a new question set

If using the Legacy Question Editor:

- edit an existing question set
- create a new question set

What should I do next?

You're now ready to prepare the subject for the test.

**Preparing the Subject for the Test**

Review the question set you just selected with the subject and note his or her responses. During the test, you must indicate whether the subject provided the expected response; therefore, you need to know what to expect!

What should I do next?

You're now ready to enter the exam information.

**Entering the Exam Information**

Entering exam information lets you create a new exam for the open PF. An exam stores charts recorded over a short period of time (usually one or two days). Exam information focuses on variables that might affect test results, such as lack of sleep, health problems, etc.

**Note:** When a subject is tested periodically, always create a new exam at the beginning of each polygraph session.

To create a new exam:

1. Select New Exam from the Exam menu. The Exam Info dialog box appears. The Examiner, Date, Start Time, and Stop Time fields are filled in for you.
2. Enter information in all applicable fields. Don't forget to use the scroll bar to reach all of the questions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Recorded</td>
<td>Used to indicate if the room audio is being recorded.</td>
</tr>
<tr>
<td>Room Monitored</td>
<td>Used to indicate if the room is being monitored.</td>
</tr>
<tr>
<td>Final Call</td>
<td>The Final Call is the determination made by the examiner as the result of an analysis of all examination data. Examples of typical Final Calls are Deception Indicated and No Deception Indicated.</td>
</tr>
<tr>
<td>Requester</td>
<td>The person, department, or agency requesting the test.</td>
</tr>
<tr>
<td>Location</td>
<td>The place the polygraph test is being conducted.</td>
</tr>
<tr>
<td>Sleep Soundly</td>
<td>Indicate if the subject slept soundly.</td>
</tr>
<tr>
<td>Normal Amount</td>
<td>The average number of hours the subject normally sleeps in a 24-hour period.</td>
</tr>
<tr>
<td>Amount Last 24 Hours</td>
<td>The actual number of hours the subject slept within the last 24 hours.</td>
</tr>
<tr>
<td>Breakfast, Lunch, Dinner</td>
<td>Indicate if the subject ate breakfast, lunch, and dinner.</td>
</tr>
<tr>
<td>Prior Polygraph Exam</td>
<td>Indicate if the subject has had a polygraph test. If yes, other information includes: When (date), By Whom, Why, Result</td>
</tr>
<tr>
<td>Prior Arrests</td>
<td>Indicate if the subject has been arrested. If yes, additional information includes: When (date), Location, Offense, Disposition</td>
</tr>
</tbody>
</table>

3. Review the information and correct any typographical errors.
4. Record any additional comments pertaining to the exam information in the PF Notes.

5. When you are finished entering exam data, double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the window.

**Note:** If an exam has already been created for the current PF, the New Exam Warning dialog box appears when you select New Exam from the Exam menu. If you select Continue to create a new exam, you will not be able to record another chart for a previous exam.

What should I do next?

You’re now ready to record a chart.

**Recording a Chart**

Before you record a chart, you must attach the response sensors to the subject and make sure the physiological sensors work properly.

**Attaching the response sensors**

To attach the response sensors:

1. Place the Thoracic Respiration (P2) and Abdominal Respiration (P1) sensors around the subject.
2. Place the EDA sensors on the subject’s fingers.
3. Place the Cardio cuff on the subject, but do not inflate it.
4. Verify that the Auxiliary sensors, if used, are in place.

**Note:** Now is a good time to test and adjust the gain for the individual sensors. Also, ensure the physiological sensors work properly. Inflate the Cardio cuff pressure to between 50 mmHg-135 mmHg, and check the sensor trace.

Please note that real-time cardio cuff pressure and Electrodermal (EDA) measurements are displayed in the status pane at the bottom of the chart recording window.

**Recording the chart**

To record a chart:

1. Press the Start button located in the bottom-right corner of the window. Alternatively, you may right-click on the question text within the chart window and select Start Chart.

**Note:** The Start commands will not work until you’ve selected a PF, a Question Set and an Exam.
2. Press <X> to annotate the start position, and tell the subject the test has begun. The **Start Announcement Annotation ID** appears on the chart.

3. If you do not want to ask the displayed question, select another question ID in the **Question Ordering grid** (bottom of window). Select the **Question Ordering control** (small black triangle) to select another question list within the selected question set. Clicking the control will cycle through each question list within the selected question set.

4. When you start to read the question, press the **Onset** button (or <numeric 0> or <spacebar>) and hold it down until you finish. A gray bar appears on the chart and marks the time it took to read the question.

5. **Annotate** the subject's response by clicking the + button (Yes) or the - button (No). The next question in the sequence appears at the bottom of the screen.

**Note:** You can also indicate the subject's response by pressing the + key or the - key on your keyboard; or press the **spacebar** to indicate the subject gave the expected response.

6. Wait until the progression timer is completely gray and the **Onset** button reappears. The progression timer shows you how much time you have between questions. You must wait until the timer runs out before you can press the
Onset button to begin the next question. You can adjust the progression time in the Set Question Timer field in the Chart Preferences.

**Note:** The current question timer can be stopped by double-clicking the question timer cylinder or by right-clicking the question text and selecting Stop Question from the popup menu.

7. Annotate the chart if necessary.

8. Repeat steps 3-7 for each question you want to record.

9. When you finish recording question responses, inform the subject the test is finished and press <X>. The Stop Announcement Annotation ID appears on the chart.

10. Press the Stop button. Alternatively you may right-click on the question text within the chart window and select Stop Chart.

**What should I do next?**

You are now ready to review the chart.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensors</td>
<td>Sensors are the detection devices that are <strong>attached to the subject</strong> and <strong>connected to the DAS</strong> for input to the Lafayette Polygraph System workstation. You'll work with the following sensors:</td>
</tr>
<tr>
<td><strong>LX5000</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• P1 (Abdominal Respiration)</td>
</tr>
<tr>
<td></td>
<td>• P2 (Thoracic Respiration)</td>
</tr>
<tr>
<td></td>
<td>• GSR (GSR electrodermal)</td>
</tr>
<tr>
<td></td>
<td>• GSR Detrended (GSR electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>• GSC (GSC electrodermal)</td>
</tr>
<tr>
<td></td>
<td>• GSC Detrended (GSC electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>• PLE (Plethysmograph)</td>
</tr>
<tr>
<td></td>
<td>• Cardio (Cardiovascular)</td>
</tr>
<tr>
<td></td>
<td>• Feet (Feet movement)</td>
</tr>
<tr>
<td></td>
<td>• Seat (Seat movement)</td>
</tr>
<tr>
<td></td>
<td>• Arms (Arm movement)</td>
</tr>
<tr>
<td><strong>LX4000</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• P1 (Abdominal Respiration)</td>
</tr>
<tr>
<td></td>
<td>• P2 (Thoracic Respiration)</td>
</tr>
<tr>
<td></td>
<td>• EDA (GSR electrodermal)</td>
</tr>
<tr>
<td></td>
<td>• EDA Detrended (GSR electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>• Cardio (Cardiovascular)</td>
</tr>
<tr>
<td></td>
<td>• Aux 1 (Auxiliary 1, typically Movement)</td>
</tr>
<tr>
<td></td>
<td>• Aux 2 (Auxiliary 2, typically Countermeasure)</td>
</tr>
<tr>
<td></td>
<td>• Aux 3 (Auxiliary 3)</td>
</tr>
<tr>
<td>Question to read</td>
<td>Lists the question to read in the following format:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **question ID (expected response) question** | 1 (No) Regarding that piece of paper under your leg, did you write the number 1?  
To change the font of the question text, right-click on the question text to display the Chart Preferences page. |
<p>| <strong>Question text menu</strong>        | Activate the question text popup menu by right-clicking on the question text in the chart recording window. The menu provides the following options:                                                                 |
|                              | Start Chart – Start recording a chart.                                                                                                                                                                      |
|                              | Stop Chart – Stop recording a chart.                                                                                                                                                                        |
|                              | Stop Question – Stop the question timer.                                                                                                                                                                    |
|                              | Center Traces – Center all chart traces simultaneously.                                                                                                                                                     |
|                              | Speech Preview – If speech is enabled, select to have the computer speak the current question.                                                                                                              |
|                              | Speech Enable – Select to enable speech synthesis. When enabled, the computer will ask the questions during the examination and also during chart replay.                                                     |
|                              | Speech Configure – Select to configure speech synthesis. This will open the Speech Synthesis preferences page.                                                                                           |
| <strong>Question ordering control</strong> | Select the <strong>Question Ordering control</strong> (small black triangle) to toggle through all question lists associated with this question set.                                                                     |
| <strong>Question ordering grid</strong>    | Click a Question ID to select a question.                                                                                                                                                                    |
|                              | <strong>Note:</strong> When a Question Set for a PF is not selected, the grid is blank.                                                                                                                                   |
| <strong>Question set selector</strong>     | Click on the open folder button to access the Question Manager and select a Question Set.                                                                                                                   |
|                              | <strong>Tip:</strong> Double-click on the edit box to the left of the open folder button to open the active question set for editing in the default question editor.                                                        |
| <strong>Start</strong>                    | Click here to start recording.                                                                                                                                                                              |
| <strong>Real-Time Cuff Pressure Display</strong> | Real-time measurement of cardio cuff pressure as detected by the cardio sensor.                                                                                                                           |
| <strong>Real-Time EDA Display</strong>     | Real-time Electrodermal (EDA) measurement in Ohms as detected by the EDA sensor.                                                                                                                           |
| <strong>DAS type</strong>                 | Displays the currently selected DAS type. There are three selections:                                                                                                                                       |
|                              | LX5000 = LX5000                                                                                                                                                                                             |
|                              | LX4000 = LX4000                                                                                                                                                                                             |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIM = DAS simulator.</td>
<td></td>
</tr>
<tr>
<td>Cardio</td>
<td>Cardio is the Cardiovascular sensor. The default abbreviation (the two characters that appear on the sensor control) is CA. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Cardio property page of the Preferences dialog.</td>
</tr>
<tr>
<td>EDA</td>
<td>EDA is the Electrodermal sensor. For historical reasons, the default abbreviation (the two characters that appear on the sensor control) is GS (Galvanic Skin Conductance). You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Electrodermal property page of the Preferences dialog.</td>
</tr>
<tr>
<td>P1</td>
<td>P1 is the default abbreviation assigned to the Pneumatic 1 sensor control. The P1 sensor produces the Abdominal Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Abdominal Respiration property page of the Preferences dialog.</td>
</tr>
<tr>
<td>P2</td>
<td>P2 is the default abbreviation assigned to the Pneumatic 2 sensor control. The P2 sensor produces the Thoracic Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Thoracic Respiration property page of the Preferences dialog.</td>
</tr>
</tbody>
</table>

**Reviewing a Chart**

To help you evaluate a subject's chart, you can review previously recorded charts at any time. To choose a chart to review:

1. Select Open PF (Ctrl + O) from the File menu.
2. From the list of PFs, select the PF name for the chart you want to review.
3. Select Chart 1 Exam 1 from the Chart menu (Chart 1 Exam 1 represents the correct chart number for a specific exam).

**Tip:** All charts for the currently open PF may be opened simultaneously by using the Open All Charts menu item under the Chart main menu.

As you select a chart for review, the chart is displayed. An associated examiner score sheet (if applicable) can be displayed.

You can toggle between the examiner score sheet and the Chart Review window.

To bring the Chart Review window to the front, click on it with the mouse.

To bring the score sheet to the front, press (Ctrl+A).

An alternative method of displaying the examiner score sheet is by right-clicking on the sensor trace portion of the Chart Review window. A floating popup menu is displayed from which the Examiner Score menu item may be selected to display the associated score sheet.

**Tip:** Click on a chart item to see a brief description at the bottom of the window.
Chart Playback

Previously recorded charts can be replayed using the VCR-style controls at the bottom right of the chart review window. Pressing the "Play" button starts the playback operation. During playback, the chart will scroll from the right edge of the window similar to when the chart was originally recorded. The chart will stop scrolling at the end of the playback. Press the "Stop" button to return the chart to the normal view.

While the playback is progressing, the "Fast Forward" button can be used to accelerate the rate of playback. When the "Fast Forward" button is pressed, the chart playback rate is doubled. Subsequent presses of the "Fast Forward" button cycle the playback rate between 1x, 2x, 4x, and 8x. To resume chart playback, press the "Play" button.

The "Home" button can be pressed during playback to restart the chart at the beginning. Pressing the "Pause" button toggles the video between pause and play mode.

If a chart has an associated audio/video clip, this clip will be replayed synchronized with the chart when the replay controls are selected.

Using the Chart Review functions

The Chart Review window is similar to the Chart Display window, but the Chart Review functions let you pick what part of the chart you see. For example:
Function Description

**Zoom** The **Zoom** controls let you choose how much of the chart to display in the Chart Review window, providing the ability to significantly magnify the detail with which a chart is displayed. This capability is available from the Zoom toolbar or by right clicking the chart display and selecting the desired zoom control from the popup menu. The following describes the options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Zoom Level</td>
<td>Displays sensor traces for approximately 70 seconds worth of data.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Provides four zoom out levels, including 50%, 33%, 25%, and All.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Provides four zoom in levels, including 150%, 225%, 300%, and 375%.</td>
</tr>
</tbody>
</table>

**Notes Present** The Notes Present bitmap button lets you open the PF Notes to review or record chart review notes.

**Video Present** The Video Present bitmap button lets you open an existing video associated with the current chart.

**Comment Present** The Comment Present bitmap button lets you open an individual chart comment for review.

Use the scroll bar to view the portions of the chart that exceed the window area. From the Question Ordering grid at the bottom of the window, you can select a specific question. Use the left and right arrows to display question IDs that exceed the display area.

**Tip:** To scroll through a chart, click anywhere on the chart and drag the mouse to the desired portion of the chart.

**Adjusting the gain**

When reviewing the chart, remember that the gain of each chart trace can be manually adjusted temporarily. The gain adjustments you make are active only while the PF is open. As soon as the PF is closed, the gain values are restored to their original startup values, as defined within the Trace Preferences. To adjust the gain:

1. Display the portion of the chart containing the chart trace you want to adjust.
2. Click on the sensor control for the appropriate trace.
3. Click the up and down arrows in the sensor control to increase and decrease the gain.

Alternatively, the gain may be adjusted by opening the Trace Preferences by double-clicking the sensor control.

**Adjusting the Trace Preferences**

The Trace Preferences for a chart can be modified while the chart is open during chart review. To modify a chart review sensor trace, double-click on the chart review sensor control for the appropriate trace. This will display the Trace Preferences property page.
Remember, any changes made in this fashion affect only the chart whose sensor control was double-clicked, and the change only applies as long as the chart is open.

An alternative method of displaying the Trace Preferences is by right-clicking on the sensor trace portion of the Chart Review window. A floating popup menu is displayed from which Trace Preferences may be selected.

**Reviewing the corresponding questions**

You can display the list of questions asked during a chart recording. To display the questions for a particular chart:

1. Select **Open PF** (Ctrl + O) from the **File** menu.

2. From the list of PFs, select the PF name for the chart you want to review.

3. Select desired question set name from the Chart Question Sets menu. The questions appear in the Question Editor dialog box.

**Measuring subject reactions using on-screen calipers**

You can measure the magnitude and duration of a subject reaction during chart review using a set of on-screen calipers. To display the Chart Review calipers:

1. Right-click on the sensor trace portion of the Chart Review window. A floating popup menu is displayed.

2. Select **Show Calipers** from the floating popup menu. A set of horizontal and vertical bars is displayed that may be used to perform on-screen measurements. Also displayed is a [Caliper Statistics](#) window showing statistics about the area selected by the calipers.

3. Click on any portion of the caliper to move it. As the caliper is moved, the measurements are updated both in the status pane at the bottom of the main window and in the Caliper Statistics window. In the status pane, reaction magnitudes are displayed in grid divisions, while reaction durations are displayed in seconds.

4. By selecting the area between the horizontal calipers, the vertical calipers, or the intersection of the horizontal and vertical calipers, the calipers can be moved as a single unit. This is useful when a fixed area is defined for the calipers, and they can then be dragged question-to-question to make measurements without the need to resize the calipers at each question.

**Note**: The vertical calipers may be locked via the caliper preferences to prevent resizing, so that moving one caliper causes the other caliper to move an identical amount. While reviewing a chart, it is possible to override the caliper lock if needed. To override, grab the caliper handle at the caliper endpoint and slide the caliper to the desired location. This allows the calipers to be moved individually despite the locked setting.

See [Setting Caliper Preferences](#) for more information.

**Tip**: The horizontal calipers can be moved a pixel at a time. To move the upper horizontal caliper, select `<Shift + Up Arrow>` or `<Shift + Down Arrow>`. To move the lower horizontal caliper, select `<Ctrl + Up Arrow>` or `<Shift + Down Arrow>`. 
To move the left vertical caliper, select <Shift + Left Arrow> or <Shift + Right Arrow>. To move the right vertical caliper, select <Ctrl + Left Arrow> or <Ctrl + Right Arrow>.

**Entering chart comments**

If you are the original examiner, you can enter a comment directly on the chart during chart review. To enter a chart comment:

1. Right-click on the sensor trace portion of the Chart Review window at the location where you want the comment to be displayed. A floating popup menu is displayed. Or, you may also enter a chart comment by double-clicking on the chart.

2. Select **Enter Comment** from the floating popup menu. A small window will be displayed in which a comment may be entered. This window may be resized or moved as necessary. However, when it is closed, it will revert back to iconic form at the location where it was originally entered.

3. To close the comment, click on the close box at the top right of the comment window.

4. To display the location of all chart comments in bitmap form, select **Show Comments** from the floating popup menu.

**Showing centering indications**

Centering indications made during the examination can be temporarily disabled during chart review. To hide centering indications on a specific chart:

1. Right-click on the sensor trace portion of the Chart Review window. A floating popup menu is displayed.

2. By default, centering indications are enabled. Select **Show Centering** from the floating popup menu. Centering indications will be disabled and the chart will be redrawn without centering.

3. To re-enable centering, select **Show Centering** again from the floating popup menu.

Note that a change to the centering indication display mode only applies until the chart is closed. Centering indications are always enabled when a chart is opened.

**What should I do next?**

You're now ready to either:

- score a chart
- create a report showing the results.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensors</td>
<td>Sensors are the detection devices that are <strong>attached to the subject</strong> and <strong>connected to the DAS</strong> for input to the Lafayette Polygraph System workstation.</td>
</tr>
</tbody>
</table>
You'll work with the following sensors:

### LX5000
- **P1** (Abdominal Respiration)
- **P2** (Thoracic Respiration)
- **GSR** (GSR electrodermal)
- **GSR Detrended** (GSR electrodermal with the "detrending" filter applied)
- **GSC** (GSC electrodermal)
- **GSC Detrended** (GSC electrodermal with the "detrending" filter applied)
- **PLE** (Plethysmograph)
- **Cardio** (Cardiovascular)
- **Feet** (Feet movement)
- **Seat** (Seat movement)
- **Arms** (Arm movement)

### LX4000
- **P1** (Abdominal Respiration)
- **P2** (Thoracic Respiration)
- **EDA** (GSR electrodermal)
- **EDA Detrended** (GSR electrodermal with the "detrending" filter applied)
- **Cardio** (Cardiovascular)
- **Aux 1** (Auxiliary 1, typically Movement)
- **Aux 2** (Auxiliary 2, typically Countermeasure)
- **Aux 3** (Auxiliary 3)

### Question to read
Lists the question to read in the following format:

```
question ID (expected response) question
```

1 (No) Regarding that piece of paper under your leg, did you write the number 1?

To change the font of the question text, right-click on the question text to display the Chart Preferences page.

### Chart review question grid
The Chart Review question grid shows the questions that were asked during chart recording in the exact order in which the questions were asked. To move to a different question, just select it by clicking it with the mouse or using the left and right arrow keys. As a different question ID is selected, the chart is scrolled horizontally to center the question’s corresponding tracings on the chart review screen.

**Tip:** To enable or disable question ID color coding, modify the "Color code question IDs" setting in Examination Preferences.

### Home button
Select this button to return to the start of chart.

### Fast Forward button
Select this button to toggle between 1x, 2x, 4x, and 8x chart playback speeds.

### Pause button
Select this button to pause a playing chart.

### Stop button
Select this button to stop a playing chart and return to the start of chart.

### Play button
Select this button to initiate playback of a chart.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question ID</td>
<td>The ID for the question. Click on this field to select the question.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The question ID is the number that appears in the question ordering grid.</td>
</tr>
<tr>
<td>Chart Comment</td>
<td>An on-screen comment made by the original examiner. This allows the examiner to make a directed comment about a specific area on the chart. A comment may be entered by selecting <strong>Enter Comment</strong> from the floating chart review popup menu. The chart review popup menu may be accessed by right-clicking on the chart. Note that the location where the right-click occurred will be the location where the chart comment will be located. Once entered, the chart comment may not be moved to another location on the chart. To view the text of the comment, double-click on the comment bitmap present on the chart. Chart comment bitmaps can be displayed or hidden via the <strong>Show Comments</strong> menu item in the chart review popup menu. <strong>Note:</strong> Chart comments can only be entered and modified by the original examiner. If the <strong>Enter Comment</strong> chart review popup menu entry is dimmed, it is because the current user is not the original examiner.</td>
</tr>
<tr>
<td>Gray bar</td>
<td>Marks the time it took to read the question.</td>
</tr>
<tr>
<td>Cardio</td>
<td>Cardio is the <strong>Cardiovascular</strong> sensor. The <strong>default abbreviation</strong> (the two characters that appear on the sensor control) is <strong>CA</strong>. You can change a sensor’s abbreviation by typing two new characters in the Sensor ID field in the <strong>Cardio</strong> property page of the <strong>Preferences</strong> dialog.</td>
</tr>
<tr>
<td>EDA</td>
<td>EDA is the <strong>Electrodermal</strong> sensor. For historical reasons, the <strong>default abbreviation</strong> (the two characters that appear on the sensor control) is <strong>GS</strong> (Galvanic Skin Conductance). You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the <strong>Electrodermal</strong> property page of the <strong>Preferences</strong> dialog.</td>
</tr>
<tr>
<td>P1</td>
<td>P1 is the <strong>default abbreviation</strong> assigned to the <strong>Pneumatic 1</strong> sensor control. The P1 sensor produces the <strong>Abdominal Respiration Trace</strong>. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the <strong>Abdominal Respiration</strong> property page of the <strong>Preferences</strong> dialog.</td>
</tr>
<tr>
<td>P2</td>
<td>P2 is the <strong>default abbreviation</strong> assigned to the <strong>Pneumatic 2</strong> sensor control. The P2 sensor produces the <strong>Thoracic Respiration Trace</strong>. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the <strong>Thoracic Respiration</strong> property page of the <strong>Preferences</strong> dialog.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>This box lists the date of the test, the time the test was started, and the duration of the test.</td>
</tr>
<tr>
<td>CP mmHg</td>
<td>This box lists the cuff pressure readings at the start of chart (X) and end of chart (XX) announcements. If no start of chart announcement was made, the cuff pressure listed is from the beginning of chart. If no end of chart announcement was made, the cuff pressure listed is from the end of chart.</td>
</tr>
<tr>
<td>EDA Ohms</td>
<td>Displays the minimum, maximum, and average Electrodermal (EDA) measured in Ohms.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Notes present      | The Notes Present bitmap button lets you open the PF Notes to review or record notes about a chart.  
**Note:** The Notes Present bitmap will not appear on the Chart Review window if no notes were recorded. To open the PF Notes, choose PF Notes from the Exam menu. |
| Comments present   | The Comment Present bitmap button lets you open individual chart comments. The count of the number of chart comments present in a chart is displayed beside the Comment Present button. Each selection of the Comment Present button will open a different on-screen chart comment. If all chart comments are open, selection of the Comment Present button will cycle through each Chart Comment window, centering them in the Chart Review window.  
**Note:** The Comment Present bitmap will not appear on the Chart Review window if no comments were recorded by the original examiner. |
| Video present      | The Video Present bitmap button lets you know that an audio/video clip is associated with this chart. Selection of the Video Present button will begin replay of the chart and the associated audio/video clip.  
**Note:** The Video Present bitmap will not appear on the Chart Review window if no audio/video clips were recorded when this chart was collected. |
| Chart playback timer | Indicates the current offset of a replaying chart in seconds from the start of chart. |
| Gain Sensor ID     | Identifies the sensor.                                                      |
| Gain Start Value   | Lists the gain value when the test started.                                 |
| Gain End Value     | Lists the gain value when the test ended.                                  |

**Scoring a Chart**

The LXSoftware provides two primary options for scoring a chart: automatic and manual.

During automatic scoring, a computer algorithm examines the sensor data and automatically provides a recommended decision with minimal effort on the part of the examiner. Automatic scoring algorithms are commonly referred to as computerized scoring algorithms. Examples of automatic scoring algorithms available for use with the LXSoftware are PolyScore®, QuEST, ASIT, Identifi, and the Objective Scoring System (OSS). Only OSS is provided with the LXSoftware. The other algorithms are available for an additional fee by contacting Lafayette Instrument Company.

In addition to the aforementioned scoring algorithms, a Countermeasure Detection Algorithm is also provided. The Countermeasure Detection Algorithm attempts to detect

---

* A well-defined computational procedure that takes some value, or set of values, as input and produces some value, or set of values, as output.
the use of mental and physical countermeasures employed by the subject during an examination.

During manual scoring, a score sheet is provided in which the examiner may enter "hand scores" without the aid of a computer algorithm.

Creating a Report

To produce a final report recording the results of a polygraph chart:

1. Select **New Report** from the **File** menu. The **Final Call** dialog box appears.

---

2. Select an evaluation option from the **Final Call** drop-down box. This evaluation is recorded in the **Exam Info** dialog box for you when you select a choice in the **Final Report** dialog box.

3. Select the template file to use for generating the final report from the **Final Report Template** box. Use the browse button to find the file if necessary. This option allows selecting from one of multiple Final Report templates depending on the type of examination. For example, an examiner could create a Final Report template for pre-employment exams, one for a specific type of crime, and one specific to sex offenders.

4. Select **OK** to save the changes and generate a report. The LXSoftware window moves to the background, the word processing application window opens, and a Final Report appears.

   The LXSoftware extracts relevant information from the examination and puts it into the template. You must type the remaining information in the template.
Including PF notes in a report
If you used the PF Notes during the exam, the PF Notes window opens when the template appears. The comments you made in the PF Notes appear in a separate document window. You can add the PF Notes to the final report using standard copy, cut, and paste techniques.

Note: This function is not available if you're using Microsoft WordPad.

Exiting the word processor
When you are finished with the final examination report:

1. Select Save from the File menu to save the report to disk.
2. Double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the word processor's application window.
3. Click the Lafayette Polygraph System icon at the bottom of the screen to return to the polygraph application.

Tip: You can press <Alt + Tab> to toggle between the two applications.

Customizing the Final Report
The Final Report may be customized to meet the needs of the examiner. For details, see Custom Final Report with extended field support under the Exam Preferences topic.

What should I do next?
You're now ready to print the report.

Printing a Report
To print a report, follow your word processor's printing instructions.

Using the Lafayette Polygraph System
Starting the Lafayette Polygraph System
Getting started!

Working with polygraph files (PFs)
Creating a PF
Recording Audio/Video
Entering the personal history information
Opening a PF
Closing a PF
Moving a PF
Copy Current PF to CD/DVD
E-mailing a PF
Deleting a PF
Renaming a PF
Switching between PFs
Zip Current PF

Working with question editors
Selecting the default Question Editor for LXSoftware
Using the LXQuestionEditor
Using the Legacy Question Editor

Working with exams
Entering the exam information

Working with charts
Recording a chart
Annotating a chart
Scoring a chart
Using the sensor controls
Centering a chart trace
Reviewing a chart
Printing a chart

Working with reports
Creating a report
Opening a report
Printing a report

Using other helpful functions
Locking the screen
Using Chart Comments
Using the PF Notes
Performing a spell check
Searching the Drug Reference
Printing all PF documents

Customizing your system
Setting Administrator preferences
Setting Audio/Video preferences
Setting Caliper preferences
Setting Chart preferences
Setting Examination preferences
Setting Printing During Recording preferences
Setting Printing During Review preferences
Setting Screen Calibration preferences
Setting Speech Synthesis preferences
Setting System preferences
Setting Toolbar/Menu preferences
Customizing the Final Report
Performing system administrator functions
  Working with the user list
  Working with the audit trail
Exiting the Lafayette Polygraph System

Creating a PF

To create a PF:\(^{10}\):

1. Select **New PF...** <Ctrl + N> from the **File** menu. The New PF dialog box appears.

2. In the **PF** text box, enter a unique name. The name can be any legal Windows filename that is not a device name (e.g., COM, LPT). The name can contain embedded spaces but cannot contain any of the following characters: / : * ? " < > |. Note that the period character (.) can be part of the PF name but may not be the last character in the name.

3. Select **OK** to create a PF, or select **Cancel** to close the dialog box and ignore the New PF command.

   If the PF name you entered already exists, a duplicate name message appears. At this point, repeat steps 1-3 and enter a unique name in step 2.

**Note:** After you create a PF, the **Personal History dialog box** appears (if the Personal History check box is selected in the **Examination Preferences**). You must enter biographical information about the subject in this dialog box.

What should I do next?
You're now ready to enter the biographical information in the Personal History dialog box.

**Note:** If a PF already exists on the hard drive, you can open it using the **Open PF** command.

Entering the Personal History Information
The first time you create a PF, the **Personal History tabbed dialog box** appears (if the “Require entry of Personal History” check box is selected in the Examination

---

\(^{10}\) A PF, or Polygraph File, contains all biographical information on the subject as well as all examination data categorized by exam.
Preferences). Use this tabbed dialog to enter biographical information about the subject. The subject’s age is entered automatically.

**Note:** You can display the Personal History dialog box for the open PF at any time by selecting Personal History from the Exam menu.

To fill in the Personal History tabbed dialog box:

1. Enter information in the spaces provided on each tab. The underlined fields on the Identification tab are required.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The subject's name. <strong>You must enter this field.</strong></td>
</tr>
<tr>
<td>Date of Birth</td>
<td>The subject's date of birth. <strong>You must enter this field.</strong> If a 2-digit year is entered, it is assumed to be relative to 1900.</td>
</tr>
<tr>
<td>Age</td>
<td>The subject's age at the time the Personal History was entered. This field is automatically calculated.</td>
</tr>
<tr>
<td>Aliases</td>
<td>Other name(s) by which the subject is referred.</td>
</tr>
<tr>
<td>ID Number</td>
<td>The identification number for this subject.</td>
</tr>
<tr>
<td>Case</td>
<td>The Case Number associated with this subject.</td>
</tr>
<tr>
<td>Driver’s License  Number</td>
<td>The subject's driver's license number.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
State/Province | The state or province in which the driver's license was issued.
Country | The country in which the driver's license was issued.
Expiration Date | The date on which the driver's license expires.
Description | The subject's physical description, such as hair color, eye color, height, etc.

2. Select the **Fingerprint tab** to scan or verify the subject's fingerprint.

3. Select the **Signature tab** to scan or verify the subject's signature.

4. Select the **Photo tab** to capture a still photograph of the subject.

**Note:** In order to use the fingerprint, signature, or photograph features within the Lafayette Polygraph System, fingerprint/signature capture hardware or digital video camera/web cam equipment must be purchased and installed separately.

5. Record any comments pertaining to the personal history in the **Comments tab** or in the **PF Notes**.

6. Review the information and correct any typographical errors.

7. When you are finished entering the biographical data, double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the window.

**Note:** If you did not enter the required information, a message box appears identifying the incomplete field:

Select **Retry** to return to the Personal History dialog box to enter the required information.

Select **Close** to close the message box and disregard any modifications made to the exam information. If the Personal History was displayed as a result of the **New PF** command, the PF will not be created.

---

**Printing a customized Personal History**

To print the open PF's **Personal History**:

1. Select **Personal History** from the **Exam** menu to open the personal history. The **Personal History** window appears.
2. Select **Print** <Ctrl + P> from the **File** menu. The **Print All** dialog window appears.

![Print All dialog window](image)

3. The dialog lists all items within the open PF's personal history. To select or deselect an item for printing, click on the checkbox next to the desired item. Alternatively, all checkboxes may be simultaneously checked or unchecked by selecting the **Select All** or **Clear All** buttons.

4. Select **Print** to print the checked documents; select **Close** when finished printing or to disregard the **Print** command.

**What should I do next?**

You're now ready to select a question set.

**Recording Audio/Video**

**Note:** To record audio/video, a web cam, digital video camera, and/or microphone must first be attached to your system, and the audio/video capability must be enabled within the audio/video preferences.
The LXSoftware provides the capability to record and play back both the audio and video, or audio only, of an entire examination or individual charts. Audio/video recordings are stored within the PF and are automatically synchronized with chart recordings.

The **Video** menu contains the commands to control the audio/video features.

![Video Menu](image)

Those commands include the following:

- **Stop** The **Stop** command stops audio/video recording and audio/video playback.
- **Record** The **Record** command initiates the audio/video recording of an examination or chart.
- **Play** The **Play** command initiates the playback of recorded audio/video sessions. If more than one recorded audio/video session is stored within the same open PF, a **Select Video** window appears. Select the desired session to play back and press **OK**.
Fast Forward The **Fast Forward** command plays the audio/video at twice the normal speed when selected. To resume normal playback speed, select **Play**.

Rewind The **Rewind** command rewinds the audio/video to the beginning of the recording.

Pause The **Pause** command temporarily suspends the playback of the audio/video selection. To resume playback, select **Pause** or **Play**.

Mute Audio The **Mute Audio** command mutes the audio playback of the audio/video selection. To resume audio, select **Mute Audio** again.

**Tip:** Capturing a still photograph of the subject cannot be performed while audio/video recording is currently active. To record an uninterrupted video of the entire examination, capture the photograph as soon as the Personal History file is displayed. Once the still photograph is captured, audio/video can be recorded normally.

Audio/Video Preview Mode

When the audio/video window title indicates **Previewing**, no data is being stored to disk. This allows the user to adjust the camera settings prior to beginning actual recording.

To record audio/video for a single chart

When the audio/video capability is enabled, audio/video recording will begin automatically when chart recording is initiated. When activated in this fashion, audio/video recording will stop when chart recording is complete.

To record audio/video for an entire examination

To record the audio/video for an entire examination without any gaps, create the PF and immediately select **Record** from the audio/video menu. Alternatively, select the **Record** button on the audio/video toolbar. As charts are recorded, synchronization information
is stored so that during chart review, the chart can be replayed such that it is synchronized exactly with the associated audio/video file.

**Tip:** Click on the window's contents to see a brief description at the bottom of the window.

To replay audio/video for a single chart

To replay an audio/video file for a single chart, open the chart and select the **Play** button. The chart will begin replaying in synchrony with the audio/video file. At the conclusion of the chart, the audio/video playback will automatically terminate. Audio/video files may be replayed on any computer whether or not that computer has a web cam or other video capture device present.

To replay audio/video for an entire examination

To replay an audio/video file for an entire examination, select **Play** from the audio/video menu. Alternatively, select the **Play** button on the audio/video toolbar. If multiple audio/video files are present, a dialog will be displayed from which you can select the audio/file to play. The audio/video file will not stop until it reaches the end of the file or the **Stop** menu item or toolbar button is selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>Title bar for the LXVideo Preview/Playback window. The title bar indicates the current mode (Preview or Playing) as well as the video title, playback speed, current video offset, and total video length.</td>
</tr>
<tr>
<td>Video Duration</td>
<td>The video duration displayed in hour:minute:second format.</td>
</tr>
<tr>
<td>Slider</td>
<td>The LXVideo slider lets you quickly move to any location in the video.</td>
</tr>
<tr>
<td>Preview/Playback Window</td>
<td>The LXVideo Preview/Playback window is where the video is displayed.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>As the window is resized, the video is scaled appropriately.</td>
<td></td>
</tr>
<tr>
<td>Current Offset</td>
<td>The current offset into the video displayed in hour:minute:second format.</td>
</tr>
<tr>
<td>Minimize Button</td>
<td>The LXVideo minimize button allows minimizing the LXVideo window to move it temporarily out of the way. While minimized, video playback and recording still occur normally.</td>
</tr>
</tbody>
</table>

**Opening a PF**

If a PF exists on the hard drive, you can open it using any of the following methods:

Select **Open PF** from the **File** menu, then select the desired PF from the submenu.

Or,

Select **Open PF** from the **File** menu, then select **Browse**… from the submenu. The **Browse for Folder** window appears allowing you to select and open a PF from any available drive.

Or,

Select **Open PF** <Ctrl + O> from the **File** menu, then select **Open PF**... from the submenu. The **Open PF dialog box** appears:
The Open PF dialog contains columns that can be sorted by any of the column headings, for example PF Name, Chart Name, Date, etc. Click on the desired column heading to sort.

To open a PF, highlight the desired PF from the list of PFs and select **OK**. Alternatively, double-click the desired PF to open. If the desired PF is not shown, select the **Browse** button to search for a PF.

**Note:** Opening a PF using the browse capability temporarily changes your PF directory. As soon as the PF is closed, the PF directory is restored to its original location.

**Tip:** Once a PF is selected, its associated chart list is displayed in the lower half of the dialog window. Charts can then be selected from this list for automatic opening when the PF is opened.

To print, select **Print PF List...** to print a list of all PFs within the current PF directory, or select **Print Chart List...** to print a list of charts for the selected PF.

To close the dialog box and disregard any changes, select **Cancel**.

### Moving a PF

With the Move PF capability, you can move or copy PFs between any two directories visible to Windows, as well as copy PFs to writable CD or DVD drives. You can also backup PFs to a compressed archive and copy a PF, removing sensitive information first. To perform any of these actions, follow these steps:

1. Select **Move PF** from the **File** menu. The Move PF dialog box appears. The dialog displays all PFs located in the specified PF directory. The list of PFs can be changed by selecting the **From...** button to change to a different directory.
2. Select the **From** button to display a dialog box containing all drives visible to Windows. From this graphical directory structure browser, select the directory currently containing the PF(s) to process. This will be referred to as the **Source** directory.

   **Note:** The **Current PF Directory** indicates the current PF directory. The PF directory is set in the Examination Preferences and is the directory in which all new PFs are created.

3. Select the check box beside the name of each PF to be included in the **Move**, **Copy**, **Remove Info**, or **Archive** process. The number of **Bytes Selected** to move is displayed as well as the number of **Bytes Available** on the destination drive (as specified by the "To" directory).

4. Select the **To** button to display a dialog box containing all drives visible to Windows. From this graphical directory structure browser, select the directory to which the PF(s) should be moved. This will be referred to as the **Destination** directory.

5. Select the operation to perform on the selected files:

   - Select **Move** to transfer the PF to the destination directory, deleting it from the source directory.
   - Select **Copy** to transfer the PF to the destination directory, leaving a copy of it in the source directory.
- Select **Archive**... to generate a compressed archive of the selected files, saving the file in the destination directory.
- Select **Remove Info**... to copy a PF, removing sensitive information first. The **Remove Sensitive Information** dialog will appear allowing you to select components from which personal information will be removed.
- Select the checkbox **Verify files copied to CD/DVD** to verify that the PF(s) were copied successfully to CD or DVD. This checkbox will be dimmed if the target drive is not a CD or DVD.

**Note:** To avoid inadvertent PF deletion, a backup copy of each Moved PF is made in the Windows Recycle Bin. Please remember to periodically empty the Recycle Bin to avoid filling up the computer hard disk. From the Windows Desktop, right-click on the Recycle Bin and select **Empty Recycle Bin** from the menu to permanently remove files that were moved during a Move PF operation.

6. When finished, click on the close button in the upper right-hand corner of the dialog.

**Tip:** To restore the contents of a compressed archive, please see the topic **Restoring a PF from an Archive**.

### Restoring a PF from an Archive

The **Restore PF from Zip** capability is used to restore the contents of a compressed archive from the source directory into the Current PF Directory. To restore a PF, follow these steps:

1. Select **Restore PF from Zip** from the **File** menu. The Open window appears and you will be prompted for the archive name. Type in the archive name or browse for the desired file.
2. You will be prompted to overwrite existing files and may be required to supply a case-sensitive password if a password was specified during archive generation.

**Note:** During the restoration process, you will be prompted if you want to overwrite existing files. This does not mean that a PF with the same name was detected in the Current PF Directory, but rather the desired action to take in the event files with the same name are encountered.

3. The dialog advises when the restore process has completed successfully. Click the **Close** button.

### Copy Current PF to CD/DVD

To copy the current open PF to a CD or DVD drive:

1. Select **Copy Current PF To CD/DVD**... from the **File** menu. The Copy To CD/DVD dialog box appears.
2. Select the drive to which the current PF should be copied from the drop down list. The drop down list contains a list of all supported CD and DVD drives detected within your system. All CD, Combo, and DVD recorders manufactured since 1997 should be supported by LXSoftware.

**Note**: In some instances a recordable CD or DVD device is present but unsupported by the LXSoftware. If this occurs, please use the third-party software that typically comes with CD/DVD drives for recording discs. Lafayette Instrument Company does not provide tech support for copying PFs to CD/DVD using third-party software. Please refer to the software provider for technical support.

**Note**: The write speed of the media must be greater than or equal to the maximum write speed of the drive you select from the drop down list. In addition, media quality is very important. Lafayette Instrument Company recommends discs manufactured by Mitsui, Philips, Kodak, and TDK.

3. Click **Copy PF** to initiate the copy to the selected drive. The progress of the copy is shown in the status box and progress bar.

4. When the copy is complete, the status will be indicated in the status box. Click **Close** to close the window when finished.

**Note**: Once you have copied a PF to a CD/DVD, you cannot copy a PF with the same name to that same CD/DVD. A new CD/DVD disc must be used.
E-mailing a PF

In order to e-mail a PF, the host computer must have a MAPI compliant e-mail program installed, such as Microsoft Outlook, Outlook Express, etc... and it must be set as the default e-mail program.

LXSoftware will compress the selected PF’s, encrypt it, open the default e-mail program and create an attachment containing the encrypted data. Data compression and compression is performed by the LICMail.exe application, provided as of version 10.0 of LXSoftware.

LICMail is a self extracting program designed to extract and decrypt PF(s) that have been compressed and encrypted from the "Email PF" option in LXSoftware. Using AES encryption, "Email PF" now provides a secure way to email PF(s) to allow remote users to view PFs.

To e-mail a PF:

1. Select E-mail PF... from the File menu. The E-mail PF dialog box appears, displaying all PFs located in the specified PF directory.

11 A PF, or Polygraph File, contains all biographical information on the subject as well as all examination data categorized by exam.
2. The **PF Folder** indicates the current PF directory. The PF directory is set in the **Examination Preferences** and is the directory in which all new PFs are created. If necessary, select the **From...** button to change to a different PF directory.

3. Select the check box beside the name of each PF to be included in the e-mail. Note that **Bytes Selected** indicates the number of bytes currently selected for inclusion in the e-mail. This is the size before any compression is performed.

   **Note:** Select the **Select All** button to simultaneously select all PFs in the list. Select the **Clear All** button to simultaneously clear all PF selections in the list.

4. If desired, select the checkbox to remove all identifying information about the subject from the e-mailed copy of the PF. This will open the **Remove Sensitive Information dialog**, allowing you to customize which information is removed from the e-mailed copy of the PF.

5. Select the **Send** button to initiate the e-mail construction process. The progress bar will be updated to display the status of the e-mail attachment generation. When complete, the **Attachment Size:** field will indicate the size of the constructed attachment. Note that the e-mail size can be substantially larger than the size of the compressed file due to encoding of non-character values prior to e-mail transmission.
6. The LXSoftware will launch the default system mail program, create a new, empty e-mail, and insert the attachment into the e-mail. Fill in the recipient’s e-mail address, Subject, and e-mail body.

7. When satisfied with the e-mail content, send the e-mail.

**Note:** Be careful not to send an e-mail that is larger than the recipient can reasonably receive. Many Internet Service Providers have limits on maximum e-mail sizes. Unless you are sure that the recipient can handle large e-mail attachments, avoid sending e-mails when the attachment size is greater than 1000 KB (i.e., 1 MB).

8. When finished, click on the close button in the upper right-hand corner of the dialog.

**To Decrypt and decompress a .LICM type file:**

When a remote user receives an email with a .licm attachment he or she can should save the file to a known location, naming the file whatever they wish, but maintaining the .licm extension. By double clicking on the file that has been saved, LICMail will open. Alternatively, the user may just double click on the attachment and select LICMail to open the file when prompted what program should open the file.

Once LICMail is open the title bar should read "LICMail - Your Filename". If the file you are attempting to extract is not next to LICMail in the title bar, click File->Open to locate your file.
Once the proper file is selected to extract, the user must determine the destination of the extraction process. By default, LICMail locates the users PFFolder, as specified in LXSoftware's preferences, and automatically chooses that directory as the extraction destination. If the user would like the file to be extracted to a different location, click the "Browse..." button and navigate to the desired location.

Click "Start" to begin the extraction process. If the PF(s) being extracted already exists in the user selected destination directory, the user will be asked if he or she would like to overwrite the PF(s) or not.

If not the extraction process ends with no changes. If the user chooses to overwrite or the PF(s) does not exist, the PF(s) will be decrypted and extracted into the desired destination directory. The "Status" bar shows the overall percentage complete. The text above the status bar is a status message. The log window logs the events taking place. If a problem may occur the log is saved in a temporary
Deleting a PF

To delete a PF:\(^{12}\):

1. Select Delete PF... from the File menu. The Delete PF dialog box appears.

   ![Delete PF dialog box]

   2. The dialog displays all PFs located in the specified PF directory. If necessary, select the From... button to change to a different PF directory from which to delete PFs.

   3. Select the check box beside the name of each PF to delete. The columns may be resized as needed to display more or less information about a PF. The Bytes Selected indicates the number of bytes currently selected for deletion.

   **Note:** Select the Select All button to simultaneously select all PFs in the list. Select the Clear All button to simultaneously clear all PF selections in the list.

   4. Select the Delete... button to initiate the deletion process. Confirmation is required to prevent accidental file deletion.

   **Note:** To avoid inadvertent PF deletion, a backup copy of each deleted PF is made in the Windows Recycle Bin. Please remember to periodically empty the Recycle Bin to avoid filling up the computer hard disk. From the Windows Desktop, right-click on the Recycle Bin and select Empty Recycle Bin from the menu to permanently remove deleted files.

\(^{12}\) A PF, or Polygraph File, contains all biographical information on the subject as well as all examination data categorized by exam.
5. When finished, click on the close button in the upper right-hand corner of the dialog.

**Renaming a PF**

To rename a PF:

1. Select **Rename PF...** from the **File** menu. The Rename PF dialog box appears.

![Rename PF dialog box](image)

2. In the **PF** text box, enter a unique name. The name can be any legal Windows filename that is not a device name (e.g., COM, LPT). The name can contain embedded spaces but cannot contain any of the following characters: / : * ? " < > |. Note that the period character (.) can be part of the PF name but may not be the last character in the name.

3. Select **OK** to rename the PF, or select **Cancel** to close the dialog box and ignore the Rename PF command.

**Switching Between PFs**

Only one PF can be open at a time; therefore, to **switch** between files, you must close the open file and select another:

1. Select **Close PF** (Ctrl + U) from the **File** menu to close the current PF.

2. Select **Open PF** (Ctrl + O) from the **File** menu to display the list of available PFs.

**Zip Current PF**

The currently open PF can be compressed and archived to a single zip file using the **Zip Current PF...** menu item or toolbar button. To zip the open PF:

1. Select **Zip Current PF...** from the **File** menu. The **Save As** dialog box appears.
2. In the **File Name:** field, the name of the open PF is listed. You may keep this file name for the zip file or enter another unique file name. You can use any valid Windows file name in this field. However, you cannot use colons, backslashes (\), or periods (.). Also avoid DOS device names such as COM1, COM2, LPT1, LPT2, NUL, AUX, etc.
3. Select **Zip files (*.zip)** as the **Save as type**.
4. Select **Save** to save the zip file. Select **Cancel** to cancel and return to the LXSoftware program window.

**Note:** It is not necessary to have WinZip or another third-party tool installed to use this feature.
**Closing a PF**

To close a PF:

1. Select **Close PF** (Ctrl + U) from the **File** menu.

*Note*: When a PF is not open, many menu items and commands are disabled.

**Removing Sensitive Information**

Sensitive information can be removed, or stripped, from a PF. The dialog below is displayed at the beginning of each sensitive information removal operation.

As indicated in the dialog instructions, the Personal History information will be purged from the PF. Additionally, you may choose additional components from which personal information will be removed. You may also prefer to have specific words removed from the selected components (excluding Chart Comments), have examiner information removed, or have selected components completely removed from the PF. Click on a setting to see a brief description at the bottom of the window.
Option | Description
--- | ---
Select additional components | The personal history file will be removed from a PF during the copy operation. Select additional components from which personal information will also be removed.
Remove additional words | In the space provided, enter additional words to be removed that are not already listed. After typing each word, hit the spacebar to separate distinct words.
Remove examiner information | Select Yes to remove the examiner's name and ID from the PF.
Remove additional components | Select components to completely remove from the PF.
Preview | Select to preview the personal information to be removed from the PF.
Option | Description
---|---
Save Settings | Select the **Save Settings** button to save the current settings as the default settings for LXSoftware.

**Note:** The entered words are searched for exactly as they are entered in a case-sensitive fashion. For example, if a word appears in one of the PF documents beginning with an upper case letter, enter it in upper case when prompted for additional words to remove.

**Note:** The ability to remove subject identification is only available if sufficient disk space exists on the local hard drive for the removal process.

**LXSoftware Question Editor**

The question editor for LXSoftware, now referred to as the LXQuestionEditor, has been redesigned to greatly enhance the questioning component of the application. Some features of the LXQuestionEditor include:

- Attaching multimedia files (audio, video, or picture) to an individual question. This information can then be presented to the subject on a second monitor during the examination.
- Creating an unlimited number of questions.
- Creating an unlimited number of lists of questions.
- Creating a set of multiple lists with different questions.
- Creating different types of lists (MGQT, Rank, Zone, etc.) in one set.
- Validating entered data.
- Previewing speech synthesis and attached multimedia files.
- Recording examiner’s voice for use during question asking.

To open the questioning component of LXSoftware, select **New Questions** from the **Question** menu. The following window will appear:
This dialog allows you to select the default Question Editor for LXSoftware, either the aforementioned LXQuestionEditor or the Legacy Question Editor, the previous standard in older versions of the application. Select the checkbox so that the dialog is no longer displayed after the selection is made.

The default Question Editor may be changed at any time in the Examination Preferences.

**Question Manager**

The Question Manager provides enhanced question set management and selection for Templates, PF Question Sets, and Chart Question Sets. The dialog can be used to select a question set for an open PF, to organize question sets into folders, to rename question sets and folders, and to delete question sets and folders. The **Edit** command can be used to launch the default question editor and edit the selected question set.

To open the Question Manager, select the open folder button at the bottom of the chart window, or select **Templates**, **PF Question Sets**, or **Chart Question Sets** from the LXSoftware **Question** menu. The Question Manager dialog appears.
To create new Template categories, select the location under the Templates directory in the Question Manager display where you would like to create the new category. Select the **New Folder** button to create a new category and assign a name to the category.

To edit, delete, or rename a question set, select the question set name in the hierarchy and then select the corresponding button. Selecting the **Edit** button will launch the default Question Editor. The **Delete** and **Rename** buttons can be applied to question set folders also.

To obtain Windows-based file properties for a question set or question set folder, select the item name in the hierarchy and then select the **Properties** button.

To import a question template from an external source select the **Import** button. To export a question template for use by a colleague, select the **Export** button.

To select a question set for use with chart recording, select the question set name in the hierarchy and then select the **OK** button.

**Tip**: Question sets and folders can be reorganized within the question set hierarchy by dragging and dropping the question sets into the desired position within the hierarchy.

**Tip**: Double-click an entry in the Question Manager dialog to open the selection for editing in the default question editor.

To select a question set for an open PF:
1. Click on the "Open Question Set" button at the bottom of the LXSoftware screen. The Question Manager appears.

2. Select the desired question set from the Question Manager dialog and select the OK button. If you do not see a suitable question set, select the Edit button to modify the selected question set, or use the LXQuestionEditor to:
   - edit an existing question set
   - create a new question set

   If using the Legacy Question Editor:
   - edit an existing question set
   - create a new question set

**Note:** Chart Question Sets are a permanent record of the examination and can never be deleted.

### Selecting a Question Set

To select a question set for an open PF:

1. Click on the "Open Question Set" button at the bottom of the screen. The Question Manager appears.

2. Select the desired question set from the Question Manager dialog and select the OK button. If you do not see a suitable question set, select the Edit button to modify the selected question set. Two question editors are provided, the LXQuestionEditor and the Legacy Question Editor. The Legacy Question Editor is familiar to users of LXSoftware prior to version 9.9.3. The LXQuestionEditor is new for version 9.9.3.

   If using the LXQuestionEditor:
   - edit an existing question set
   - create a new question set

   If using the Legacy Question Editor:
   - edit an existing question set
   - create a new question set
What should I do next?

You’re now ready to prepare the subject for the test.

Importing Question Sets

The LXSoftware provides the ability to easily receive question sets from a colleague using the question set import feature. The import feature lets you copy question sets from an external source to either the local question template folder or a P^F question folder without requiring the use of Windows Explorer.

The Import dialog is shown below. This dialog operates much like Windows Explorer. To import a question set perform the following steps:

1. In the "Select the files to import" tree control, select the folder containing the question set files to import.
2. In the "Select the files to import." list control, select one or more checkboxes next to the question set files or folders to be imported.
3. In the "Select the destination folder" tree control, select the destination folder where the selected files will be imported. This displays the contents of the P^F Question Set directory if a P^F is open and P^F Question Sets was selected in the Question Manager, or the Question Template directory if a P^F is not open.
4. Click the "Import" button

**Note:** Alternatively, you can drag a file or folder from the top portion of the dialog and drop it on a destination at the bottom of the dialog.

**Note:** When importing, nothing is deleted from the external source. A copy of the question set or question set folder is imported.

Click on an item in the dialog below for a description of its function.
A combobox displays the name of the source folder. The user may type the name of the source folder in this window instead of clicking on the folder in the tree control. Clicking on the combobox arrow displays a list of folders from which files have been recently imported.

**Note:** To quickly locate a source folder that has been recently used, click on the combobox arrow and select the folder from the list.

### Exporting Question Sets

The LXSoftware provides the ability to easily share question sets with a colleague using the question set export feature. The export feature lets you copy question sets from either the local question template folder or a PF question folder to an external source without requiring the use of Windows Explorer.

The Export dialog is shown below. This dialog operates much like Windows Explorer. To export a question set perform the following steps:

1. In the "Select the files to export" tree control, select the folder containing the question set files to export.
2. In the "Select the files to export." list control, select one or more checkboxes next to the question set files or folders to be exported. This list displays the contents of the PF Question Set directory if a PF is open and PF Question Sets was selected in the Question Manager, or the Question Template directory if a PF is not open.

3. In the "Select the destination folder" tree control, select the destination folder where the selected files will be exported.

4. Click the "Export" button

**Note:** Alternatively, you can drag a file or folder from the top portion of the dialog and drop it on a destination at the bottom of the dialog.

**Note:** When exporting, nothing is deleted from your computer. A copy of the question set or question set folder is exported.

---

### LXQuestionEditor: Getting Started

Some features of the LXQuestionEditor include:
Attaching multimedia files (audio, video, or picture) to an individual question. This information can then be presented to the subject on a second monitor during the examination.

- Creating an unlimited number of questions.
- Creating an unlimited number of lists of questions.
- Creating a set of multiple lists with different questions.
- Creating different types of lists (MGQT, Rank, Zone, etc.) in one set.
- Validating entered data.
- Previewing speech synthesis and attached multimedia files.
- Recording examiner’s voice for use during question asking.

With the LXQuestionEditor, all the questions that are anticipated to be asked during an examination can be pre-constructed instead of having to switch between multiple question sets during chart recording. A "Question List" is used to group and order the questions that will be asked during a specific chart. A "Question Set" is used to group all the "Question Lists" that will be used during an examination.

To open the LXQuestionEditor, you must first select the default Question Editor for LXSoftware. After choosing the default editor, the LXQuestionEditor may be opened by selecting New Questions from the LXSoftware Question menu. To learn more about the question editor, view the topics below for additional information.

Step 1: Select the question list type
Step 2: Add a question
Step 3: Add a new question list
Step 4: Validate the question list
Step 5: Save the question list

Tip: For more comprehensive information about the LXQuestionEditor, please click here to read “Using the LXQuestionEditor.”

LXQuestionEditor: Using the LXQuestionEditor

Note: If you are new to the LXQuestionEditor, please read the topic Getting Started first to become acquainted with the questioning component of LXSoftware.

Getting Started

Working with the LXQuestionEditor
Using the LXQuestionEditor window
Using the Question Grid
Setting LXQuestionEditor preferences
Displaying open question sets in a tiled format
Using keyboard shortcuts

Adding Questions
Creating a new question set
Adding a question
Adding a question list to a question set

**Copying Questions**
- Copying/moving a question
- Copying/moving a question list

**Deleting Questions**
- Deleting a question
- Deleting a question list
- Deleting a question set

**Editing Questions**
- Editing (rephrasing) a question
- Editing an existing question set
- Rearranging the question order

**Synchronizing Questions**
[Ref1095614076 Synchronizing Questions]

**Validating a question set**

**Saving a question set**

**LXQuestionEditor: Using the LXQuestionEditor Window**

To open the LXQuestionEditor, you must first select the default Question Editor for LXSoftware. After choosing the default editor, the LXQuestionEditor may be opened by selecting **New Questions** from the LXSoftware **Question** menu or by selecting the **Edit** button in the LXQuestionEditor to edit the selected question set.

The LXQuestionEditor is designed similar to a spreadsheet program like Microsoft Excel. Each question set is represented by a separate window displaying the question set name within the LXQuestionEditor window immediately below the toolbar or the main menu if the toolbars are disabled.

Inside each question set, multiple question lists can be created. Each question list represents the questions that could be asked during chart recording for an individual chart. Each row in the LXQuestionEditor represents a single question in a single question list. Each column in the LXQuestionEditor corresponds to a question component and is identified by a label at the top of the LXQuestionEditor view.

For example, the question index is in the leftmost column. The question **ID** column is positioned to the immediate right of the question index column. The question **Type** column is to the right of the question ID and so forth.

Questions can be edited using the Question Properties dialog or by tabbing from field to field and directly entering the question information. To display the Question Properties dialog at any time, double-click anywhere in the desired question row.
Toolbars

The question editor has seven different toolbars to choose from as listed in the following tables:

### Main Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open a question set in the editor.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the file.</td>
</tr>
<tr>
<td>New List</td>
<td>Add a question list to the set</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Make a duplicate copy of the selected question list</td>
</tr>
<tr>
<td>Add</td>
<td>Add a question to the active list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the selected question.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete all of the selected questions.</td>
</tr>
<tr>
<td>Find</td>
<td>Find or replace question text.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Moves the selected question up in the list.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves the selected questions down in the list.</td>
</tr>
<tr>
<td>Multimedia</td>
<td>Turns all of the multimedia options on and off.</td>
</tr>
</tbody>
</table>

### File Toolbar
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open a question set in the editor.</td>
</tr>
<tr>
<td>New</td>
<td>Create a new question list.</td>
</tr>
<tr>
<td>Print</td>
<td>Save the file.</td>
</tr>
<tr>
<td>Validate</td>
<td>Make a duplicate copy of the selected question list</td>
</tr>
</tbody>
</table>

**Question Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Add a question to the active list</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the selected question.</td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts an empty question before the focused question.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected questions or lists.</td>
</tr>
</tbody>
</table>

**Question List Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New List</td>
<td>Create a new question list.</td>
</tr>
<tr>
<td>Select List</td>
<td>Selects all of the questions for the selected list.</td>
</tr>
<tr>
<td>Delete List</td>
<td>Deletes the entire list.</td>
</tr>
<tr>
<td>Edit List</td>
<td>Edits the list type and name.</td>
</tr>
</tbody>
</table>

**Tools Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spell Check</td>
<td>Performs a spell check on the entire question set.</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Modifies the toolbars.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Change the question editor preferences.</td>
</tr>
</tbody>
</table>

**Edit Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Copies the selected questions to the clipboard and deletes the questions.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected questions to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the copied questions into the selected list.</td>
</tr>
<tr>
<td>Erase</td>
<td>Clears all of the information for the selected questions.</td>
</tr>
</tbody>
</table>

**Preview Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speak</td>
<td>Use the speech synthesis engine to read the question.</td>
</tr>
<tr>
<td>Play Audio</td>
<td>Plays the audio clip for the selected question.</td>
</tr>
<tr>
<td>Play Video</td>
<td>Plays the video clip for the selected question.</td>
</tr>
<tr>
<td>Display Picture</td>
<td>Shows the picture for the selected question.</td>
</tr>
</tbody>
</table>

The "Main" toolbar is the default toolbar. However, any combination of the toolbars may be displayed at one time. To configure the toolbars, select "Tools" from the main menu, then select "Toolbars."

**LXQuestionEditor: Using the Question Grid**
The Question Editor is composed of two windows. The top window is the "Question Grid" window and the bottom window is the "Question Editor" window. The two windows are separated by a "splitter." The heights of the windows may be resized by clicking on the splitter and moving it either up or down.

**Note:** To enlarge the size of the Question Grid, click on the splitter and drag the mouse downward until the window is the desired size.

---

**Question Grid**

The Question Grid displays each question list contained in the question set and the ID of each question in each list. Control questions are shaded green and relevant questions are shaded red. The Question Grid provides a visual representation of how questions are ordered in each list and it allows the operator to quickly rearrange the order of the questions.

**Reordering Questions**

To rearrange the order of questions within a list:

- Click on the ID of the question to move.
- Hold the mouse button while moving the mouse to the left or right. The IDs are updated to show the new question order.
- Release the mouse button when the question is in the correct location.
**Editing Questions**
To quickly edit a question, simply double-click the ID of the question and the Question Properties dialog is displayed allowing the question information to be changed.

**Viewing Questions**
To quickly see the information pertaining to a question, simply click on the ID of the question and the question is highlighted and visible in the question editor window.

**Changing Editor Options**
Right-clicking anywhere within the Question Grid displays a context-menu that allows options to be changed, such as turning on/off question synchronization and hiding the question grid.

**Hiding the Question Grid**
The question grid may be hidden in one of two ways:

- Right-click and select “Show Question Grid.”
- From the main menu, select “Question Grid,” then select “Show Question Grid.”

**Showing the Question Grid**
If the question grid is not visible, it may be displayed by selecting “Question Grid” from the main menu and then selecting “Show Question Grid.”

**Managing Templates**
The Lafayette Polygraph System comes with a collection of question set templates. A question set template is a question set that may be used as the basis for creating other question sets, or as a question set containing commonly asked questions.

The LXSoftware ships with several standard question template formats. In addition, the LXSoftware ships with two sets of question templates designed by leading authorities in the polygraph industry. The first set of templates was developed by the National Training Center of Polygraph Science under the direction of Mr. Dick Arther. The second set of templates was developed by the Backster School of Lie Detection under the direction of Mr. Cleve Backster.

To manage question templates, select **Templates** from the LXSoftware **Question** menu or select the browse button to the right of the question set name in the **Chart Display window**. The Question Manager is displayed.
As shown in the graphic above for the Arther Templates and the Backster Templates, the templates can be grouped into various categories based on the type of Templates, for example, pre-employment or criminal cases. To create new Template categories, select the location under the Templates directory in the Question Manager display where you would like to create the new category. Select the **New Folder** button to create a new category and assign a name to the category.

**Tip**: Question sets and folders can be reorganized within the question set hierarchy by dragging and dropping the question sets into the desired position within the hierarchy.

**Tip**: Question sets and folders can be copied by holding the <Ctrl> key while dragging and dropping the question sets into the desired position.

To edit, delete, or rename a question set, select the question set name in the hierarchy and then select the corresponding button. Selecting the **Edit** button will launch the default Question Editor. The **Delete** and **Rename** buttons can be applied to question set folders also.

To obtain Windows-based file properties for a question set or question set folder, select the item name in the hierarchy and then select the **Properties** button.
Tip: To rename a question set or question set folder, select the item in the hierarchy and let the mouse cursor rest over the selected name. The item's name can then be changed directly just like in Microsoft Windows Explorer.

To import a question template from an external source select the Import button. To export a question template for use by a colleague select the Export button.

To select a question set for use with chart recording, select the question set name in the hierarchy and then select the OK button.

Managing Chart Question Sets

Chart Question Sets are only available when a PF Folder is open. Chart Question Sets are question sets that have been used during chart recording for a specific subject, and are stored within that subject's PF Folder.

To manage Chart Question Sets, select Chart Question Sets from the LXSoftware Question menu. The Question Manager is displayed.

- To edit a Chart Question Set, select the Question Set name in the hierarchy and then select the Edit button. This launches the default Question Editor.
To select a Question Set for use with chart recording, select the Question Set name in the hierarchy and then select the OK button.

**Note:** Chart Question Sets are a permanent record of the examination and can never be deleted or renamed.

### Managing PF Question Sets

PF Question Sets are only available when a PF Folder is open. PF Question Sets are question sets that have been customized for a particular subject and are stored within that subject's PF Folder.

To manage PF Question Sets, select **PF Question Sets** from the LXSoftware Question menu. The Question Manager is displayed.

To edit, delete, or rename a PF Question Set, select the Question Set name in the hierarchy and then select the corresponding button. Selecting the **Edit** button will launch the default question editor.
- To obtain Windows-based file properties for a Question Set, select the Question Set name in the hierarchy and then select the **Properties** button.

- To select a Question Set for use with chart recording, select the Question Set name in the hierarchy and then select the **OK** button.

**Tip:** To rename a Question Set, select the Question Set name in the hierarchy and let the mouse cursor rest over the selected name. The Question Set name can then be changed directly just like in Microsoft Windows Explorer.

**LXQuestionEditor: Adding a Question**

To add a new question to the current question list:

1. Select **Add** from the **Questions** menu or toolbar, or right click the first question and select **Add** from the pop-up menu. The **Add Question** dialog appears.

**Tip:** Information may also be entered for each question by clicking on the desired field within the question line, or using the <Tab> key or Arrow keys to navigate to each field within the LXQuestionEditor window.

**Tip:** Review the topic **LXQuestionEditor Keyboard Shortcuts** for more information about using the mouse and keyboard within the LXQuestionEditor.
2. Enter up to a four-character identification number in the question identifier field, then press <Tab>.

**Tip:** Contact Lafayette Instrument Company for information on how to expand the maximum question ID length to eight characters.

3. Select the question type (Relevant, Control, Start of Chart, or End of Chart) from the drop-down list, then press <Tab>.
4. Enter the question text in the text field, then press <Tab>. Press the **Speak** button to have the computer read the question aloud.
5. Select the expected response from the expected response drop-down list (Yes or No), then press <Tab>.
6. If desired select an audio clip, video clip, or picture to be presented during the question. Use the browse button (...) to find the desired file. **Select the Record... button to record an audio clip.** Press the **Preview** button to preview the audio clip, video clip, or picture.
7. Select the **Next** button to continue adding questions to the question list. Select the **Finish** button to view the question list in the LXQuestionEditor window.

**Note:** If Synchronization is turned on, then the question will be added to all lists of the same type. See Synchronizing Question Lists for details.

**LXQuestionEditor: Adding a Question List to a Question Set**
To add a question list to an open question set:

1. Select **Add List** from the **Question List** menu or toolbar, or right-click the question list name bar and select **Add List** from the pop-up menu. The **Question List** properties dialog appears.

2. Select the **Question List Type**.

3. Enter a unique name for the new question set in the **Question List Name** field.

4. Select **Next** to use the dialog to add questions to the question list. The **Question properties** dialog appears.

**Note:** If **Finish** is selected, the empty question list is displayed within the **LXQuestionEditor** window. Questions can then be added using the mouse or keyboard (\<Tab\> or Arrow keys) to input the question fields.

**Tip:** Review the topic [LXQuestionEditor Keyboard Shortcuts](#) for more information about using the mouse and keyboard within the **LXQuestionEditor**.
5. Enter up to a four-character identification number for the question identifier.

**Note:** Contact Lafayette Instrument Company for information on how to expand the maximum question ID length to eight characters.

6. Select the question type (Relevant, Control, Start of Chart, End of Chart, or Other) from the drop-down list.

7. Enter the question text in the text field. Press the **Speak** button to preview the pronunciation of this question using the current speech synthesis settings.

8. Enter the subject's expected response to the question.

9. If desired select an audio clip, video clip, or picture to be presented during the question. Use the browse button (…) to find the desired file. Select the **Record** button to record an audio clip. Press the **Preview** button to preview the audio clip, video clip, or picture.

10. Select the **Next** button to continue adding questions to the question list. Select the **Finish** button to view the question list in the LXQuestionEditor window.

**LXQuestionEditor: Copying a Question**

You can use the standard Copy, Cut, and Paste functions, or you can use the **drag and drop** feature to copy or move a question from one question set to another.

**Note:** To select the entire question (ID, type, text, and response fields, etc.) to copy or cut, always click the question number box. The question number boxes are located in the leftmost column of the LXQuestionEditor window. These
numbers indicate the order in which the questions will be presented during chart recording. Use the <Shift> key to select multiple question number boxes.

Tip: Review the topic LXQuestionEditor Keyboard Shortcuts for more information about using the mouse and keyboard within the LXQuestionEditor.

Copy, Cut, and Paste Method
To copy or cut and paste questions from one question set to another:

1. Open the question set that contains the question(s) you want to copy or move. This is called the source.
2. Open or create the question set you want to insert the copied/moved question(s) into. This is called the target.
3. Select the question number box for the question you want to copy.
4. Right-click the mouse and select Copy or Cut from the pop-up menu, or select Copy or Cut from the Edit menu or toolbar. To use the keyboard, press <Ctrl + C> to copy or <Ctrl + X> to cut.
5. Right-click the target question set and select Paste from the pop-up menu, or select Paste from the Edit menu or toolbar. To use the keyboard, press <Ctrl + V> to paste. The question is added to the target question set.

To select multiple questions:

1. Click the question number box for the first question to be copied or moved.
2. To copy or move non-sequential questions, hold down the <Ctrl> key and click the question number boxes for the desired questions. The desired questions are highlighted.
3. To copy or move a range of sequential questions, hold down the <Shift> key and click the question number box for the last question in the range. All questions in the range are highlighted.
4. Right-click the target question set and select Paste from the pop-up menu, or select Paste from the Edit menu or toolbar. To use the keyboard, press <Ctrl + V> to paste. The question is added to the target question set.

Drag and Drop Method
To drag and drop questions from one question set to another:

1. Open the question set that contains the question(s) you want to copy. This is called the source.
2. Open or create the question set you want to insert the copied question(s) into. This is called the target.
3. Click the question number box for the question you want to copy.
4. Press and hold down the mouse button as you drag the question to the target question set. The question is added to the question list.

To select multiple questions:

1. Click the question number box for the first question in the range of questions you want to copy.
2. To drag and drop non-sequential questions, hold down the <Ctrl> key and click the question number boxes for the desired questions. The desired questions are highlighted.
3. To copy or move a range of sequential questions, hold down the <Shift> key and click the question number box for the last question in the range. All questions in the range are highlighted.

4. To move the selected questions to the target template, hold down the <Shift> key and drag the mouse pointer across the screen until the arrow is within the border of the target template tab.

5. Release the mouse button where you would like the questions added in the list. The moved questions are automatically added at that location in the list.

6. To copy the selected questions to the target template, hold down the <Ctrl> key and drag the mouse pointer across the screen until the arrow is within the border of the target template tab.

7. Release the mouse button where you would like the questions added in the list. The copied questions are automatically added at that location in the list.

**LXQuestionEditor: Copying a Question List**

You can use the standard Copy, Cut, and Paste functions, or you can use the drag and drop feature to copy or move a question list from one question set to another.

**Tip**: Review the topic [LXQuestionEditor Keyboard Shortcuts](#) for more information about using the mouse and keyboard within the LXQuestionEditor.

**Copy, Cut, and Paste Method**

To copy or cut and paste a question list from one question set to another:

1. Open the question set that contains the question list you want to copy or move. This is called the **source**.
2. Open or create the question set you want to insert the copied/moved question list into. This is called the **target**.
3. Select the question list name bar for the question list you want to copy.
4. Right-click the mouse and select **Copy** or **Cut** from the pop-up menu, or select **Copy** or **Cut** from the **Edit** menu or toolbar. To use the keyboard, press <Ctrl + C> to copy.
5. Right-click the target question set and select **Paste** from the pop-up menu, or select **Paste** from the **Edit** menu or toolbar. To use the keyboard, press <Ctrl + v> to paste. The question list is added to the target question set.

   To select multiple question lists:

1. Select the question list name bar for the first question list to be copied or moved.
2. Hold down the <Ctrl> key and click the question list name bars for the additional question lists to be copied. The desired question list name bars are highlighted. Right-click the mouse and select **Copy** or **Cut** from the pop-up menu. Or select **Copy** or **Cut** from the **Edit** menu or toolbar.
3. Right-click the target question set and select **Paste** from the pop-up menu. Or select **Paste** from the **Edit** menu or toolbar. The question lists are added to the target question set.

**Drag and Drop Method**

To drag and drop a question list from one question set to another:

1. Open the question set that contains the question list you want to copy. This is called the source.
2. Open or create the question set you want to insert the copied question list into. This is called the target.
3. Click the question list name bar for the question list you want to copy.
4. Press and hold down the mouse button as you drag the question list to the target question set’s question list area. The question list is added to the question set.
To select multiple question lists:

1. Click the question list name bar for the first question list to be copied or moved.
2. Hold down the <Ctrl> key and click the question list name bars for the additional question lists to be copied or moved. The desired question list name bars are highlighted.
3. To move the selected question lists to the target question set, hold down the <Shift> key and drag the mouse pointer across the screen until the arrow is within the border of the target question list area.
4. Release the mouse button. The moved question lists are automatically added to the target question set.
5. To copy the selected question lists to the target question set, hold down the <Ctrl> key and drag the mouse pointer across the screen until the arrow is within the border of the target question list area.
6. Release the mouse button. The copied question lists are automatically added to the target question set.

**LXQuestionEditor: Creating a New Question Set**

If the existing question sets do not meet your needs, create a new set of questions:

1. Select **New Questions** from the LXSoftware **Question** menu. The LXQuestionEditor window appears with a Question List dialog to create a question list.
2. To create a question list, first select the question list type from the displayed list.
3. The question list name may also be entered.
4. Select Next to use the step-by-step technique to add questions to the question list. The Question List properties dialog appears.

**Note:** If Finish is selected, the empty question list is displayed within the LXQuestionEditor window. Questions can then be added using the mouse or keyboard (<Tab> or Arrow keys) to input the question fields.

**Tip:** Review the topic LXQuestionEditor Keyboard Shortcuts for more information about using the mouse and keyboard within the LXQuestionEditor.
5. Enter up to a four-character identification number for the question identifier.

Tip: Contact Lafayette Instrument Company for information on how to expand the maximum question ID length to eight characters.

6. Select the question type (Relevant, Control, Start of Chart, End of Chart, or Other) from the drop-down list.
7. Enter the question text in the text field. Press the Speak button to have the computer read the question aloud.
8. Enter the subject's expected response to the question.
9. If desired select an audio clip, video clip, or picture to be presented during the question. Use the browse button (...) to find the desired file. Select the Record... button to record an audio clip. Press the Speak button to preview the pronunciation of this question using the current speech synthesis settings.
10. Select the Next button to continue adding questions to the question list. Select the Finish button to view the question list in the LXQuestionEditor window.

What should I do next?
You're now ready to select a question set for an open PF.

LXQuestionEditor: Deleting a Question

If a question is no longer applicable and you don't plan to use it in any future polygraph tests, you can delete it. To delete a question from the current question set:

1. Click the question number box for the question you want to delete.
2. Right-click the question number box and select **Delete** from the pop-up menu, select **Delete** from the toolbar, or press the <Delete> key to delete the desired question(s). The question is deleted from the list.

**Note**: To select multiple questions, press and hold down the <Shift> key (for consecutive questions) or the <Ctrl> key as you click the mouse on the question number box for each question.

**Tip**: Review the topic [LXQuestionEditor Keyboard Shortcuts](#) for more information about using the mouse and keyboard within the LXQuestionEditor.

---

### LXQuestionEditor: Deleting a Question List

To delete a question list from an open question set:

1. Select the question list name bar, shown at the top of the desired question list, by clicking it.
2. Select **Delete List** from the **Question List** menu or toolbar, or right-click and select **Delete List** from the pop-up menu. Confirmation is required to prevent accidental question list deletion.

---

### LXQuestionEditor: Editing a Question

In the current question set, you can edit or rephrase any of the question settings.

**To edit a question:**

1. Choose the question you want to edit by selecting the question number box of the desired question.

   **Note**: When you choose a question, the selected question is highlighted.

2. Changes can be made using either of the following methods:
   a. Use the <Tab> key to navigate to the field to change. Type the new information or use the drop down list if available. **Or**...
   b. Use the mouse to select the field or portion of the question to change. Type the new information or use the drop down list if available. **Or**...
   a. After selecting the desired question number box, select **Edit** from the **Questions** menu or toolbar, or right-click and select **Edit** from the pop-up menu. The **Question** dialog appears. Enter changes as necessary.

   **Tip**: Review the topic [LXQuestionEditor Keyboard Shortcuts](#) for more information about using the mouse and keyboard within the LXQuestionEditor.

   **Note**: If Synchronization is turned on, then the question will be changed in all lists of the same type. See [Synchronizing Question Lists](#) for details.

---

**To find and replace a word in each question list in a question set:**

1. Select **Find** from the **Edit** menu or toolbar.
2. The Find and Replace window appears. Enter the word to find within the question list(s) in the **Find What** box. Then enter the word to replace it with in the **Replace With** box. Optionally, you may check the **Match Case** checkbox to locate words which match the case of the word you typed.

3. Select **Find Next** to find the next instance of the word. Select **Replace** to replace that instance of the word.

4. To replace all instances of the word simultaneously, select the **Replace All** button.

5. Click the **Close** button when finished.

**LXQuestionEditor Keyboard Shortcuts**

Shortcut keys can be used as an alternative to the mouse when working in the LXQuestionEditor. You can navigate the menus, questions, and question lists using keyboard shortcuts. Keyboard shortcuts may even make it easier for you to interact with the question editor.

Listed below are a number of keyboard shortcuts that are available within the LXQuestionEditor.

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB</td>
<td>Move forward through question fields.</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Move backward through question fields.</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copy.</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste.</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Undo.</td>
</tr>
<tr>
<td>CTRL+Y</td>
<td>Redo.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Delete.</td>
</tr>
<tr>
<td>SHIFT+DELETE</td>
<td>Delete selected item permanently without placing the item in the Recycle Bin.</td>
</tr>
<tr>
<td>Press</td>
<td>To</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>INSERT</td>
<td>Inserts a blank question into the question list.</td>
</tr>
<tr>
<td>PLUS SIGN on numeric keypad (+)</td>
<td>Add a question to the end of the question list. Opens the Question properties dialog.</td>
</tr>
<tr>
<td>MINUS SIGN on numeric keypad (-)</td>
<td>Delete selected question.</td>
</tr>
<tr>
<td>CTRL while dragging an item with mouse</td>
<td>Copy selected item.</td>
</tr>
<tr>
<td>SHIFT with any of the arrow keys</td>
<td>Select more than one consecutive question.</td>
</tr>
<tr>
<td>CTRL + Up or Down arrow keys</td>
<td>Move one or more selected questions up or down in the question list.</td>
</tr>
<tr>
<td>ALT+F4</td>
<td>Quit the LXQuestionEditor.</td>
</tr>
<tr>
<td>ALT+SPACEBAR</td>
<td>Open the shortcut menu for the active window.</td>
</tr>
<tr>
<td>CTRL+F4</td>
<td>Close the active question set.</td>
</tr>
<tr>
<td>SHIFT+F10</td>
<td>Display the shortcut menu for the selected item.</td>
</tr>
<tr>
<td>ALT+SPACEBAR</td>
<td>Display the System menu.</td>
</tr>
<tr>
<td>ALT+Underlined letter in a menu name</td>
<td>Display the corresponding menu.</td>
</tr>
<tr>
<td>Underlined letter in a command name on an open menu</td>
<td>Carry out the corresponding command.</td>
</tr>
<tr>
<td>HOME</td>
<td>Display the top of the active window.</td>
</tr>
</tbody>
</table>

**LXQuestionEditor: Preferences**

The LXQuestionEditor lets you customize the way the editor operates. To change the default options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select the desired item from the window's left menu. Click the topics below for more information.

- Setting Toolbar/Menu Preferences
- Setting Editor Preferences
- Setting Speech Synthesis Preferences

**LXQuestionEditor: Question List Properties**

To view the **Question List Properties** dialog for an open question list, select **Properties** from the **Question List** menu or toolbar, or right-click the desired question list name bar and select **Properties** from the pop-up menu.

The **Question List Properties** dialog displays the Question List Type and Question List Name for the selected question list.
LXQuestionEditor: Rearranging the Question Order

To arrange the questions in a different order:

**Using the mouse in the grid window**

1. Open the question set that contains the questions you want to reorder.
2. In the grid, click on the question id you want to move.
3. Drag the question id horizontally to its new position and release the mouse button.
4. Repeat steps 1 through 3 for each question to reorder.

**Using the mouse in the editor window**

1. Open the question set that contains the questions you want to reorder.
2. Click the question number box for the question you want to move.
3. Drag the highlighted question to a new position in the question list, and release the mouse button.
4. Repeat steps 1 through 3 for each group you want to reorder.

**Using toolbar buttons**

1. Select the **Move Up** toolbar button to move the selected question up in the selected question list’s order.
2. Select the **Move Down** toolbar button to move the selected question down in the selected question list’s order.

**Using keyboard shortcuts**

1. Open the question set that contains the questions you want to reorder.
2. Use the <Tab> key or Arrow keys to select the question to move. To select multiple questions, press the <Shift> key while using the Up or Down arrow keys.
3. Press the <Ctrl> key while also using the Up or Down arrow keys to move the question(s).
   Or...
4. Use the Cut <Ctrl + X> and Paste <Ctrl + V> shortcuts to move the question(s).
LXQuestionEditor: Record Audio

To include an audio clip with a question in the LXQuestionEditor:

1. Select the checkbox next to **Audio Clip** within the Question properties dialog.

2. To include a previously recorded audio clip, select the Browse button (…) to search for the desired file.

3. To record a clip, select the **Record…** button. The Voice Recording window opens.
4. Select the microphone to use from the drop-down list. This list shows the audio recording devices detected by your system.
5. Select the Record button to record the audio clip. Select the Stop button when finished.
6. To preview the clip, select the Play button.
7. When finished recording click OK to save the file and return to the Question properties dialog. Select Cancel to ignore the changes and return to the Question properties dialog.

**LXQuestionEditor: Save Question Set**

To save an open question set, select Save from the File menu or toolbar. The Save Template dialog appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.
The hierarchy displays the folder and file hierarchy for question templates/question sets. To expand a folder and show its contents, click the plus sign ('+') beside the folder name or double-click the folder icon. To collapse a folder and no longer show it contents, click the minus sign ('-') beside the folder name.

To create new Template categories, select the location under the Templates directory in the hierarchy where you would like to create the new category. Select the New Folder button to create a new category and assign a name to the category.

To delete or rename a question set, select the question set name in the hierarchy and then select the corresponding button. The Delete and Rename buttons can be applied to question set folders also.

To obtain Windows-based file properties for a question set or question set folder, select the item name in the hierarchy and then select the Properties button.
LXQuestionEditor: Validate a Question Set

In LXSoftware, a valid question is defined as having an original ID, an expected response, and question text. Duplicate IDs are not permitted.

Note: If used, the Start of Chart announcement ("X") and End of Chart announcement ("XX") need to be the first and last questions respectively in the chart for the question set to be valid.

To validate a question set, select Validate... from the LXQuestionEditor File menu or toolbar. The Validate window opens, displaying the results of the validation process. Errors are listed for each question that was found to be invalid.

To correct the error(s), double-click the erroneous question, or click on the question and select the Edit button. The Question dialog appears, allowing the error to be corrected.

After correcting the errors, select the Validate window’s Close button.

LXQuestionEditor: Deleting a Question Set
If a question Template or PF Question Set is no longer applicable and you don't plan to use it in any future polygraph examinations, you can delete it.

1. To delete a question set, select the desired template category from the LXSoftware Question menu. The Question Manager dialog appears.
2. Select the desired question set to delete in the question template hierarchy.
3. Select the Delete button to initiate the deletion process. Confirmation is required to prevent accidental file deletion.
4. When finished, press the OK button.

Note: Chart Question Sets are a permanent record of the examination and can never be deleted.

LXQuestionEditor: Editing an Existing Question Set

The available question sets are listed on the Question menu. Question sets fall into the following three categories:

Templates: The Lafayette Polygraph System comes with several Templates. A Template is a question set that may be used as the basis for creating other question sets, or as a question set containing commonly asked questions.

PF Question Sets: PF Question Sets are only available when a PF Folder is open. PF Question Sets are question sets that have been customized for a particular subject and are stored with that subject's PF Folder.

Chart Question Sets: Chart Question Sets are only available when a PF Folder is open. Chart Question Sets are question sets that have been used during chart recording for a specific subject, and are stored with that subject's PF Folder.

For more information about editing existing question sets, select the desired category below.

Templates
PF Question Sets
Chart Question Sets

LXQuestionEditor: Selecting an Exam Type

When you create a new question set, you must specify an exam type. You may select from the following types:

MGQT NTC Other Peak of Tension (POT) Pre-employment Rank Acquaintance Rank Field RI TES Zone

Selecting Zone, TES, Rank, or MGQT serves as a reminder when creating examiner's score sheets.

LXQuestionEditor: Setting Editor Preferences
The LXQuestionEditor lets you customize the way the editor operates. To change the
default options, select Preferences from the Tools menu. The Preferences window
appears. Select Question Editor from the window’s left menu and the Question Editor
property page appears.

To change a setting, click on the row containing the setting to change, click on the down
arrow to display a list of choices and select the new setting.

**Note:** Double-clicking on the second column rotates through the available
options.

**Note:** Click on a setting to see a brief description at the bottom of the window.

The following Question Editor options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Select the font, font size, bold, italic, etc...</td>
</tr>
<tr>
<td>Show Audio Options?</td>
<td>Set to ‘Yes’ to display the audio options. Otherwise, set to ‘No’.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Video Options?</td>
<td>Set to ‘Yes’ to enable video within the editor.</td>
</tr>
<tr>
<td>Show Picture Options?</td>
<td>Set to ‘Yes’ to enable pictures within the editor. This includes web pages.</td>
</tr>
<tr>
<td>Synchronize question lists?</td>
<td>Set to ‘Yes’ to enable question synchronization, which automatically updates identical questions when a question of the same ID and list type is edited.</td>
</tr>
<tr>
<td>Show the question grid on startup?</td>
<td>Set to ‘Yes’ to display the question grid when the editor is opened.</td>
</tr>
<tr>
<td>Horizontal Grid Style</td>
<td>Set to ‘Yes’ to display a horizontal line between all rows in the editor.</td>
</tr>
<tr>
<td>Vertical Grid Style</td>
<td>Set to ‘Yes’ to display a vertical line between all columns in the editor.</td>
</tr>
<tr>
<td>Window arrangement after opening a new file.</td>
<td>Select how windows will be positioned when multiple question sets are opened. The choices are “Tile Vertically”, “Tile Horizontally” and “Cascade”</td>
</tr>
</tbody>
</table>

**Synchronizing Question Lists**

Synchronization attempts to keep all question lists of the same type synchronized such that the lists all contain the same questions, just in a different order. Synchronization allows the operator to change a question's information in the LXQuestionEditor and have that change reflected across multiple lists within the same set. With synchronization turned on, the operator does not have to change a question's information in each list.

**Synchronization Requirements**

When synchronization is turned on, questions are considered to be the same question only if they meet the following criteria:

- The questions are in a list of the same type, such as Zone, MGQT, etc...
- The questions have the same question ID.

**Editing with Synchronization turned On**

After changing a question's information, the system will search for all questions matching the above requirements and will make the same changes to all matching questions. If synchronization is turned off then no additional changes are made.

**Adding Questions with Synchronization turned On**

After adding a new question, the system will search for all lists that are the same type. If matching list types are found then a dialog is displayed as shown below:
How to turn Synchronization On/Off

Synchronization is turned on by default. The setting may be changed in the following ways:

- Select "Question List" from the main menu, then select "Synchronize". A checkmark will be displayed if synchronization is turned on.
- Right-click on the Question Grid and select "Synchronize" from the popup menu. A checkmark will be displayed if synchronization is turned on.
- Select "Tools" from the main menu, then select "Preferences" and the "Synchronize question lists" option.

LXQuestionEditor: Window Menu

The LXQuestionEditor Window menu provides enhanced window management capabilities within the question editor.

To tile open question sets, select the desired option from the Window menu or right-click the open question template name and select the desired option from the pop-up menu.

Cascade

Select to view open question sets in a tiled format, cascading downward from left to right.

Tile Horizontally

Select to view open question sets in a tiled format, displayed horizontally across the screen.
**Tile Vertically**

Select to view open question sets in a tiled format, displayed vertically across the screen.

**Close All**

Select to close all open question sets.

**Windows...**

Select to display the Windows management dialog. The dialog displays a list of currently open question sets. Select the desired button to manage the open windows.

![Windows Dialog](image)

**Tip:** Multiple question sets may be selected within this window by pressing the `<Ctrl>` key while selecting the question sets with the mouse.

**Legacy Question Editor**

To open the Legacy Question Editor, you must first select the default Question Editor for LXSoftware.

After choosing the default editor, the Legacy Question Editor may be opened by selecting **New Questions** from the **Question** menu. To learn more about the editor, click on an item for its description or view the topics below for more information.
Adding a question
Copying a question
Creating a new question set
Deleting a question
Editing an existing question set
Rearranging the question order
Rephrasing a question
Save a question set
Selecting a question set
Selecting an exam type

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question selection</td>
<td>Click on a button to select a question ordering group.</td>
</tr>
<tr>
<td>buttons</td>
<td></td>
</tr>
<tr>
<td>Note: The same</td>
<td>The same questions are in each ordering group.</td>
</tr>
<tr>
<td>questions are in</td>
<td>You can arrange the questions in each ordering group in a different</td>
</tr>
<tr>
<td>each ordering group</td>
<td>sequence. This lets you ask the same questions in four different ways.</td>
</tr>
<tr>
<td>in a different</td>
<td>The text in the question list area matches the selected ordering group (group</td>
</tr>
<tr>
<td>sequence</td>
<td>1, group 2, group 3, or group 4).</td>
</tr>
<tr>
<td>Exam Type</td>
<td>Specifies the type of examination. The exam type is selected when you save</td>
</tr>
<tr>
<td>a</td>
<td>a question set.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Question list area</td>
<td>The active list of questions you will ask the subject. You may add, change or delete any of these questions by selecting the text field.</td>
</tr>
<tr>
<td>Expected Response</td>
<td>Lists the subject's expected response to each question.</td>
</tr>
<tr>
<td>Question ID</td>
<td>The ID for the question. Click on this field to select the question.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The question ID is the number that appears in the question ordering grid.</td>
</tr>
<tr>
<td>Question selection boxes</td>
<td>The question selection boxes are located in a vertical line on the left side of the window. Click on a question selection box to <strong>copy, paste, or delete an entire question</strong> (text, ID, and expected response fields). You can also drag and drop a question selection box from one question set to another (using multiple windows).</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> Use the <code>&lt;Shift&gt;</code> key to select multiple question selection boxes.</td>
</tr>
<tr>
<td></td>
<td>If you want to <strong>edit</strong> a question, do not click the question selection box. Click on the <strong>actual field</strong> and type the new text.</td>
</tr>
<tr>
<td>Question ordering grid</td>
<td>The question ordering grid is located at the top of the window. Use the grid to select and move question IDs.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The numbers in the question ordering grids are the question IDs. They match those listed in the Question ID fields. When you click on an ID in the question ordering grid, it becomes selected in the question list area.</td>
</tr>
</tbody>
</table>

### Legacy Question Editor: Adding a Question

To add a new question to the current question list:

1. Position the cursor in an empty text field.
2. Enter up to a four-character identification number in the **ID** field, then press `<Tab>`.
3. Enter the expected response in the **Expected Response** field (Y or N), then press `<Tab>`.
4. Type the question in the **Text** field. When the question has been added, the identification number appears in the last column of the Question Ordering grid.

### Legacy Question Editor: Copying a Question

You can use the standard Copy, Cut and Paste functions, or you can use the drag and drop feature to copy a question from one question set to another.

The question ordering grid is located at the top of the window. Use the grid to select and move question IDs. The numbers in the question ordering grids are the question IDs.
They match those listed in the Question ID fields. When you click on an ID in the question ordering grid, it becomes selected in the question list area.

To select the entire question (text, ID and expected response fields) to copy or cut, always click the question selection box. The question selection boxes are located in a vertical line on the left side of the window. Click on a question selection box to copy, paste, or delete an entire question (text, ID, and expected response fields). You can also drag and drop a question selection box from one question set to another (using multiple windows). If you want to edit a question, do not click the question selection box. Click on the actual field and type the new text.

**Tip:** Use the <Shift> key to select multiple question selection boxes.

The Exam Type specifies the type of examination. The exam type is selected when you save a question set. Refer to PolyScore Guidelines for more information.

To drag and drop questions from one question set to another:

1. Open the question set that contains the question(s) you want to copy. This dialog box is called the source.

2. Open or create the question set you want to insert the copied question(s) into. This dialog box is called the target.

3. Position the source and target dialog boxes so you can see a portion of each.

4. Click the question selection box for the question you want to copy.
5. Press and hold down the mouse button as you drag the question to the target dialog box. The question is added to the bottom of the question list area. The question list area displays the active list of questions you will ask the subject. You may add, change or delete any of these questions by selecting the text field.

To select multiple questions:

1. Click the **question selection box** for the first question in the range of questions you want to copy. You can only select a range of questions, not non-sequential questions from the list.

2. Hold down the <Shift> key and click the question selection box for the last question in the range. All questions in the range are highlighted.

3. To drag the selected questions to the target template, slide the mouse pointer across the screen until the arrow is within the border of the target template dialog box.

4. Release the mouse button. The copied questions are automatically added at the bottom of the question list.
Legacy Question Editor: Deleting a Question

If a question is no longer applicable and you don’t plan to use it in any future polygraph tests, you can delete it. To delete a question from the current question set:

1. Click the question selection box for the question you want to delete. The question selection boxes are located in a vertical line on the left side of the window. Do not highlight the ID, expected response or text; only highlight the question selection box.

**Tip:** Use the <Shift> key to select multiple question selection boxes.

2. Select **Cut** (Ctrl + X) from the **Edit** menu. The question is deleted from the list.

Legacy Question Editor: Creating a New Question Set

If the existing question sets do not meet your needs, create a new set of questions:

1. Select **New Questions** from the Question menu. The legacy **Question Editor** dialog box appears in an untitled window.
2. Enter the new questions using one or a combination of the following methods:

Position the I-beam cursor in an empty Text field, and type in each question.
Copy and paste questions from an existing question set.

3. When you finish entering the question information, double-click the Control-menu box in the top-left corner (Ctrl + F4 or Ctrl + W) to close the window. The Save Question Set dialog box appears. Click here to learn how to use this dialog box.

Legacy Question Editor: Editing an Existing Question Set

Question sets fall into the following three categories:

**Templates** The Lafayette Polygraph System comes with several Templates. A Template is a question set that may be used as the basis for creating other question sets, or as a question set containing commonly asked questions. To open a template: highlight Templates on the Question menu, and select a template name from the submenu.

**PF Question Sets** PF Question Sets are only available when a PF Folder is open. PF Question Sets are question sets that have been customized for
a particular subject and are stored with that subject's PF Folder. To open a PF Question Set: highlight **PF Question Sets** on the **Question** menu, and select a name from the submenu.

**Chart Question Sets** Chart Question Sets are only available when a PF Folder is open. Chart Question Sets are question sets that have been used during chart recording for a specific subject, and they also are stored with that subject's PF Folder. To open a chart question set: highlight **Chart Question Sets** on the **Question** menu, and select a name from the submenu.

To open a question set:

1. Highlight **Templates**, **PF Question Sets**, or **Chart Question Sets** from the **Question** menu.

2. In the Question Manager, select the question set to edit. The legacy **Question Editor** dialog box appears.

The **question ordering grid** is located at the top of the window. Use the grid to select and move question IDs. The numbers in the question ordering grids are the **question IDs**. They match those listed in the Question ID fields. When you click on an ID in the question ordering grid, it becomes selected in the question list area.
To select the entire question (text, ID and expected response fields) to copy or cut, always click the question selection box. The question selection boxes are located in a vertical line on the left side of the window.

The Exam Type specifies the type of examination. The exam type is selected when you save a question set. Refer to PolyScore Guidelines for more information.

The question list area displays the active list of questions you will ask the subject.

3. Edit, add, delete, or rearrange the questions. You can also copy a question from one template to another.

4. When you finish entering the question information, double-click the Control-menu box in the top-left corner (Ctrl + F4 or Ctrl + W) to close the window. The Save Question Set dialog box appears. Click here to learn how to use this dialog box.

Legacy Question Editor: Rephrasing a Question

In the current question set, you can rephrase any of the questions, change the ID, or change the expected response.

To edit a question:

1. Choose the question you want to edit using one of the following methods:

   In the Question Ordering grid, highlight the ID for the question you want to change.

   In the question list area of the dialog box, position the I-beam cursor on the portion of the question you want to change.

   Note: When you choose a question, a selection box surrounds the information.

2. Highlight the text to change or remove.

3. Select Cut (Ctrl + X) from the Edit menu. Only the selected portion is affected. The rest of the question remains intact.

   Note: This step is optional; you can highlight the text and type the new information without using the Cut command.

4. Type the new information.

Legacy Question Editor: Rearranging the Question Order

The Question Ordering grid boxes allow you to create four groups of questions. Each group contains the same questions, but you can arrange them in a different order (group 1, group 2, group 3, and group 4).

To arrange the questions in a different order:
1. Position the pointer on the question ordering grid box for the ID you want to move.

**Note:** You can also use the question selection boxes in the question list area for the selected group. The question selection boxes are located in a vertical line on the left side of the window.

2. Drag the highlighted grid box to a new position in the group or list, and release the mouse button.

3. Repeat steps 1 and 2 for each group you want to reorder.

**Legacy Question Editor: Selecting an Exam Type**

When you save a question set, you must specify an exam type. You can select from the following types:

Zone  Rank  MGQT  RI  TES  Other

Selecting Zone, TES, Rank, or MGQT serves as a reminder when creating examiner's score sheets.

**Legacy Question Editor: Using the Save Question Set Dialog Box**

1. In the **Name** field, enter a unique name for the new question set. You can use any valid Windows file name in this field. However, you cannot use colons, backslashes (\), or periods (.). Also avoid **DOS device names** such as COM1, COM2, LPT1, LPT2, NUL, AUX, etc.

2. Select the exam type. The exam type specifies the type of examination. The exam type is selected when you save a question set. Refer to **PolyScore Guidelines** for more information.

3. Select the type of question set (e.g., Template or PF Question Set). A **Template** is present for all subjects and can be used as a basis for customizing questions to a particular situation. **PF Question Sets** are question sets that have been customized for a specific subject and are stored in that subject's PF Folder. PF
Question Sets are only visible when the PF for which the question set was created is open.

**Note:** Template is available for any PF at any time. PF Question Set is available only when a PF is open.

4. Exit the dialog box by selecting one of the following options:

   Select **Save** to save the questions. You return to the Chart display window and the new question set is selected.

   Select **Don't Save** to disregard the new question information and close both the Save Question Set dialog box and Legacy Question Editor window.

   Select **Cancel** to close the Save Question Set dialog box and return to the Legacy Question Editor window.

**What should I do next?**

You're now ready to prepare the subject for the test.

**Entering the Exam Information**

Entering exam information lets you create a new exam for the open PF. An exam stores charts recorded over a short period of time (usually one or two days). Exam information focuses on variables that might affect test results, such as lack of sleep, health problems, etc.

**Note:** When a subject is tested periodically, always create a new exam at the beginning of each polygraph session.

To create a new exam:

1. Select **New Exam** from the Exam menu. The Exam Info dialog box appears. The Examiner, Date, Start Time, and Stop Time fields are filled in for you.
2. Enter information in all applicable fields. Don't forget to use the scroll bar to reach all of the questions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Recorded</td>
<td>Used to indicate if the room audio is being recorded.</td>
</tr>
<tr>
<td>Room Monitored</td>
<td>Used to indicate if the room is being monitored.</td>
</tr>
<tr>
<td>Final Call</td>
<td>The Final Call is the determination made by the examiner as the result of an analysis of all examination data. Examples of typical Final Calls are Deception Indicated and No Deception Indicated.</td>
</tr>
<tr>
<td>Requester</td>
<td>The person, department, or agency requesting the test.</td>
</tr>
<tr>
<td>Location</td>
<td>The place the polygraph test is being conducted.</td>
</tr>
<tr>
<td>Sleep Soundly</td>
<td>Indicate if the subject slept soundly.</td>
</tr>
<tr>
<td>Normal Amount</td>
<td>The average number of hours the subject normally sleeps in a 24-hour period.</td>
</tr>
<tr>
<td>Amount Last 24 Hours</td>
<td>The actual number of hours the subject slept within the last 24 hours.</td>
</tr>
<tr>
<td>Breakfast, Lunch, Dinner</td>
<td>Indicate if the subject ate breakfast, lunch, and dinner.</td>
</tr>
<tr>
<td>Prior Polygraph Exam</td>
<td>Indicate if the subject has had a polygraph test. If yes, other information includes: When (date), By Whom, Why, Result</td>
</tr>
<tr>
<td>Prior Arrests</td>
<td>Indicate if the subject has been arrested. If yes, additional information includes: When (date), Location, Offense, Disposition</td>
</tr>
</tbody>
</table>

3. Review the information and correct any typographical errors.
4. Record any additional comments pertaining to the exam information in the PF Notes.

5. When you are finished entering exam data, double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the window.

**Note:** If an exam has already been created for the current PF, the New Exam Warning dialog box appears when you select New Exam from the Exam menu. If you select Continue to create a new exam, you will not be able to record another chart for a previous exam.

**What should I do next?**

You're now ready to record a chart.

**Managing Charts**

The "Chart Manager" dialog allows the operator to quickly locate charts that are part of the opened PF and to manipulate the size and position of each chart. It may be used to open charts, close charts, bring charts to the forefront, cascade charts, tile charts, minimize charts and maximize charts. It provides a quick and convenient way to manage all charts belonging to a PF.
Selecting Charts

To select a single chart just click on the chart name. To select multiple charts perform one of the following actions:

- Click on a chart name, hold the mouse-button down and drag the mouse to quickly select multiple contiguous charts.
- Click on a chart name to select the first chart. Press the <Shift> key and select on the last chart name to select all charts in the list starting with the first chart clicked and ending with the last chart clicked.
- Click on a chart name to select it. Press the <Ctrl> key and click on any other chart names. This will select all of the highlighted charts.

Open Charts

The "Open Charts" listbox allows the operator to quickly see what charts are currently open and available for viewing. It is used to select charts for activating, closing, cascading, tiling horizontally, tiling vertically, minimizing, and maximizing.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>Clicking this button will bring the selected chart to the front if hidden behind other windows. This command is not available if multiple charts are selected.</td>
</tr>
<tr>
<td>Close</td>
<td>Clicking this button will close the selected charts.</td>
</tr>
<tr>
<td>Select All</td>
<td>Clicking this button will select all of the opened charts.</td>
</tr>
</tbody>
</table>

**Note:** Double-clicking on a chart name in the "Open Charts" window maximizes the chart.
Chart Positions

The five "Chart Positions" buttons allow the operator to quickly manipulate the location of opened charts. To change the position of one or more charts, select the charts and then click on one of the five chart position buttons. The buttons from left to right perform the following functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Clicking this button will stagger the selected charts like the picture on the button. Cascaded charts will be overlapped such that the window title bar will be displayed for each chart.</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Clicking this button will arrange the selected charts such that the charts are stacked on top of each other.</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Clicking this button will arrange the selected charts such that the charts are positioned side-by-side.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Clicking this button will minimize the selected charts such that only the window title bar is displayed.</td>
</tr>
<tr>
<td>Maximize</td>
<td>Clicking this button will maximize the selected charts such that the chart window fills the entire application window.</td>
</tr>
</tbody>
</table>

Closed Charts

The Closed Charts" listbox allows the operator to quickly see what charts are closed and allows the user to select one or more charts to be opened. To open charts, simply select the charts and click the Open button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Clicking this button will open the selected charts.</td>
</tr>
<tr>
<td>Select All</td>
<td>Clicking this button will select all of the closed charts.</td>
</tr>
<tr>
<td>Exit</td>
<td>Clicking this button will dismiss the dialog.</td>
</tr>
</tbody>
</table>

Note: Double-clicking on a chart name in the "Closed Charts" window opens the chart.

Note: When opening multiple charts, the windows are positioned according to the "Window Arrangement" chart preference (Maximize, Tile Vertically, Tile Horizontally, Cascade, Legacy) See Setting Chart Preferences for further details.

Resizing the Window

The size of the "Chart Manager" dialog window may be changed by clicking on the bottom-right corner of the window and dragging the mouse. The window size will change as the mouse is moved. The new window size will be used every time the "Chart Manager" dialog is displayed.

Restoring the Window Size and Position

The "Chart Manager" dialog window size and position is set to the size and position of the window when it was last closed. So, simply place the window where you want it and set it's size. Now, every time the window is displayed it will be located where you wanted it and the size that you wanted it to be.
Auto-opening the Chart Manager

A "System Preference" option exists that controls whether the "Chart Manager" dialog is automatically displayed when LXSoftware is started. See Setting System Preferences for further details.

Recording a Chart

Before you record a chart, you must attach the response sensors to the subject and make sure the physiological sensors work properly.

Attaching the response sensors

To attach the response sensors:

1. Place the Thoracic Respiration (P2) and Abdominal Respiration (P1) sensors around the subject.

2. Place the EDA sensors on the subject's fingers.

3. Place the Cardio cuff on the subject, but do not inflate it.

4. Verify that the Auxiliary sensors, if used, are in place.

**Note:** Now is a good time to test and adjust the gain for the individual sensors. Also, ensure the physiological sensors work properly. Inflate the Cardio cuff pressure to between 50 mmHg-135 mmHg, and check the sensor trace.

Please note that real-time cardio cuff pressure and Electrodermal (EDA) measurements are displayed in the status pane at the bottom of the chart recording window.

Recording the chart

To record a chart:

1. Press the **Start** button located in the bottom-right corner of the window. Alternatively, you may right-click on the question text within the chart window and select **Start Chart**.

**Note:** The **Start** commands will not work until you've selected a **PF**, a **Question Set** and an **Exam**.
2. Press <X> to annotate the start position, and tell the subject the test has begun. The Start Announcement Annotation ID appears on the chart.

3. If you do not want to ask the displayed question, select another question ID in the Question Ordering grid (bottom of window). Select the Question Ordering control (small black triangle) to select another question list within the selected question set. Clicking the control will cycle through each question list within the selected question set.

4. When you start to read the question, press the Onset button (or <numeric 0> or <spacebar>) and hold it down until you finish. A gray bar appears on the chart and marks the time it took to read the question.

5. Annotate the subject's response by clicking the + button (Yes) or the - button (No). The next question in the sequence appears at the bottom of the screen.

Note: You can also indicate the subject's response by pressing the + key or the - key on your keyboard; or press the spacebar to indicate the subject gave the expected response.

6. Wait until the progression timer is completely gray and the Onset button reappears. The progression timer shows you how much time you have between questions. You must wait until the timer runs out before you can press the
Onset button to begin the next question. You can adjust the progression time in the Set Question Timer field in the Chart Preferences.

**Note:** The current question timer can be stopped by double-clicking the question timer cylinder or by right-clicking the question text and selecting Stop Question from the popup menu.

7. Annotate the chart if necessary.

8. Repeat steps 3-7 for each question you want to record.

9. When you finish recording question responses, inform the subject the test is finished and press <X>. The Stop Announcement Annotation ID appears on the chart.

10. Press the Stop button. Alternatively you may right-click on the question text within the chart window and select Stop Chart.

**What should I do next?**
You are now ready to review the chart.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensors</td>
<td>Sensors are the detection devices that are attached to the subject and connected to the DAS for input to the Lafayette Polygraph System workstation. You'll work with the following sensors:</td>
</tr>
<tr>
<td></td>
<td><strong>LX5000</strong></td>
</tr>
<tr>
<td></td>
<td>†  P1 (Abdominal Respiration)</td>
</tr>
<tr>
<td></td>
<td>†  P2 (Thoracic Respiration)</td>
</tr>
<tr>
<td></td>
<td>†  GSR (GSR electrodermal)</td>
</tr>
<tr>
<td></td>
<td>†  GSR Detrended (GSR electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>†  GSC (GSC electrodermal)</td>
</tr>
<tr>
<td></td>
<td>†  GSC Detrended (GSC electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>†  PLE (Plethysmograph)</td>
</tr>
<tr>
<td></td>
<td>†  Cardio (Cardiovascular)</td>
</tr>
<tr>
<td></td>
<td>†  Feet (Feet movement)</td>
</tr>
<tr>
<td></td>
<td>†  Seat (Seat movement)</td>
</tr>
<tr>
<td></td>
<td>†  Arms (Arm movement)</td>
</tr>
<tr>
<td></td>
<td><strong>LX4000</strong></td>
</tr>
<tr>
<td></td>
<td>†  P1 (Abdominal Respiration)</td>
</tr>
<tr>
<td></td>
<td>†  P2 (Thoracic Respiration)</td>
</tr>
<tr>
<td></td>
<td>†  EDA (GSR electrodermal)</td>
</tr>
<tr>
<td></td>
<td>†  EDA Detrended (GSR electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>†  Cardio (Cardiovascular)</td>
</tr>
<tr>
<td></td>
<td>†  Aux 1 (Auxiliary 1, typically Movement)</td>
</tr>
<tr>
<td></td>
<td>†  Aux 2 (Auxiliary 2, typically Countermeasure)</td>
</tr>
<tr>
<td></td>
<td>†  Aux 3 (Auxiliary 3)</td>
</tr>
<tr>
<td>Question to read</td>
<td>Lists the question to read in the following format:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>question ID (expected response) question</td>
<td>1 (No) Regarding that piece of paper under your leg, did you write the number 1? To change the font of the question text, right-click on the question text to display the Chart Preferences page.</td>
</tr>
</tbody>
</table>
| Question text menu     | Activate the question text popup menu by right-clicking on the question text in the chart recording window. The menu provides the following options:  
  - Start Chart – Start recording a chart.  
  - Stop Chart – Stop recording a chart.  
  - Stop Question – Stop the question timer.  
  - Center Traces – Center all chart traces simultaneously.  
  - Speech Preview – If speech is enabled, select to have the computer speak the current question.  
  - Speech Enable – Select to enable speech synthesis. When enabled, the computer will ask the questions during the examination and also during chart replay.  
  - Speech Configure – Select to configure speech synthesis. This will open the Speech Synthesis preferences page. |
| Question ordering control | Select the **Question Ordering control** (small black triangle) to toggle through all question lists associated with this question set.                                                                                                                                                                                                 |
| Question ordering grid | Click a Question ID to select a question. **Note**: When a Question Set for a PF is not selected, the grid is blank.                                                                                                                                                                                                                       |
| Question set selector  | Click on the open folder button to access the Question Manager and select a Question Set. **Tip**: Double-click on the edit box to the left of the open folder button to open the active question set for editing in the default question editor.                                                                                                    |
| Start                  | Click here to start recording.                                                                                                                                                                                                                                                                                                             |
| Real-Time Cuff Pressure Display | Real-time measurement of cardio cuff pressure as detected by the cardio sensor.                                                                                                                                                                                                                                                         |
| Real-Time EDA Display  | Real-time Electrodermal (EDA) measurement in Ohms as detected by the EDA sensor.                                                                                                                                                                                                                                                        |
| DAS type               | Displays the currently selected DAS type. There are three selections:  
  - LX5000 = LX5000  
  - LX4000 = LX4000 |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIM</td>
<td>DAS simulator.</td>
</tr>
<tr>
<td>Cardio</td>
<td>Cardio is the Cardiovascular sensor. The default abbreviation (the two characters that appear on the sensor control) is CA. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Cardio property page of the Preferences dialog.</td>
</tr>
<tr>
<td>EDA</td>
<td>EDA is the Electrodermal sensor. For historical reasons, the default abbreviation (the two characters that appear on the sensor control) is GS (Galvanic Skin Conductance). You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Electrodermal property page of the Preferences dialog.</td>
</tr>
<tr>
<td>P1</td>
<td>P1 is the default abbreviation assigned to the Pneumatic 1 sensor control. The P1 sensor produces the Abdominal Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Abdominal Respiration property page of the Preferences dialog.</td>
</tr>
<tr>
<td>P2</td>
<td>P2 is the default abbreviation assigned to the Pneumatic 2 sensor control. The P2 sensor produces the Thoracic Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Thoracic Respiration property page of the Preferences dialog.</td>
</tr>
</tbody>
</table>

Select an Exam for Chart Recording Dialog Box

If the Require entry of Exam Information option in the Examination Preferences is enabled, and you have not created an exam for the current PF, the dialog box appears when you press the Start button on the Chart window.

To create an exam, select the New Exam button and enter the exam information before recording a chart.

Select a PF for Chart Recording Dialog Box

This dialog box appears if you try to record a chart before you open a PF and enter an exam. For example, if a PF is not open when you press the Start button on the Chart window, the dialog box appears.

Do one of the following to proceed:

- To use an existing PF, select the Open PF button.
- To create a new PF, select the New PF button.
- To close this dialog box without choosing a PF, select Cancel.

Annotating a Chart

The Lafayette Polygraph System comes with built-in annotation keystrokes. You can use these default keystrokes to annotate a chart, or you can reprogram the function keys if you do not like the default settings.

The following tables describe the default settings:

<table>
<thead>
<tr>
<th>Annotation Description</th>
<th>Text</th>
<th>Keystore</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Announcement</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Stop Announcement</td>
<td>XX</td>
<td>X</td>
</tr>
<tr>
<td>Annotation Description</td>
<td>Text</td>
<td>Keystroke</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------</td>
<td>-----------------------------------------------</td>
</tr>
</tbody>
</table>
| Question Reading        | (Gray bar) | Onset button, <numeric 0>, or <spacebar>  
Note: Press the annotation key when you start to read a question and hold it down until you finish. |
<p>| Yes                    | +     | + button or &lt;numeric +&gt;                       |
| Expected Response       | + or -| &lt;spacebar&gt; or &lt;numeric 0&gt;                     |
| No                     | -     | - button or &lt;numeric -&gt;                      |
| Not Expected Response   | + or -| &lt;esc&gt; or &lt;*&gt;                                 |
| Movement               | MV    | M                                             |
| Talking                | T     | V                                             |
| Deep Breath            | DB    | D                                             |
| Cough                  | C     | C                                             |
| Clear Throat           | CT    | T                                             |
| Swallow                | SW    | W                                             |
| Sniff                  | SNF   | F                                             |
| Yawn                   | Y     | Y                                             |
| Sneeze                 | SZ    | S                                             |
| Laugh                  | LGH   | L                                             |
| Sleep                  | SLP   | Z                                             |
| Belch                  | B     | B                                             |</p>
<table>
<thead>
<tr>
<th>Annotation Description</th>
<th>Text</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other</td>
<td>OTH</td>
<td>F1</td>
</tr>
<tr>
<td>Outside Noise</td>
<td>OSN</td>
<td>F2</td>
</tr>
<tr>
<td>Inside Noise</td>
<td>ISN</td>
<td>F3</td>
</tr>
<tr>
<td>Examiner Error</td>
<td>EE</td>
<td>F4</td>
</tr>
<tr>
<td>Poorly Worded Question</td>
<td>PW</td>
<td>F5</td>
</tr>
<tr>
<td>Will Repeat Question</td>
<td>WRQ</td>
<td>F6</td>
</tr>
<tr>
<td>Movement Instruction</td>
<td>MI</td>
<td>F7</td>
</tr>
<tr>
<td>Talking Instruction</td>
<td>TI</td>
<td>F8</td>
</tr>
<tr>
<td>Answering Instruction</td>
<td>AI</td>
<td>F9</td>
</tr>
<tr>
<td>Breathing Instruction</td>
<td>BI</td>
<td>F10</td>
</tr>
<tr>
<td>Wake Up</td>
<td>WU</td>
<td>F11</td>
</tr>
<tr>
<td>Take Deep Breath</td>
<td>TDB</td>
<td>F12</td>
</tr>
</tbody>
</table>

Reprogramming keys for chart annotation

To reprogram keys used to annotate a chart:

1. Select **Preferences** from the **Tools** menu. The **Preferences** window appears. Select **Annotations** from the left menu and the **Annotations** property page appears.
2. To reprogram a function key, highlight the value in the corresponding annotation ID field, and enter the new ID to be displayed on the chart.

3. To reprogram a keyboard key, highlight the value in the Key column, and enter the new keystroke. If desired, select the corresponding annotation ID field and enter the new annotation ID to be displayed on the chart.

   **Note:** Select the Print button to print the current annotation keystrokes.

4. When you are finished changing key assignments or annotation IDs, press OK to save the changes, or press Cancel to ignore the changes and retain the default values.

### Scoring a Chart

The LXSoftware provides two primary options for scoring a chart: automatic and manual.

During automatic scoring, a computer algorithm examines the sensor data and automatically provides a recommended decision with minimal effort on the part of the user.
examiner. Automatic scoring algorithms are commonly referred to as computerized scoring algorithms. Examples of automatic scoring algorithms available for use with the LXSoftware are PolyScore®, QuEST, ASIT, Identifi, and the Objective Scoring System (OSS). Only OSS is provided with the LXSoftware. The other algorithms are available for an additional fee by contacting Lafayette Instrument Company.

In addition to the aforementioned scoring algorithms, a Countermeasure Detection Algorithm is also provided. The Countermeasure Detection Algorithm attempts to detect the use of mental and physical countermeasures employed by the subject during an examination.

During manual scoring, a score sheet is provided in which the examiner may enter “hand scores” without the aid of a computer algorithm.

**Recommended Question Formats**

PolyScore® produces a probability of deception for two common test question sequences: Zone Comparison and MGQT. These are both Probable Lie comparison/control question techniques. The Zone is a single issue exam, while the MGQT allows for multiple aspects of a single issue. The Zone/MGQT algorithm is not suitable for the truly multiple issues of a screening exam (e.g., RI, TES).

The Rank scoring algorithm has been used successfully when comparing responses in multiple issue (screening) tests and it is recommended for use for Guilty/Concealed Knowledge tests. It does not provide a probability of deception, but it can help you identify which of the subject’s reactions are the greatest over a series of charts. The most reactive spot will be assigned a value of ten (10.0) for both the deceptive and non-deceptive subject, even if all the reactions are small. The others will be assigned a ranking relative to the largest between 0 and 10.

For sample questions, select Zone, MGQT, MGQT Mixed.

As illustrated in the previous typical question lists, using a C or R in the question ID field when constructing the question list will allow PolyScore® to automatically identify the comparison/control and relevant questions, respectively, when scoring.

**Scoring a Chart Manually**

After recording a chart, an examiner's manual score sheet can be created.

**Selecting Examiner Scoring**

When preparing to score charts for a PF, first select a scoring technique. To choose a scoring technique:

1. Select **Score** from the **Exam** menu, and then select the **scoring technique** from the submenu.

---

14 A well-defined computational procedure that takes some value, or set of values, as input and produces some value, or set of values, as output.
If you select **Examiner...**, the **Open Score Sheet** dialog box appears with the names of all score sheets for the open PF listed. As indicated, multiple score sheets can exist for each chart. Multiple score sheets may be selected simultaneously by either dragging the mouse through the score sheets to open or by shift-clicking on individual score sheets. Once the desired score sheets are selected, select the **Open** button. The charts associated with a score sheet are indicated in the Chart column. Note that TES score sheets are always associated with a single chart. Zone, MGQT, and Rank score sheets can be associated with multiple charts in an exam.

Selecting the **New** button in the **Open Score Sheet** dialog box displays the **New Score Sheet** dialog box. This dialog displays a list of all charts for the currently open PF. Examiner score sheets can be created as needed by either the original examiner or by one or multiple reviewers.

To **select** one or more charts to associate with the score sheet:

1. Highlight the number of the chart you want to include using the mouse or the <up arrow> and <down arrow> keys.
2. Select **Include**. A check mark appears in front of the chart number.
Tip: For a shortcut, double-click the chart you want to include. A check mark appears in front of the chart number.

3. Repeat steps 1 and 2 for each additional chart you want to include.

After selecting all the charts to associate with the score sheet:

1. Select the score sheet type from the Score Sheet Type list box.
2. Select Create.

Deselecting a chart
If you accidentally select a chart, you can deselect it using the Exclude button (the toggle of the Include button; when you highlight a chart with a check mark beside it, the button reads Exclude). To exclude a chart from the scoring process:

1. Highlight the number of the chart you want to exclude using the mouse or the <up arrow> and <down arrow> keys.
2. Select Exclude (E). The check mark is removed from in front of the chart number, and the chart will not be associated with the score sheet.

Tip: For a shortcut, double-click the chart you want to exclude. The check mark is removed from in front of the chart number.

Click on one of the following exam types to see a sample score sheet:
TES
MGQT
Zone
Rank

MGQT Score Sheet
The following is a sample MGQT score sheet:

Hand score each relevant question for the Pneumo, EDA, and Cardio responses by entering values (-3 to +3) into the rows and columns on the score sheet. As values are entered, a total is automatically calculated and displayed at the bottom of the score sheet. Spot Call selections can be made for each spot on the MGQT score sheet.

MGQT score sheets are saved with the chart(s) in the subject's PF folder.

The Information tab of the Score Sheet dialog contains relevant information about the chart including the subject name, original examiner, and date the chart was recorded. Additionally, space is provided to enter reviewer information, including reviewer name, reviewer title, date reviewed, and whether the reviewer concurred with the original examiner's score.
R1 indicates the first relevant question, R2 indicates the second relevant question, etc. ID indicates the question ID corresponding to the relevant question that was asked on the first chart.

**Tip:** You can toggle between the examiner score sheet and the Chart Review window. To bring the Chart Review window to the front, click on it with the mouse. To bring the score sheet to the front, press (Ctrl+A).

**MGQT**

The following is a typical MGQT question list:

- X The test is about to begin.
- 1 Are you in the state of Maryland?
- 2 Is this the month of November?
- R3 Did you plan with anyone to steal those truck tires from your mother’s basement?
- 4 Are you called John?
- R5 Did you steal any of those truck tires from the basement of your mother’s home?
- C6 Prior to this year, did you ever steal anything from someone who really trusted you?
- 7 Are the lights on in this room?
- R8 Do you know where any of those missing truck tires are now?
- R9 Were you present when those truck tires were stolen from your mother’s home?
- C10 Have you ever cheated a friend out of anything?
- XX The test is over. Please remain still.

**MGQT Mixed**

When using the MGQT format with PolyScore, the mixed series must be used on the third chart, and should look similar to the following:

- X The test is about to begin.
- 4 Are you called John?
- 1 Is today Thursday?
- R5 Did you any of those truck tires from the basement of your mother’s home?
- C6 Prior to this year, did you ever steal anything from someone who really trusted you?
R3 Did you plan with anyone to steal those truck tires from your mother’s basement?

C10 Have you ever cheated a friend out of anything?

R9 Were you present when those truck tires were stolen from your mother’s home?

C6 Did you ever steal anything from someone who really trusted you?

R8 Do you know where any of those missing truck tires are now?

C10 Have you ever cheated a friend out of anything?

XX The test is over. Please remain still.

**Rank Score Sheet**

Hand score each relevant question for the Pneumo, EDA, and Cardio responses by entering values (-3 to +3) into the rows and columns on the score sheet. As values are entered, a total is automatically calculated and displayed at the bottom of the score sheet. Rank score sheets are saved with the chart(s) in the subject's PF folder.

The **Information** tab of the Score Sheet dialog contains relevant information about the chart including the subject name, original examiner, and date the chart was recorded. Additionally, space is provided to enter reviewer information, including reviewer name, reviewer title, date reviewed, and whether the reviewer concurred with the original examiner's score.

**R1** indicates the first relevant question, **R2** indicates the second relevant question, etc.
**ID** indicates the question ID corresponding to the relevant question that was asked on the first chart.

You can toggle between the examiner score sheet and the **Chart Review** window.

To bring the Chart Review window to the front, click on it with the mouse.

To bring the score sheet to the front, press (Ctrl+A).

**TES Score Sheet**

The following is a sample TES score sheet:
Hand score each relevant question for the Pneumo, EDA, and Cardio responses by entering values (-3 to +3) into the rows and columns on the score sheet. As values are entered, a total is automatically calculated and displayed at the bottom of the score sheet.

TES score sheets are saved with the chart(s) in the subject’s PF folder.

The **Information** tab of the Score Sheet dialog contains relevant information about the chart including the subject name, original examiner, and date the chart was recorded. Additionally, space is provided to enter reviewer information, including reviewer name, reviewer title, date reviewed, and whether the reviewer concurred with the original examiner’s score.
**Zone Score Sheet**

The following is sample Zone score sheet:

![Zone Score Sheet Image]
Hand score each relevant question for the Pneumo, EDA, and Cardio responses by entering values (-3 to +3) into the rows and columns on the score sheet. As values are entered, a total is automatically calculated and displayed at the bottom of the score sheet. Spot Call selections can be made for each spot on the Zone score sheet.

Zone score sheets are saved with the chart(s) in the subject's PF folder.

The Information tab of the Score Sheet dialog contains relevant information about the chart including the subject name, original examiner, and date the chart was recorded. Additionally, space is provided to enter reviewer information, including reviewer name, reviewer title, date reviewed, and whether the reviewer concurred with the original examiner's score.

R1 indicates the first relevant question; R2 indicates the second relevant question, etc. ID indicates the question ID corresponding to the relevant question that was asked on the first chart.

You can toggle between the examiner score sheet and the Chart Review window.

To bring the Chart Review window to the front, click on it with the mouse.

To bring the score sheet to the front, press (Ctrl+A).

**Zone Comparison**

The following is a typical Zone Comparison question list:

X The test is about to begin.

1 Is today Friday?

2 Regarding the money taken from the cash drawer, do you intend to answer truthfully each question about that?

3 Are you completely convinced that I will not ask you a question on this test that has not already been reviewed?

C4 Prior to your last birthday, did you ever lie to anyone in authority?

R5 Did you take any of that money taken from the safe?

C6 Before 1994, did you ever deliberately do anything dishonest?

R7 Did you take any of that money from the safe last Wednesday?

8 Is there something else you are afraid I will ask you a question about, even though I have told you I would not?

C9 Before your last birthday, did you ever lie to someone who really trusted you?

R10 Did you have any of that money after it was taken from the safe?

or

R10 Do you know where any of that money that was taken from the safe is now?
The test is over. Please remain still.

Depending on the situation, Question R10 can sometimes make the Zone a two-issue test. The performance of PolyScore® is improved when question R10 addresses the same issue as is addressed in questions R5 and R7. The 'Do you know where ...?' is often used. When it is possible that the subject strongly suspects someone or thinks they know where the money is, then another form of question R10, perhaps as suggested, should be used.

**Scoring a Chart Using ASIT**

After charts are recorded, they can be automatically scored using the ASIT scoring algorithm. The ASIT scoring algorithm is not contained within the LXSoftware, but rather is a separate program that may be launched from within the LXSoftware. See the *ASIT User Guide* for instructions on using the ASIT scoring algorithm.

To select the ASIT Scoring Algorithm:

1. Select *Score* from the *Exam* menu, and then select *ASIT* from the submenu.
2. The ASIT program will be launched automatically.

**Scoring a Chart Using Identifi**

After charts are recorded, they can be automatically scored using the Identifi scoring algorithm. The Identifi scoring algorithm is not contained within the LXSoftware, but rather is a separate program that may be launched from within the LXSoftware. See the *Identifi User Guide* for instructions on using the Identifi scoring algorithm.

To select the Identifi Scoring Algorithm:

1. Select *Score* from the *Exam* menu, and then select *Identifi* from the submenu.
2. The Identifi program will be launched automatically.

**Scoring a Chart Using PolyScore®**

If PolyScore for Windows Version 5.1 or higher is installed on the same computer as the LXSoftware, that program will be automatically launched when the APL algorithm is chosen from the *Score* menu. If it is not installed, then the PolyScore menu item is not displayed.

Refer to *PolyScore Guidelines* for more information.

**PolyScore Guidelines**

PolyScore imposes the following chart collection requirements:

1. The event markers (beginning-of-question and end-of-question) must be entered for each valid comparison/control and relevant question. The keystrokes must be entered accurately (within one second of the actual time).

2. You must allow at least 25 seconds between question onsets (the time between when you start asking a question and the time you start asking the next question). Refer to *Setting Chart Preferences* for information about setting the question timer.
3. Use the start of chart (X) and end of chart (XX) marks when recording a chart.

4. Record at least three (3) charts for Zone and MGQT format and four (4) charts for Bi-Zone.

5. For all charts, only the first nine (9) minutes following the start of chart (X) mark are used.

6. The test type (Zone/MGQT or Rank) must match the test given. The SKY question sequence sometimes used with the Zone Comparison test has not been used in algorithm development and should not be scored using PolyScore®.

7. If there is a movement or other artifact occurring during a comparison/control or relevant question response (within the first 18 seconds after the beginning of the question for respiration, within the first 8 seconds for blood volume, or within the first 14 seconds for the electrodermal or galvanic skin response), then components of the response must be dropped.

8. The blood pressure cuff should not be inflated beyond the diastolic pressure, typically less than 65 mmHg.

!!! WARNING !!!

PolyScore results are affected by the quality of the chart recording process. Computerized scoring cannot overcome improper pretesting, bad question formulation, or degenerate tracings (i.e., pneumo tubes that are stretched too tightly or not tightly enough, under-inflated cardio cuff, or flat, wandering, noisy, or erratic EDA). Do not use PolyScore® to score poor-quality charts.

For a list of sample questions, see Recommended Question Formats.

In addition to marking the Control/Comparison and Relevant questions, you must also exclude components from the PolyScore® scoring process.

At the conclusion of the scoring process, a scoring report is generated.

Select Scoring Algorithm

When preparing to score charts for a PF, first select the scoring algorithm\(^\text{15}\). To choose a scoring algorithm:

1. Select Score from the Exam menu, and then select the scoring algorithm from the submenu.

\(^{15}\) A well-defined computational procedure that takes some value, or set of values, as input and produces some value, or set of values, as output.
If you select **OSS**, the Scoring dialog box appears with a list of charts for the current PF:
If Auto-select charts to score\(^{16}\) was selected in the Examination Preferences, all charts will be automatically selected for inclusion in the scoring process.

You're now ready to select the charts to include in the scoring process.

**Excluding PolyScore® Components**

The scoring algorithm analyzes the sensor traces for each question and identifies which components (i.e., thoracic respiration, electrodermal, cardio blood volume, or cardio pulse) should not be used when scoring. If a movement artifact is detected, the sensor component of the affected question is recommended to be dropped from the scoring process. Questions with dropped components will not be scored, similar to "zeroing out" a component during hand scoring.

**Adding and Removing Exclusions**

You can exclude components that were not automatically selected or reinclude components marked for exclusion. As a general rule, you should follow the suggestions made by PolyScore® and, in addition, drop all components that you feel contain artifacts or should not be used in scoring the chart. If the program tags a component that is a valid response, you must remove the tag.

Components should be dropped only if the artifact occurs during the reaction interval used by PolyScore®. For the Blood Volume Derivative channel, PolyScore® examines the rate of increase of the blood volume from the beginning of the question until 8 seconds after the start of the question. For the Electrodermal channel, the reaction period is from 2 seconds after the start of the question until 14 seconds after the start of the question. Artifacts outside of the response window should be ignored. The response interval for each channel is shown in the following figure:
What should I do next?
You're now ready to review the scoring report

**Reviewing the PolyScore® Scoring Report**

The PolyScore® scoring report includes the following information:

1. Algorithm version number (for example, 5.1)
2. Overall probability of deception
3. Algorithm format used (for example, Zone/MGQT)
4. PF name and charts scored
5. Spot scores
6. Channel weights
7. Question scores

**Spot Scores**

The spot scores give you the probability of deception for each of the relevant questions. It assumes that each of the different relevant questions will have different wording, but that relevant questions are repeated on different charts. The spot scores are useful for identifying 'hot' issues for interrogation or questions which may need rephrasing.

The spot score is the probability of deception based only on the particular question. Spot scores result from a completely different algorithm than the overall score.
Therefore, the spot scores do not add up to the overall score. Particularly for MGQT exams, spot scores should NOT be used as the basis for making an overall decision - that is what the overall probability is for.

**Channel Weights**

The channel weights approximate the percentage contribution to the overall probability of deception stemming from a particular sensor or channel. Positive weights indicate an NDI tendency and negative weights a DI tendency. The absolute values of the weights add to one (except for round-off error where the total will be .99). Two points must be noted:

- It is not uncommon to have differing tendencies between channels.
- The actual amount of information coming from, and therefore weight given to, a channel varies from individual to individual.

Channel weights can be used to confirm an examiner’s suspicion about controlled breathing, for example.

**Question Scores**

The question scores show how each question on the exam was tagged, which questions had artifacts, and which had outliers. The reactivity for each comparison/control and relevant question is shown. Like the spot and channel scores, the reactivities provide the examiner with diagnostic information. No conclusions should be reached on the basis of these scores. Individual question scores may not be consistent with the overall probability of deception.

**Recommendation**

PolyScore processes information from the charts in a way which is different from the traditional method and on occasion will be different from your scores. The spot probabilities must necessarily use different quantities than those used in computing the overall probabilities. Therefore, channel or spot probabilities may not be consistent with the overall probability.

The scoring report provides the single number from which to make a decision - the overall probability of deception. If, for example, the probability of deception is greater than .99, fewer than 1 examinee in 100 will exhibit such reactions and still be telling the truth. Any conclusions based on PolyScore® probabilities should be based only on the overall probability of deception.

The spot probabilities are to be viewed only with the overall conclusion in mind and are provided for insights. The examiner may use spot probabilities and channel weights to better understand the PolyScore® results.

The typical examiner will obtain an inconclusive result about 15% of the time, slightly more with MGQTs and less with Zones. It is tempting to select a different chart or use trial-and-error retagging in hopes of forcing PolyScore® into a decision; or even worse, using spot scores. ‘Shopping’ for a conclusive decision could also produce one which is incorrect.

Inconclusives are an unfortunate fact of life, even with computerized scoring. They can be minimized by testing using the Zone format whenever possible. Obviously, the pre-test and question formulation play a very large role in reducing inconclusives. The proper resolution of an inconclusive is a retest!
Use the information contained in the spot scores from the first inconclusive exam to assist in clarifying questions and focusing issues for the retest.

**Scoring a Chart Using QuEST**

After charts are recorded, they can be automatically scored using the Quantitative Evaluation System (QuEST) scoring algorithm. The QuEST scoring algorithm is not contained within the LXSoftware, but rather is a separate program that may be launched from within the LXSoftware. See the *QuEST User Guide* for instructions on using the QuEST scoring algorithm.

To select the QuEST Scoring Algorithm:

1. Select **Score** from the **Exam** menu, and then select **QuEST** from the submenu.
2. The QuEST program will be launched automatically.

**Scoring a Chart Using the Objective Scoring System**

After charts are recorded, they can be automatically scored using the Objective Scoring System (OSS) scoring algorithm. The OSS scoring algorithm analyzes the sensor traces for each chart selected and formulates a recommended decision based on the data.

For information about using the OSS scoring algorithm, see **OSS Guidelines**.

The general procedure for scoring charts is as follows:

1. **Open the PF containing the charts to score**.
2. **Select the scoring algorithm to use**.
3. **Select the charts to include in the OSS scoring process**.
4. **Select the questions to score in each chart**.
5. **Specify the list of components to exclude from the scoring process**.
6. **Review the scoring report**.

To manually score charts recorded using MGQT, TES, Rank, or Zone as the exam type, select **Examiner...** from the **Score** menu.

**OSS Guidelines**

OSS imposes the following chart collection requirements:

1. You must allow at least 10 seconds between question onsets (the time between when you start asking a question and the time you start asking the next question). Refer to **Setting Chart Preferences** for information about setting the question timer.
2. Record three (3) charts, each containing three relevant and three comparison questions, conducted as a single-issue DODPI Zone Comparison Technique using exclusionary probable-lie comparison questions. Other question set
formats have not been validated during the algorithm development and should not be scored using OSS.

3. If there is a movement or other artifact occurring during a comparison/control or relevant question response (within the first 10 seconds after the beginning of the question for respiration, from question onset to next question onset for blood volume, or within the first 20 seconds for the electrodermal or galvanic skin response), then components of the response must be dropped.

!!! WARNING !!!

The validity of the OSS decision is a function of accuracy of the data entered, and the adherence to standard ZCT protocol. The algorithm assumes that the data are adequate: highly unstable, heavily artifacted, or very unresponsive tracings that are not suitable for manual scoring are also not suitable for the OSS. Users of this algorithm should base their professional opinions of the polygraph data on analytical methods for which they are trained. The OSS is provided here to expedite the algebraic computations of those who use and are trained in the OSS.

For sample questions, select Zone.

As illustrated in the previous sample question list, using a C or R in the question ID field when constructing the question list will allow OSS to automatically identify the comparison/control and relevant questions, respectively, when scoring.

Selecting OSS Charts to Score

To select one or more charts to include in the scoring process:

1. Highlight the number of the chart you want to include using the mouse or the <up arrow> and <down arrow> keys.

2. Select Include (I). A check mark appears in front of the chart information.
Tip: For a shortcut, double-click the chart you want to include. A check mark appears in front of the chart information.

3. Repeat steps 1 and 2 for each additional chart you want to include.

After selecting all the charts to include in the scoring process, select **Score (S)**. The scoring algorithm performs initial data processing and question type identification, and the **Set Question Types dialog box** appears for tagging questions.

**Deselecting a chart**

If you accidentally select a chart, you can deselect it using the **Exclude** button (the toggle of the **Include** button; when you highlight a chart with a check mark beside it, the button reads **Exclude**). To **exclude** a chart from the scoring process:

1. Highlight the number of the chart you want to exclude using the mouse or the <up arrow> and <down arrow> keys.

2. Select **Exclude (E)**. The check mark is removed from in front of the chart information, and the chart will not be scored.

**Tip:** For a shortcut, double-click the chart you want to exclude. The check mark is removed from in front of the chart information.

**Displaying a chart**

You can also use this dialog box to **display** a specific chart:

1. Highlight the number of the chart you want to display using the mouse or the <up arrow> and <down arrow> keys.

---

17. The process by which questions are identified as a particular type, such as relevant, or comparison/control.
2. Select View Chart (V). The chart appears.

What should I do next?
You're now ready to tag the questions.

Select OSS Questions

The Select Questions dialog box displays the list of questions for the first chart included in the scoring process:

<table>
<thead>
<tr>
<th>Type</th>
<th>ID</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Is this the month of __________?</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Regarding __________, do you intend to answer truly each question about __________?</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Are you completely convinced that I will not ask you a question on this test?</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>C4</td>
<td>Prior to __________, did you ever __________?</td>
</tr>
<tr>
<td>R</td>
<td>R5</td>
<td>Did you ____________?</td>
</tr>
<tr>
<td>C</td>
<td>C6</td>
<td>Before your __________ birthday, did you ever ____________?</td>
</tr>
<tr>
<td>R</td>
<td>R7</td>
<td>Did you ____________?</td>
</tr>
<tr>
<td>8</td>
<td>Is there something else you are afraid I will ask you a question about, even though you are sure you will not be asked?</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>C9</td>
<td>Prior to 19__, did you ever ____________?</td>
</tr>
<tr>
<td>R</td>
<td>R10</td>
<td>Did you ____________?</td>
</tr>
</tbody>
</table>

Step 2: Select three control questions and three relevant questions from each chart.

The question type tags are displayed in the Type column and correspond to the first letter of the question type (e.g., O = Other, C = Comparison/Control, and R = Relevant). Note that questions of type Other display as a blank in the Type column.

Note: Scoring accuracy depends on the correct tagging of questions.

Warning

If comparison/control or relevant questions contain artifacts or should not be used in scoring for other reasons, you must remove those questions from use by the scoring algorithm by using a blank for a mark. Any question not marked with a C or an R will not be used in scoring the test. If only certain components of a reaction contain artifacts, then only those components need to be deleted. A procedure for deleting components is described later. Although an effort has been made to minimize the effects of abnormalities, you may obtain invalid scores if you include invalid questions or questions with artifacts or other abnormalities while scoring charts.
Changing a tag
To assign a different tag to a question in the current list:

1. Highlight the question using the mouse or the <up arrow> and <down arrow> keys.
2. In the Question Type group box, select the appropriate option button or type the first character of the tag, such as r for Relevant. The new tag is displayed in the Type column.
3. Repeat steps 1 and 2 for each question tag you want to change.
4. Review the questions for the other charts in the scoring process. See "Viewing other questions," next, to learn how.

Viewing other questions
To display the questions used while recording one of the other selected charts:

1. Press the ↑ or ↓ arrows in the Chart Control group box, or use the <page up> and <page down> keys until the desired exam and chart number is displayed:

![Chart Control](chart-control.png)

2. Revise the question type tags as appropriate.
3. Repeat this process for each chart selected for scoring.
4. After reviewing the questions and tags for all the charts in the scoring process, select OK. The Exclude Components dialog box then appears.

What should I do next?
You're now ready to exclude components from the scoring process.

Excluding OSS Components
Components of unstable, artifacted, and unresponsive tracings must be dropped from the scoring process. For example, if a movement artifact is detected, the affected sensor component(s) of the affected question must be dropped. Dropped components will not be scored, similar to "zeroing out" a component during hand scoring. For control questions, components from the nearest control question will be used in place of the dropped components. Any substitutions made by the scoring algorithm will be indicated on the OSS Scoring Report.

The Exclude Components dialog box displays the current chart's questions and exclusions, indicated by the capital letters appearing in the Drop column. The letters
below indicate artifacts were detected in the Abdominal (A) Respiration trace and the Electrodermal (E) trace of the associated questions.

For this chart, the Abdominal (A) Respiration trace for question C4 and the Electrodermal trace for question R7 are marked for exclusion from scoring. To display and evaluate the current chart, select View Chart from the Chart Control group box. To continue the scoring process, select OK.

Adding and Removing Exclusions

You can exclude components or re-include components marked for exclusion. As a general rule, you should drop all components that you feel contain artifacts or should not be used in scoring the chart.

Components should be dropped only if the artifact occurs during the reaction interval used by OSS. For the Cardio channel, the OSS evaluates the entire trace between question onsets. For the Electrodermal channel, the reaction period is from the start of the question until 20 seconds after the start of the question. For the Respiration channel, the reaction period is 10 seconds after the start of question. Artifacts outside of the response window should be ignored.

To exclude components, use the following procedure:

1. Highlight the question using the mouse or the <up arrow> and <down arrow> keys.
2. To exclude a component from the score, either select the check box in the Drop Components group box, or type the first character in the component’s name, such as E to drop the Electrodermal component for the highlighted question.
To include a component in the scoring process that was previously excluded, use the following procedure:

1. Highlight the question using the mouse or the <up arrow> and <down arrow> keys.
2. To include the component in the score, either select the check box in the Drop Components group to unmark it, or type the first character in the component's name.

**Viewing Other Chart Exclusions**

To view the questions and the components to exclude from other charts, use the following method:

1. Press the \( \uparrow \) or \( \downarrow \) arrows in the Chart Control group box, or use the <page up> and <page down> keys until the desired exam and chart number is displayed.
2. Review and modify the component exclusions for each chart as described in "Adding and Removing Exclusions" above, then select **OK**.

**What should I do next?**

You're now ready to review the scoring report.

**Reviewing the OSS Scoring Report**

The OSS scoring report includes the following information in the order presented:

1. Recommended decision
2. PF name and charts scored
3. Spot scores
4. Channel contributions
5. Question set information

**Spot Scores**

The spot scores give you the scores for each spot as well as the IDs of the questions comprising the spot. Note that although there are two respiration channels, only the single channel with the score farthest from zero is used. The spot scores are totaled by spot for each chart and for the set of three charts. A grand total spot score is derived from these subtotals and displayed at the bottom right corner of the Spot Score section.

**Channel Contributions**

The channel contributions are used to summarize the contribution of the individual channels to the grand total spot score presented in the Spot Score section.

**Question Set Information**

The question set information sections indicate the questions scored by the OSS algorithm. The question types and dropped components are indicated as well.
The recommended decision is NDI.

Based on the published field research, the likelihood that these polygraph data were produced by a deceptive subject is 3% or lower.

### Charts Scored: OSS Example

<table>
<thead>
<tr>
<th>Chart</th>
<th>Exam</th>
<th>Date</th>
<th>Time</th>
<th>Examiner</th>
<th>QuestionSet</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2/5/2001</td>
<td>9:29 AM</td>
<td>kevinh</td>
<td>ZCT</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2/5/2001</td>
<td>9:34 AM</td>
<td>kevinh</td>
<td>ZCT</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>2/5/2001</td>
<td>9:39 AM</td>
<td>kevinh</td>
<td>ZCT</td>
</tr>
</tbody>
</table>

### Spot Scores

<table>
<thead>
<tr>
<th>Chart</th>
<th>Exam</th>
<th>Spot 1</th>
<th>Spot 2</th>
<th>Spot 3</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abdominal (P1)</td>
<td>3 (R5/C4)</td>
<td>3 (R7/C6)</td>
<td>-2 (R10/C9)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thoracic (P2)</td>
<td>6 (R5/C4)</td>
<td>6 (R7/C6)</td>
<td>-6 (R10/C9)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electrodermal</td>
<td>-3 (R5/C4)</td>
<td>-3 (R7/C6)</td>
<td>-3 (R10/C9)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cardio</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Printing Scoring Reports

The Scoring Report is not saved to disk, so if you want to maintain a record of the scoring results, you must print a copy of the report prior to closing the Scoring Report window. To print a copy of the report while it is displayed on the screen, select **Print** from the **File** menu.

### Performing Countermeasure Detection

The optional Lafayette Countermeasure Detection System (Model 76876US) may be used with the Lafayette Polygraph System to detect mental and physical countermeasures employed by a subject during an examination. Once you have acquired the Countermeasure Detection System, it must be attached via a category 5 patch cable (available at most computer stores) to the Aux 2 input of the LX4000.

To display the Aux 2 trace, follow the instructions for setting Trace Preferences.

Once the trace has been displayed, the LXSoftware must be informed to begin saving countermeasure scoring data. To enable saving of countermeasure scoring data, modify the Administrator Preferences.

**Note:** Only charts recorded using software version 9.1.1 or newer may be scored using the Countermeasure Detection algorithm.
**Selecting the Countermeasure Detection Algorithm**

The general procedure for performing countermeasure detection is as follows:

1. **Open the PF containing the charts to score**
2. Select the Countermeasure menu item from the Exam->Score menu
3. **Select the charts to include in the Countermeasure Detection process**
4. **Select the questions to score in each chart**
5. **Review the Countermeasure report**

**Selecting Countermeasure Charts to Score**

To select one or more charts to include in the Countermeasure Detection process:

1. Highlight the number of the chart you want to include using the mouse or the <up arrow> and <down arrow> keys.
2. Select Include (I). A check mark appears in front of the chart information.

**Tip:** For a shortcut, **double-click** the chart you want to include. A check mark appears in front of the chart information.

3. Repeat steps 1 and 2 for each additional chart you want to include.
After selecting all the charts to include in the scoring process, select **Score** (S). The Countermeasure Detection algorithm performs initial data processing and question type identification, and the **Set Question Types dialog box** appears for tagging questions.

**Deselecting a chart**
If you accidentally select a chart, you can deselect it using the **Exclude** button (the toggle of the **Include** button; when you highlight a chart with a check mark beside it, the button reads **Exclude**). To exclude a chart from the scoring process:

1. Highlight the number of the chart you want to exclude using the mouse or the <up arrow> and <down arrow> keys.
2. Select **Exclude** (E). The check mark is removed from in front of the chart information, and the chart will not be scored.

**Tip:** For a shortcut, **double-click** the chart you want to exclude. The check mark is removed from in front of the chart information.

**Displaying a chart**
You can also use this dialog box to **display** a specific chart:

1. Highlight the number of the chart you want to display using the mouse or the <up arrow> and <down arrow> keys.
2. Select **View Chart** (V). The chart appears.

**What should I do next?**
You're now ready to tag the questions.

**Tagging Countermeasure Questions**
The **Select Questions dialog box** displays the list of questions for the first chart included in the scoring process:

---

18 The process by which questions are identified as a particular type, such as relevant, or comparison/control.
The question type tags are displayed in the Type column and correspond to the first letter of the question type (e.g., O = Other, C = Comparison/Control, and R = Relevant). Note that questions of type Other display as a blank in the Type column.

**Note:** Countermeasure detection accuracy depends on the correct tagging of questions.

**Changing a tag**
To assign a different tag to a question in the current list:

1. Highlight the question using the mouse or the <up arrow> and <down arrow> keys.

2. In the Question Type group box, select the appropriate option button or type the first character of the tag, such as r for Relevant. The new tag is displayed in the Type column.

3. Repeat steps 1 and 2 for each question tag you want to change.

4. Review the questions for the other charts in the scoring process. See "Viewing other questions," next, to learn how.

**Viewing other questions**
To display the questions used while recording one of the other selected charts:

1. Press the ↑ or ↓ arrows in the Chart Control group box, or use the <page up> and <page down> keys until the desired exam and chart number is displayed:
2. Revise the question type tags as appropriate.

3. Repeat this process for each chart selected for scoring.

4. After reviewing the questions and tags for all the charts in the scoring process, select OK. The Countermeasure report then appears.

What should I do next?
You're now ready to review the Countermeasure report from the scoring process.

Review the Countermeasure Report

The Countermeasure report includes the following information:

1. Overall summary of whether countermeasures were detected
2. An indication per chart of whether countermeasures were detected on that chart
3. PF name and charts evaluated
4. Chart scores showing one bar graph per chart indicating the likelihood that countermeasures were employed
5. A scoring key indicating how to interpret the results.
   - CMI = Countermeasures Indicated
   - INC = Inconclusive
   - NCMI = No Countermeasures Indicated
Using the Sensor Controls

The sensor controls are the large arrows that appear to the right of the Chart Display window. Each sensor control points to and controls the chart trace:

![Sensor Control Example]

The two characters at the left of the sensor control identify the sensor.

The gain value appears in the center of the sensor control. To adjust the gain:

- Use the up and down arrows at the right of the sensor control to adjust the gain. Click on the up arrow to increase the gain value and the bottom arrow to decrease the gain value. 
  Or...
- Use the mouse to place the cursor within the gain value field. Use the keyboard to enter the desired gain value, either by editing the numbered value or using the keyboard arrow keys to increase or decrease the value.
**Note:** When you increase the gain, the magnitude (height) of a chart trace increases. Likewise, when you decrease the gain, the magnitude of a chart trace decreases.

You can also use the sensor controls to:

- Reposition chart traces by dragging the sensor control to a new position.
- Open the Trace Preferences by double-clicking the sensor control.

**Tip:** All trace properties, including the startup gain and current gain for a sensor, can be set through the Trace Preferences.

### Centering a Chart Trace

If a chart trace exceeds its corresponding region, you can center it by clicking on its corresponding sensor control arrow.

To center all traces simultaneously, select the Center button in the chart recording window, or select the Center toolbar button from the Chart toolbar. Alternatively, you may right-click on the question text in the chart recording window and select Center Traces.

For additional information on toolbars, see the topic Customize Toolbar.

### Reviewing a Chart

To help you evaluate a subject's chart, you can review previously recorded charts at any time. To choose a chart to review:

1. Select Open PF (Ctrl + O) from the File menu.
2. From the list of PFs, select the PF name for the chart you want to review.
3. Select Chart 1 Exam 1 from the Chart menu (Chart 1 Exam 1 represents the correct chart number for a specific exam).

**Tip:** All charts for the currently open PF may be opened simultaneously by using the Open All Charts menu item under the Chart main menu.

As you select a chart for review, the chart is displayed. An associated examiner score sheet (if applicable) can be displayed.

You can toggle between the examiner score sheet and the Chart Review window.

- To bring the Chart Review window to the front, click on it with the mouse.
- To bring the score sheet to the front, press (Ctrl+A).

An alternative method of displaying the examiner score sheet is by right-clicking on the sensor trace portion of the Chart Review window. A floating popup menu is displayed.
from which the **Examiner Score** menu item may be selected to display the associated score sheet.

**Tip:** Click on a chart item to see a brief description at the bottom of the window.

---

**Chart Playback**

Previously recorded charts can be replayed using the VCR-style controls at the bottom right of the chart review window. Pressing the "Play" button starts the playback operation. During playback, the chart will scroll from the right edge of the window similar to when the chart was originally recorded. The chart will stop scrolling at the end of the playback. Press the "Stop" button to return the chart to the normal view.

While the playback is progressing, the "Fast Forward" button can be used to accelerate the rate of playback. When the "Fast Forward" button is pressed, the chart playback rate is doubled. Subsequent presses of the "Fast Forward" button cycle the playback rate between 1x, 2x, 4x, and 8x. To resume chart playback, press the "Play" button.

The "Home" button can be pressed during playback to restart the chart at the beginning. Pressing the "Pause" button toggles the video between pause and play mode.

If a chart has an associated audio/video clip, this clip will be replayed synchronized with the chart when the replay controls are selected.
Using the Chart Review functions

The Chart Review window is similar to the Chart Display window, but the Chart Review functions let you pick what part of the chart you see. For example:

### Function Description

**Zoom**  The **Zoom** controls let you choose how much of the chart to display in the Chart Review window, providing the ability to significantly magnify the detail with which a chart is displayed. This capability is available from the Zoom toolbar or by right clicking the chart display and selecting the desired zoom control from the popup menu. The following describes the options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Zoom Level</td>
<td>Displays sensor traces for approximately 70 seconds worth of data.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Provides four zoom out levels, including 50%, 33%, 25%, and All.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Provides four zoom in levels, including 150%, 225%, 300%, and 375%.</td>
</tr>
</tbody>
</table>

**Notes Present**  The **Notes Present** bitmap button lets you open the PF Notes to review or record chart review notes.

**Video Present**  The **Video Present** bitmap button lets you open an existing video associated with the current chart.

**Comment Present**  The **Comment Present** bitmap button lets you open an individual chart comment for review.

Use the scroll bar to view the portions of the chart that exceed the window area. From the Question Ordering grid at the bottom of the window, you can select a specific question. Use the left and right arrows to display question IDs that exceed the display area.

**Tip:**  To scroll through a chart, click anywhere on the chart and drag the mouse to the desired portion of the chart.

### Adjusting the gain

When reviewing the chart, remember that the gain of each chart trace can be manually adjusted temporarily. The gain adjustments you make are active only while the PF is open. As soon as the PF is closed, the gain values are restored to their original startup values, as defined within the Trace Preferences. To adjust the gain:

1. Display the portion of the chart containing the chart trace you want to adjust.
2. Click on the **sensor control** for the appropriate trace.
3. Click the up and down arrows in the sensor control to increase and decrease the gain.

Alternatively, the gain may be adjusted by opening the Trace Preferences by double-clicking the sensor control.
**Adjusting the Trace Preferences**

The Trace Preferences for a chart can be modified while the chart is open during chart review. To modify a chart review sensor trace, double-click on the chart review sensor control for the appropriate trace. This will display the Trace Preferences property page. Remember, any changes made in this fashion affect only the chart whose sensor control was double-clicked, and the change only applies as long as the chart is open.

An alternative method of displaying the Trace Preferences is by right-clicking on the sensor trace portion of the Chart Review window. A floating popup menu is displayed from which Trace Preferences may be selected.

**Reviewing the corresponding questions**

You can display the list of questions asked during a chart recording. To display the questions for a particular chart:

1. Select **Open PF** (Ctrl + O) from the **File** menu.

2. From the list of PFs, select the PF name for the chart you want to review.

3. Select desired question set name from the Chart Question Sets menu. The questions appear in the Question Editor dialog box.

**Measuring subject reactions using on-screen calipers**

You can measure the magnitude and duration of a subject reaction during chart review using a set of on-screen calipers. To display the Chart Review calipers:

1. Right-click on the sensor trace portion of the Chart Review window. A floating popup menu is displayed.

2. Select **Show Calipers** from the floating popup menu. A set of horizontal and vertical bars is displayed that may be used to perform on-screen measurements. Also displayed is a [Caliper Statistics](#) window showing statistics about the area selected by the calipers.

3. Click on any portion of the caliper to move it. As the caliper is moved, the measurements are updated both in the status pane at the bottom of the main window and in the Caliper Statistics window. In the status pane, reaction magnitudes are displayed in grid divisions, while reaction durations are displayed in seconds.

4. By selecting the area between the horizontal calipers, the vertical calipers, or the intersection of the horizontal and vertical calipers, the calipers can be moved as a single unit. This is useful when a fixed area is defined for the calipers, and they can then be dragged question-to-question to make measurements without the need to resize the calipers at each question.

**Note:** The vertical calipers may be locked via the caliper preferences to prevent resizing, so that moving one caliper causes the other caliper to move an identical amount. While reviewing a chart, it is possible to override the caliper lock if needed. To override, grab the caliper handle at the caliper endpoint and slide the caliper to the desired location. This allows the calipers to be moved individually despite the locked setting.

See [Setting Caliper Preferences](#) for more information.
Tip: The horizontal calipers can be moved a pixel at a time. To move the upper horizontal caliper, select <Shift + Up Arrow> or <Shift + Down Arrow>. To move the lower horizontal caliper, select <Ctrl + Up Arrow> or <Shift + Down Arrow>. To move the left vertical caliper, select <Shift + Left Arrow> or <Shift + Right Arrow>. To move the right vertical caliper, select <Ctrl + Left Arrow> or <Ctrl + Right Arrow>.

Entering chart comments
If you are the original examiner, you can enter a comment directly on the chart during chart review. To enter a chart comment:

1. Right-click on the sensor trace portion of the Chart Review window at the location where you want the comment to be displayed. A floating popup menu is displayed. Or, you may also enter a chart comment by double-clicking on the chart.

2. Select Enter Comment from the floating popup menu. A small window will be displayed in which a comment may be entered. This window may be resized or moved as necessary. However, when it is closed, it will revert back to iconic form at the location where it was originally entered.

3. To close the comment, click on the close box at the top right of the comment window.

4. To display the location of all chart comments in bitmap form, select Show Comments from the floating popup menu.

Showing centering indications
Centering indications made during the examination can be temporarily disabled during chart review. To hide centering indications on a specific chart:

1. Right-click on the sensor trace portion of the Chart Review window. A floating popup menu is displayed.

2. By default, centering indications are enabled. Select Show Centering from the floating popup menu. Centering indications will be disabled and the chart will be redrawn without centering.

3. To re-enable centering, select Show Centering again from the floating popup menu.

Note that a change to the centering indication display mode only applies until the chart is closed. Centering indications are always enabled when a chart is opened.

What should I do next?
You're now ready to either:

score a chart
create a report showing the results.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensors</td>
<td>Sensors are the detection devices that are <strong>attached to the subject</strong> and <strong>connected to the DAS</strong> for input to the Lafayette Polygraph System workstation. You’ll work with the following sensors:</td>
</tr>
<tr>
<td></td>
<td><strong>LX5000</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>P1</strong> (Abdominal Respiration)</td>
</tr>
<tr>
<td></td>
<td>• <strong>P2</strong> (Thoracic Respiration)</td>
</tr>
<tr>
<td></td>
<td>• <strong>GSR</strong> (GSR electrodermal)</td>
</tr>
<tr>
<td></td>
<td>• <strong>GSR Detrended</strong> (GSR electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>• <strong>GSC</strong> (GSC electrodermal)</td>
</tr>
<tr>
<td></td>
<td>• <strong>GSC Detrended</strong> (GSC electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>• <strong>PLE</strong> (Plethysmograph)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cardio</strong> (Cardiovascular)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Feet</strong> (Feet movement)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Seat</strong> (Seat movement)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Arms</strong> (Arm movement)</td>
</tr>
<tr>
<td></td>
<td><strong>LX4000</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>P1</strong> (Abdominal Respiration)</td>
</tr>
<tr>
<td></td>
<td>• <strong>P2</strong> (Thoracic Respiration)</td>
</tr>
<tr>
<td></td>
<td>• <strong>EDA</strong> (GSR electrodermal)</td>
</tr>
<tr>
<td></td>
<td>• <strong>EDA Detrended</strong> (GSR electrodermal with the &quot;detrending&quot; filter applied)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cardio</strong> (Cardiovascular)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Aux 1</strong> (Auxiliary 1, typically Movement)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Aux 2</strong> (Auxiliary 2, typically Countermeasure)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Aux 3</strong> (Auxiliary 3)</td>
</tr>
<tr>
<td>Question to read</td>
<td>Lists the question to read in the following format:</td>
</tr>
<tr>
<td></td>
<td><em>question ID (expected response) question</em></td>
</tr>
<tr>
<td></td>
<td>1 (No) Regarding that piece of paper under your leg, did you write the number 1?</td>
</tr>
<tr>
<td></td>
<td>To change the font of the question text, right-click on the question text to display the Chart Preferences page.</td>
</tr>
<tr>
<td>Chart review question grid</td>
<td>The Chart Review question grid shows the questions that were asked during chart recording in the exact order in which the questions were asked. To move to a different question, just select it by clicking it with the mouse or using the left and right arrow keys. As a different question ID is selected, the chart is scrolled horizontally to center the question’s corresponding tracings on the chart review screen.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> To enable or disable question ID color coding, modify the &quot;Color code question IDs&quot; setting in Examination Preferences.</td>
</tr>
<tr>
<td>Home button</td>
<td>Select this button to return to the start of chart.</td>
</tr>
<tr>
<td>Fast Forward button</td>
<td>Select this button to toggle between 1x, 2x, 4x, and 8x chart playback speeds.</td>
</tr>
<tr>
<td>Pause button</td>
<td>Select this button to pause a playing chart.</td>
</tr>
<tr>
<td>Stop button</td>
<td>Select this button to stop a playing chart and return to the start of chart.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Play button</td>
<td>Select this button to initiate playback of a chart.</td>
</tr>
<tr>
<td>Question ID</td>
<td>The ID for the question. Click on this field to select the question.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The question ID is the number that appears in the question ordering grid.</td>
</tr>
<tr>
<td>Chart Comment</td>
<td>An on-screen comment made by the original examiner. This allows the examiner to make a directed comment about a specific area on the chart. A comment may be entered by selecting Enter Comment from the floating chart review popup menu. The chart review popup menu may be accessed by right-clicking on the chart. Note that the location where the right-click occurred will be the location where the chart comment will be located. Once entered, the chart comment may not be moved to another location on the chart. To view the text of the comment, double-click on the comment bitmap present on the chart. Chart comment bitmaps can be displayed or hidden via the Show Comments menu item in the chart review popup menu. <strong>Note:</strong> Chart comments can only be entered and modified by the original examiner. If the Enter Comment chart review popup menu entry is dimmed, it is because the current user is not the original examiner.</td>
</tr>
<tr>
<td>Gray bar</td>
<td>Marks the time it took to read the question.</td>
</tr>
<tr>
<td>Cardio</td>
<td>Cardio is the Cardiovascular sensor. The default abbreviation (the two characters that appear on the sensor control) is CA. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Cardio property page of the Preferences dialog.</td>
</tr>
<tr>
<td>EDA</td>
<td>EDA is the Electrodermal sensor. For historical reasons, the default abbreviation (the two characters that appear on the sensor control) is GS (Galvanic Skin Conductance). You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Electrodermal property page of the Preferences dialog.</td>
</tr>
<tr>
<td>P1</td>
<td>P1 is the default abbreviation assigned to the Pneumatic 1 sensor control. The P1 sensor produces the Abdominal Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Abdominal Respiration property page of the Preferences dialog.</td>
</tr>
<tr>
<td>P2</td>
<td>P2 is the default abbreviation assigned to the Pneumatic 2 sensor control. The P2 sensor produces the Thoracic Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Thoracic Respiration property page of the Preferences dialog.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>This box lists the date of the test, the time the test was started, and the duration of the test.</td>
</tr>
<tr>
<td>CP mmHg</td>
<td>This box lists the cuff pressure readings at the start of chart (X) and end of chart (XX) announcements. If no start of chart announcement was made, the cuff pressure listed is from the beginning of chart. If no end of chart announcement was made, the cuff pressure listed is from the end of chart.</td>
</tr>
<tr>
<td>EDA Ohms</td>
<td>Displays the minimum, maximum, and average Electrodermal (EDA) measured in the...</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notes present</td>
<td>The Notes Present bitmap button lets you open the PF Notes to review or record notes about a chart.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Notes Present bitmap will not appear on the Chart Review window if no notes were recorded. To open the PF Notes, choose <strong>PF Notes</strong> from the <strong>Exam</strong> menu.</td>
</tr>
<tr>
<td>Comments present</td>
<td>The Comment Present bitmap button lets you open individual chart comments. The count of the number of chart comments present in a chart is displayed beside the Comment Present button. Each selection of the Comment Present button will open a different on-screen chart comment. If all chart comments are open, selection of the Comment Present button will cycle through each Chart Comment window, centering them in the Chart Review window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Comment Present bitmap will not appear on the Chart Review window if no comments were recorded by the original examiner.</td>
</tr>
<tr>
<td>Video present</td>
<td>The Video Present bitmap button lets you know that an audio/video clip is associated with this chart. Selection of the Video Present button will begin replay of the chart and the associated audio/video clip.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Video Present bitmap will not appear on the Chart Review window if no audio/video clips were recorded when this chart was collected.</td>
</tr>
<tr>
<td>Chart playback timer</td>
<td>Indicates the current offset of a replaying chart in seconds from the start of chart.</td>
</tr>
<tr>
<td>Gain Sensor ID</td>
<td>Identifies the sensor.</td>
</tr>
<tr>
<td>Gain Start Value</td>
<td>Lists the gain value when the test started.</td>
</tr>
<tr>
<td>Gain End Value</td>
<td>Lists the gain value when the test ended.</td>
</tr>
</tbody>
</table>

**Caliper Statistics**

Caliper statistics indicate the dimensions of the chart area selected by the calipers which are shown as the pink pairs of horizontal and vertical lines in the graphic below. The calipers can be used to measure minimum, maximum, and average EDA (Electrodermal) Ohms, heart rate, respiration rate, cuff pressure (CP), and cardio baseline characteristics. Respiration line lengths are also automatically measured.

**Tip:** Click on a statistic to see a brief description below.
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Dimensions of the chart area selected by the vertical and horizontal calipers. Width is measured in seconds. Height is measured in grid divisions.</td>
</tr>
</tbody>
</table>
| Line Length (Pixels) | Length of each trace measured in pixels between the vertical calipers. The length of each trace may also be measured in millimeters instead of pixels. This setting can be changed through the Caliper Preferences. **Note:** Your screen must be calibrated via the Screen Calibration Preferences (under the Tools menu) before waveforms can be measured in millimeters.
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDA (Ohms)</td>
<td>Displays the minimum, maximum, and average Electrodermal (EDA) measured in Ohms.</td>
</tr>
<tr>
<td>CP (mmHG)</td>
<td>Displays the minimum, maximum, and average cuff pressure measured in millimeters of mercury.</td>
</tr>
<tr>
<td>Heart Rate (bpm)</td>
<td>Displays the minimum, maximum, and average heart rate measured in beats per minute.</td>
</tr>
<tr>
<td>Resp. Rate (cpm)</td>
<td>Displays the minimum, maximum, and average respiration rate measured in cycles per minute.</td>
</tr>
</tbody>
</table>

**Cardio Baseline Characteristics**

These values relate to upward facing trends on the cardio waveform. Calipers must be placed at the start of an upward trend and at the end of an upward trend to get accurate data. The left caliper should be placed on or just to the left of the **lowest** point on the cardio waveform where the measurement is to begin. The right caliper should be moved to a point representing the extent of the time period to be measured.

Once the calipers have been properly placed, **the area under the curve** is the number of blocks (e.g., divisions on the screen) under the curve. This measurement is useful for comparing the relative size of one curve to another curve.

The **time to return** is the amount of time it took the waveform to return to the original vertical offset (e.g., the waveform must return to the exact same vertical pixel as the cardio pixel under the left caliper).

The **rate of arousal** is how many vertical blocks per second the waveform rises before it reaches its maximum value and starts dropping again.

By selecting the area between the horizontal calipers, the vertical calipers, or the intersection of the horizontal and vertical calipers, the calipers can be moved as a single unit. This is useful when a fixed area is defined for the calipers, and they can then be dragged question-to-question to make measurements without the need to resize the calipers at each question. The graphics below indicate the various ways in which the calipers can be moved as a unit by selecting an intersecting region.
Printing a Chart

Your Lafayette Polygraph System workstation may be connected to a local printer or may be on a network. The appropriate software printer driver operates the printer, and
the spooler program enables you to print documents in the background while you continue with other work. If a printer is not currently available when you select the Print command, the spooler stores the documents in a queue until a printer becomes available. You can print examination information, comments recorded in the PF Notes, charts, or reports.

**Printing the entire screen display**
To print the entire screen display exactly as it appears on the workstation monitor, select *Print Screen* from the *File* menu. This command sends everything you see on the screen to the printer; however, information extending beyond the window borders is not printed.

**Printing the active window**
To print the contents of the active window, select *Print* (Ctrl + P) from the *File* menu. All the information in the window, including information not in view, is sent to the printer.

**Printing a chart**
To print a chart:

1. Select *Open PF...* (Ctrl + O) from the *File* menu.
2. From the list of PFs, select the number corresponding to the PF you want to print.
3. Select *Print Charts* from the *File* menu. The *Print Charts* dialog box appears.

4. Double-click on the name of the chart you want to print. A checkmark appears beside the chart. You may select more than one.
5. Select Print to print the charts; select Cancel to disregard the Print Charts command.

Creating a Report

To produce a final report recording the results of a polygraph chart:


Note: If a report already exists for the current PF, a message box warns you. You have the option to cancel the command. If you continue, the old report will be renamed automatically. You can open an existing report using the Open Report command.

2. Select an evaluation option from the Final Call drop-down box. This evaluation is recorded in the Exam Info dialog box for you when you select a choice in the Final Report dialog box.

3. Select the template file to use for generating the final report from the Final Report Template box. Use the browse button to find the file if necessary. This option allows selecting from one of multiple Final Report templates depending on the type of examination. For example, an examiner could create a Final Report template for pre-employment exams, one for a specific type of crime, and one specific to sex offenders.

4. Select OK to save the changes and generate a report. The LXSoftware window moves to the background, the word processing application window opens, and a Final Report appears.

The LXSoftware extracts relevant information from the examination and puts it into the template. You must type the remaining information in the template.

Note: If you are not familiar with the word processor, refer to its user's guide.
Including PF notes in a report

If you used the PF Notes during the exam, the PF Notes window opens when the template appears. The comments you made in the PF Notes appear in a separate document window. You can add the PF Notes to the final report using standard copy, cut, and paste techniques.

*Note:* This function is not available if you're using *Microsoft WordPad.*

Exiting the word processor

When you are finished with the final examination report:

1. Select **Save** from the **File** menu to save the report to disk.

2. Double-click the **Control-menu box** in the top-left corner <Ctrl + F4> to close the word processor's application window.

3. Click the **Lafayette Polygraph System** icon at the bottom of the screen to return to the polygraph application.

*Tip:* You can press <Alt + Tab> to toggle between the two applications.

Customizing the Final Report

The Final Report may be customized to meet the needs of the examiner. For details, see Custom Final Report with extended field support under the **Exam Preferences** topic.

What should I do next?

You're now ready to print the report.

Opening a Report

If a report has already been created for a particular PF, you may open and revise it as necessary. This allows you to open the report and any other ancillary files within LXSoftware that are external to LXSoftware but that you may want to incorporate into the Final Report. To open an existing report:

1. **Open the PF**.

2. Select **Open Report** (Ctrl + R) from the **File** menu. The Open Report window opens. This window lists the report and any notes for the current PF that will be opened.
1. Select the **Add**... button to open any other files or external files that you want to incorporate into the Final Report. The **Open** window appears. Use this window to browse for the desired file(s).

2. Select the **Delete** button to delete any unwanted files from the list of files to open.

3. Click the **OK** button to open the files listed in the **Files to open**: box. The LXSoftware window moves to the background, the word processor opens, and the report for the current PF appears. If any notes were entered in the PF Notes during the examination, the PF Notes file will also be automatically opened if supported by the word processor selected in the **Examination Preferences**.

4. Click the **Cancel** button to return to the main LXSoftware window.

**Printing a Report**

To print a report, follow your word processor's printing instructions.

**Generation of a Custom Final Report Template for Corel WordPerfect**

Custom Final Report Template generation under WordPerfect requires creating Bookmarks in the Final Report template document. The LXSoftware will replace the Bookmarks with the desired text from the examination. To customize the Final Report template, perform the following steps:

1. Open the file AutoRpt.wpd located in the Rptinfo directory where the LXSoftware was installed.

2. Move the cursor to the location in the document where you want exported information to be inserted by the LXSoftware.

3. Enter the **export field name**. The export field name is used by the LXSoftware to associate a Bookmark with a data item during Final Report generation.

4. Select the export field name so that it is highlighted.

5. Under the **Tools** menu select **Bookmark**... **A Bookmark** dialog is displayed.

6. Select the **Create**... button. A **Create Bookmark** dialog is displayed.

7. The highlighted **export field name** should appear in the **Bookmark name**: field. Select the **OK** button to create the Bookmark.

8. Repeat Steps 2 through 7 for every desired export field. Note that an export field name, such as SSN, can appear multiple times in the Final Report. However, since no two Bookmarks can have the same name, all export fields after the first **having the same name**
must have a number appended. For example, SSN and SSN1 would both export the Social Security Number to the Final Report.

9. Save and close the AutoRpt.wpd file when finished adding export fields.

New Final Reports will now display the information defined by the export fields in the Final Report template.

For technical reasons, the tenth custom question field information from the Exam Information can only appear once in a WordPerfect Final Report. These fields have the export field names Question10, Response10, and CustomReply10.

**Important Note:** Once a customized Final Report template has been created, it should be backed up so that it is not overwritten when the LXSoftware is reinstalled or updated.

### Generation of a Custom Final Report Template for Microsoft Word

Custom Final Report Template generation under Microsoft Word requires creating Mail Merge Fields in the Final Report template document. The LXSoftware will replace the Mail Merge Fields with the desired text from the examination. To customize the Final Report template, perform the following steps:

1. Open the file AutoRpt.doc located in the Rptinfo directory where the LXSoftware was installed.
2. Click the location in the document where you want exported information to be inserted by the LXSoftware.
3. (Office 2003 or older) Under the **Insert** menu select **Field**. A **Field** dialog is displayed.
4. (Office 2007 only) Under the **Insert** menu select the **Quick Parts** item. Select **Field** from the menu.
5. From the **Categories:** list, select **Mail Merge**.
6. From the **Field names:** list, select **Merge Field**.
7. Move the cursor to the end of the **Field Name** edit field and enter the export field name. The export field name is used by the LXSoftware to associate a Mail Merge Field with a data item during Final Report generation. For example, the field name **Age** would be used to export the subject's age at the time of the exam into the designated location in the report.
8. Repeat Steps 2 through 6 for every desired export field. An export field name can appear multiple times in the Final Report.
9. Save and close the AutoRpt.doc file when finished adding export fields.

New Final Reports will now display the information defined by the export fields in the Final Report template.

**Important Note:** Once a customized Final Report template has been created, it should be backed up so that it is not overwritten when the LXSoftware is reinstalled or updated.

### Export Field Names

The following is a list of export field names for use in **Custom Final Reports with extended field support**.

**Personal History Export Field Names**
To export the Final Report creation date and time, use the field names "Date" and "Time" respectively. In Spanish, use "Fecha" and "Hora" respectively.

Any export field name that appears in the Final Report will be deleted if the corresponding data element does not exist in the examination. For example, if an export field name for the subject's birth country appears in the Final Report, but this information was not entered during the examination, then the export field name will be deleted from the generated Final Report.

**Chart Question Set Export Field Names**

Individual question components from a chart question list can be exported to the Final Report. The three components that may be exported are question ID, expected response, and text. Each component has a separate export field name that must be combined with an exam number, chart number, and question number in order to export the desired question component. The question number indicates the order in which the question was asked during the chart, not its order in the question set.

The three export field names have the following format, where x, y, and z represent the exam number, chart number, and question number respectively:

- **QuestionSetIDExCyQz** -- Extract chart question ID for exam x, chart y, question z
- **QuestionSetERExCyQz** -- Extract chart question expected response for exam x, chart y, question z
- **QuestionSetTextExCyQz** -- Extract chart question text for exam x, chart y, question z

For example, to extract the question text for exam 1, chart 2, question 3 would require an export field name as indicated below:

QuestionSetTextE1C2Q3

To extract the question ID for exam 2, chart 4, question 10 would require an export field name as indicated below:

QuestionSetIDE2C4Q10

If an export field name exists in the Final Report template, but was not entered during the examination, the export field name will be simply deleted during Final Report generation. For example, if the export field name

QuestionSetTextE1C3Q2
Chart Question Set Export Field Names (Spanish)

Individual question components from a chart question list can be exported to the Final Report. The three components that may be exported are question ID, expected response, and text. Each component has a separate export field name that must be combined with an exam number, chart number, and question number in order to export the desired question component. The question number indicates the order in which the question was asked during the chart, not its order in the question set.

The three export field names have the following format, where x, y, and z represent the exam number, chart number, and question number respectively:

SetDePreguntasIDExGyPz -- Extract chart question ID for exam x, chart y, question z
SetDePreguntasREExGyPz -- Extract chart question expected response for exam x, chart y, question z
TextoDeSetDePreguntasExGyPz -- Extract chart question text for exam x, chart y, question z

For example, to extract the question text for exam 1, chart 2, question 3 would require an export field name as indicated below:

TextoDeSetDePreguntasE1G2P3

To extract the question ID for exam 2, chart 4, question 10 would require an export field name as indicated below:

SetDePreguntasIDE2G4P10

If an export field name exists in the Final Report template, but was not entered during the examination, the export field name will be simply deleted during Final Report generation. For example, if the export field name

TextoDeSetDePreguntasE1G3P2

is entered, but the examination has only 2 charts, the field name will be deleted during Final Report generation.

Exam Information Export Field Names

Examiner
StartDate
StopDate
StartTime
StopTime
FinalCall
Requester
Location
ExamNumber
RoomRecorded
RoomMonitored
SleepReply
SleepNormal
SleepLast24
BreakfastReply
LunchReply
DinnerReply
PregnantReply
Exam Information Export Field Names (Spanish)

Examinador
FechaInicio
FechaFinalización
HoraInicio
HoraFinalización
LlamadaFinal
Solicitante
Localización
NúmeroExamen
GrabaciónSala
MonitoreoSala
RespuestaSueño
SueñoNormal
SueñoUltimas24
RespuestaDesayuno
RespuestaAlmuerzo
RespuestaCena
RespuestaEmbarazada
RespuestaPoligPrevio
CuándoPoligPrev
PorQuienPoligPrev
PorquéPoligPrev
ResultadoPoligPrev
ArrestrosAnterRespuesta
ArrestrosAnterCuándo
ArrestrosAnterLugar
ArrestrosAnterDelito
ArrestrosAnterDisposición
DrogasIlegalesRespuesta
DrogasIlegalesCuándo
DrogasIlegalesClase
DrogasIlegalesCantidad
MedicamentosRespuesta
MedicamentosCuándo
MedicamentosClase
### Personal History Export Field Names

- PFNumber
- Name
- Aliases
- SSN
- CaseNumber
- DriversLicenseNumber
- DriversLicenseState
- DriversLicenseCountry
- DriversLicenseExpiration
- Description
- AddressStreet
- AddressApt
- AddressCity
- AddressState
- AddressCountry
- PostalCode
- HomePhone
- BusinessPhone
- DateOfBirth
- Age
- Sex
- BirthplaceCity
- BirthplaceState
- BirthplaceCountry
- MaritalStatus
- Education
- Race
- MilitaryHistoryFrom
- MilitaryHistoryTo
- MilitaryBranch
- MilitaryRank
- MilitaryDischarge
- MilitaryOther
- EmploymentDate1
- EmploymentEmployer1
- EmploymentPosition1
- EmploymentOther1
- EmploymentDate2
- EmploymentEmployer2
- EmploymentPosition2
- EmploymentOther2
- EmploymentDate3
- EmploymentEmployer3
- EmploymentPosition3
- EmploymentOther3
- EmploymentDate4
- EmploymentEmployer4
- EmploymentPosition4
- EmploymentOther4
- MotherName
- MotherAge
- MotherOccupation
- MotherLocation
- FatherName
FatherAge
FatherOccupation
FatherLocation
SpouseName
SpouseAge
SpouseOccupation
SpouseLocation
Relative1
Relative2
Relative3
Relative4
Relative5
RelativeName1
RelativeName2
RelativeName3
RelativeName4
RelativeName5
RelativeAge1
RelativeAge2
RelativeAge3
RelativeAge4
RelativeAge5
RelativeOccupation1
RelativeOccupation2
RelativeOccupation3
RelativeOccupation4
RelativeOccupation5
RelativeLocation1
RelativeLocation2
RelativeLocation3
RelativeLocation4
RelativeLocation5
PersonalHistoryComments
Photo
Fingerprint
Signature

**Personal History Export Field Names (Spanish)**

Nombre
NúmeroAP
Aliases
NSS
CasoNúmero
LicenciaConductorNúmero
EstadoLicenciaConductor
PaísLicenciaConductor
ExpiraciónLicenciaConductor
Descripción
DirecciónCalle
DirecciónApto
DirecciónCiudad
DirecciónEstado
DirecciónPaís
CódigoPostal
Individual question components from a PF Question Set can be exported to the Final Report. The three components that may be exported are question ID, expected response, and text. Each component has a separate export field name that must be combined with a PF Question Set number, question list number (for the LXQuestionEditor), and question number in order to export the desired question component.

The question number indicates the order in which the question was originally added to the question set when the question set was created.

The question list number is the ordinal list value in the LXQuestionEditor where the topmost list is 1.

The PF Question Set number is an ordinal value used to represent an arbitrary PF Question Set (first, second, etc.). During report generation, the user is prompted to associate a PF Question Set with the PF Question Set number that appears in the Final Report. In the dialog below, the user is being prompted to select the PF Question Set to use when exporting information for the PF Question Set identified by the ordinal 2 in the Final Report template.
When using the **LXQuestionEditor**, the three export field names have the following format, where x and y and z represent the PF Question Set number, the Question List number, and Question Number respectively:

- \texttt{PFQuestionSetxLyIDQz} -- Extract Question ID for PF Question Set x, List y, Question z
- \texttt{PFQuestionSetxLyERQz} -- Extract question Expected Response for PF Question Set x, List y, Question z
- \texttt{PFQuestionSetxLyTextQz} -- Extract question Text for PF Question Set x, List y, Question z

**Note:** For example, to extract the question Text for PF Question Set 1, List 1, Question 3 would require an export field name as indicated below: \texttt{PFQuestionSet1L1TextQ3}

When using the **Legacy Question Editor**, the three export field names have the following format, where x and y represent the PF Question Set number and Question number respectively:

- \texttt{PFQuestionSetxIDQy} -- Extract question ID for PF Question Set x, Question y
- \texttt{PFQuestionSetxERQy} -- Extract question Expected Response for PF Question Set x, Question y
- \texttt{PFQuestionSetxTextQy} -- Extract question Text for PF Question Set x, Question y

**Note:** For example, to extract the question Text for PF Question Set 1, Question 3 would require an export field name as indicated below: \texttt{PFQuestionSet1TextQ3}

To extract the question ID for PF Question Set 2, Question 10 would require an export field name as indicated below: \texttt{PFQuestionSet2IDQ10}

If an export field name exists in the Final Report template, but was not entered during the examination, the export field name will be simply deleted during Final Report generation. For example if the export field name,
PF Question Set Export Field Names (Spanish)

Individual question components from a PF Question Set can be exported to the Final Report. The three components that may be exported are question ID, expected response, and text. Each component has a separate export field name that must be combined with a PF Question Set number, question list number (for the LXQuestionEditor), and question number in order to export the desired question component.

The question number indicates the order in which the question was originally added to the question set when the question set was created.

The question list number is the ordinal list value in the LXQuestionEditor where the topmost list is 1.

The PF Question Set number is an ordinal value used to represent an arbitrary PF Question Set (first, second, etc.). During report generation, the user is prompted to associate a PF Question Set with the PF Question Set number that appears in the Final Report. In the dialog below, the user is being prompted to select the PF Question Set to use when exporting information for the PF Question Set identified by the ordinal 2 in the Final Report template.

When using the LXQuestionEditor, the three export field names have the following format, where x and y and z represent the PF Question Set number, the question list number, and question number respectively:

SetDePreguntasDeAPxLyIDPz -- Extract question ID for PF Question Set x, List y, Question z
SetDePreguntasDeAPxLyREPz -- Extract question Expected Response for PF Question Set x, List y, Question z
SetDePreguntasDeAPxLyTextoPz -- Extract question Text for PF Question Set x, List y, Question z
For example, to extract the question Text for PF Question Set 1, List 1, Question 3 would require an export field name as indicated below:

SetDePreguntasDeAP1L1TextoP3

When using the Legacy Question Editor, the three export field names have the following format, where x and y represent the PF Question Set number and question number respectively:

SetDePreguntasDeAPxIDPy -- Extract question ID for PF Question Set x, Question y
SetDePreguntasDeAPxREPy -- Extract question Expected Response for PF Question Set x, Question y
SetDePreguntasDeAPxTextoPy -- Extract question Text for PF Question Set x, Question y

For example, to extract the question Text for PF Question Set 1, Question 3 would require an export field name as indicated below:

SetDePreguntasDeAP1TextoP3

To extract the question ID for PF Question Set 2, Question 10 would require an export field name as indicated below:

SetDePreguntasDeAP2IDP10

If an export field name exists in the Final Report template, but was not entered during the examination, the export field name will be simply deleted during Final Report generation. For example if the export field name, SetDePreguntasDeAP3TextoP2, is entered, but the PF folder has only 2 PF Question Sets, the field name will be deleted during Final Report generation.

**Locking the Screen**

If you need to leave the room while a subject is present, lock the screen before you leave the room. Locking the screen is a way to protect data by preventing access to the display.

To lock the screen, select **Screen Lock** <Ctrl + L> from the **File** menu. A gray background replaces the current display, and the **Screen Lock** dialog box appears.

![Screen Lock dialog box](image)

This workstation has been temporarily locked out.

Please enter your password to continue.

User ID: admin Password: 

[Continue]

**Note:** To unlock the screen, type your **Password**, then select **Continue**.
Using Chart Comments

A chart comment is a word, sentence or paragraph entered by the examiner to help identify significant events that occurred during recording of a chart. Comments may be used in place of annotations to mark events such as a cough, yawn, or sneeze. Comments may also be used in addition to annotations to explain any event not covered by annotations.

The text for a chart comment may be displayed directly on the chart or hidden from view until the comment is opened. When displayed, all comment text is in a single font typeface such as Arial. However, the color, size, and style (bold, italicize and underline) attributes may be individually specified. For example, comment #1 may be displayed in red using a 20-point font that is bold and underlined and comment #2 may be displayed in green using an 8-point font without being bold, italicized or underlined. This allows each comment to have a distinct appearance and gives the operator full flexibility on how individual comments appear.

There is no limit to the number of chart comments that may be made for a chart. Comments may be entered both during recording and during review. The text, location, and attributes of the comment may be changed at any time until the PF containing the comments is closed for the first time. This allows the user to enter an abbreviated comment during recording, then during review fill in the remainder of the comment text, change its color, size and font attributes and move its location. However, once the PF is closed, the comments may not be modified. If the PF is opened again, the original examiner may add new comments but cannot change existing comments.

Entering Chart Comments During Chart Recording

The examiner may enter a comment during recording, then during review edit the comment text, change its color, size and font attributes and move its location.

There are three techniques for entering a comment during chart recording:

1. Press the <Insert> key on the keyboard at the time of the event.
2. Using the mouse, double-click on the chart at the desired location where the comment is to appear.
3. Using the mouse, right-click on the chart at the desired location where the comment is to appear and select Enter Chart Comment from the popup-menu.

Using any of the three methods causes the Enter a Comment dialog to appear. When the dialog appears, simply type in the comment text and either press the <Enter> key or click on the OK button to create the comment. Clicking the Cancel button or pressing the <Escape> key causes the comment to be discarded.

Comment Location

If the comment was created by pressing the <Insert> key, then the comment is horizontally located at the point in time when the key was pressed and vertically located at the bottom of the chart where the annotation text is located. The position in time is determined when the key is pressed, not when the comment dialog is dismissed.

If the comment was created using the mouse, then the comment is horizontally located at the point in time when the mouse button was pressed and vertically located at point where the mouse was clicked. The position in time is determined when the mouse was clicked, not when the comment dialog is dismissed.
During recording, comments may be entered anywhere on the chart data that is visible on the screen. It is not limited to the current question.

Size and Position of the "Enter Comment" Dialog
The first time the "Enter Comment" dialog is displayed, it is centered on the screen. However, the dialog’s position and size are remembered after it is dismissed. This allows the user to change the size and position on the screen and from that point on the size and position will be restored when the PF is reopened.

Chart Comments and Continuous Printing
Comments may be entered while using the "Print charts while recording" option. However, there is one caveat. If a comment is entered using the mouse at a point in the chart that has already been printed, then the comment will be printed at the bottom of the chart at the time the mouse was clicked. It will display on the real-time printout as if the user pressed the <Insert> key. However, the comment will appear on the computer screen at the position where the comment was entered. This may not be suitable to all users since the post-test printout will be different than the real-time printout.

Entering Chart Comments During Chart Review
Comments may be entered during chart review by the original examiner. This includes immediately after the chart was recorded and at a later time. Users who are not logged in as the original examiner may not add comments to a chart.

There are two methods for entering a comment during chart review:

1. Using the mouse, double-click on the chart at the desired location where the comment is to appear.
2. Using the mouse, right-click on the chart at the desired location where the comment is to appear and select Enter Chart Comment from the popup menu.

Using either method causes the "Enter a Comment" dialog to appear. When the dialog appears, simply type in the comment text and either press the <Enter> key or click on the OK button to create the comment. Clicking the Cancel button or pressing the <Escape> key causes the comment to be discarded.

Multi-line Comments
LXSoftware attempts to display a comment on the chart exactly as it appears in the "Enter a Comment" dialog. Therefore, if text wraps to a new line in the dialog then it will wrap on the chart. So, to create multi-line comments, the dialog may be resized such that the text wraps where the user wants it to wrap or the user may force text to the next line by pressing the <Ctrl> and <Enter> keys simultaneously.

Changing the Font Attributes
The font attributes, which include typeface, color, size, bold, italic and underline, may be set for the comment by pressing the Font button within the dialog. Pressing the Font button displays the Font Attributes dialog as described in the section "Font Attributes Dialog" later in this topic.

**Note:** Changing the font typeface changes it for all comments. All other attributes are specific to the comment being entered.
Spell Check Comment Text
The comment text may be spell-checked by pressing the Spell Check button in the dialog.

Hiding/Showing Chart Comments
The displaying of chart comments may be turned on or off by right-clicking on a chart and selecting Show Chart Comments from the popup menu. If the menu item is checked then comments are shown. Otherwise the comments are hidden.

Comments are attached to a specific point on the chart and are displayed at that point. This differs from annotations in that annotations are attached to a specific time, so they are displayed as a vertical line from the top of the chart to the bottom. Comments are visually displayed in one of three ways:

1. An icon is displayed along with the comment text.
2. Just the comment text is displayed.
3. Just the comment icon is displayed.

To select how comments are displayed either right-click on an existing comment and select Icon, Icon and Text or Text from the Comment Type submenu or select the type from the "Chart Comments" preference page. See the Chart Comments subsection in the Chart Preferences section for further details on changing chart comment preferences.

If the comment text is not displayed directly on the chart, then the text may be viewed by either double-clicking on the comment icon or right-clicking on the comment icon and selecting View Comment in the popup menu. This will cause a window to appear containing the comment text. However, the comment may not be edited.

During chart review, if any comments exist then a comment icon and number of comments will appear in the area to the right of the sensor arrow. The icon may be clicked on to open comments. Clicking on it the first time opens the first comment, the second time opens the second comment, etc…

Editing Chart Comments During Chart Review
Comments may be edited by the original examiner from the time the comment was created until the PF is closed. Once the PF is closed, the comments may not be edited again. Comments may never be edited by someone who is not the original examiner.

A comment consists of the following items, which all may be edited. The comment text can also be modified.

- Location
- Font Attributes
- Color
- Typeface Name
- Size
- Bold
- Underline
- Italic
Changing the Location of a Chart Comment

The comment position may only be changed from the time the comment was created until the PF is closed. To change where a comment is positioned, simply click on the comment and drag it to its desired location.

Changing the Font Attributes

The comment font attributes may only be changed from the time the comment was created until the PF is closed. There are two methods for changing the font attributes during chart review.

1. Using the mouse, double-click on the comment on the chart.
2. Using the mouse, right-click on the comment and select View Comment from the popup-menu. Then press the Font button.

Both methods will display the font attributes dialog allowing for the attributes to be changed.

Font Attributes Dialog

The "Font Attributes" dialog allows the font typeface name, color, size, bold, italic and underline attribute to be set. These settings affect how the comment text is displayed when printed, when drawn directly on a chart and when viewed in the comment dialog.

Changing the font typeface name changes it for all chart comments. However, changing any of the other settings only affects the comment being edited.

Using the PF Notes

While using the Lafayette Polygraph System to administer, record, and review charts, you can record comments about any aspect of the test or subject provided the PF is open.

To record comments in a new PF that has not been closed since it was created:

1. Select PF Notes from the Exam or Series menu. The PF Notes window appears. You may type your comments in the New Notes window. In the first line, the LXSoftware enters a context-sensitive description about the window or dialog box you were using when you selected the PF Notes.

2. When you are finished typing comments about the current PF, double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the PF Notes window.
To record comments in a PF that has been closed at least once:

1. **Open the PF**

2. Select **PF Notes** from the **Exam** or **Series** menu. The PF Notes window appears. The top section of the window displays previously recorded notes. You may not change the information in this section. Use the bottom portion of the window to type new comments. In the first line, the LXSsoftware enters a context-sensitive description about the window or dialog box you were using when you selected the PF Notes.

   2004-019 - Series 1 - Not Recording notes:
   The subject advised that he would like to enter a confession.
3. When you are finished typing comments about the current PF, double-click the Control-menu box in the top-left corner <Ctrl + F4> to close the PF Notes window.

Performing a Spell Check

Spelling can be checked on most text fields present in the Lafayette Polygraph System. To perform a spell check on entered text, select Check Spelling from the Tools menu. If a spelling error is detected, the dialog box below will be displayed indicating the word in question, along with suggested alternatives. The context in which the word was used is displayed at the bottom of the dialog box.

Spell checking is currently provided for the PF Notes, question sets, Personal History, Exam Information, and chart comments. In addition, dynamic spell checking can be performed as you type in the PF Notes. This option can be enabled via the Examination Preferences.
Drug Reference

The Lafayette Polygraph Drug Reference can be used to determine the effect of a drug on the physiologic markers most relevant for polygraph testing assessments.

To search the Drug Reference:

1. Select **Drug Reference** from the **Tools** menu. The Drug Reference dialog box appears.
2. In the Search Term field, enter any portion of the drug's trade name, generic name, medical use, or drug class.
3. Select the **Search** button to search for the entered term. The search results will be displayed.
4. To sort a column in ascending (A->Z) order, click on its column heading. Click on the column heading again to sort in descending (Z->A) order. Resize the column headings as necessary to view more or less of the column information. To resize a column heading, click on the vertical bar separating the column headings and slide it to the desired size.

**Note:** The Physiological Response Impact legend explains the meaning of terms used in the Drug Reference.

5. Select the **Print** button to print the results of the search.
6. When finished, click on the close button in the upper right-hand corner of the dialog.

**Print All**

To print all data contained within the open PF:

1. Select **Print All**… from the **File** menu. The **Print All** dialog box appears.
2. The dialog lists all polygraph documents within the open PF. To select or deselect an item for printing, click on the checkbox next to the desired item. Alternatively, all checkboxes may be simultaneously checked or unchecked by selecting the **Select All** or **Clear All** buttons.

3. Select **Print** to print the checked documents; select **Close** when finished printing or to disregard the Print command.

### Setting Abdominal Respiration Preferences

The LXSoftware lets you customize the way the system operates. To change the default Abdominal Respiration options, select **Preferences** from the **Tools** menu. The **Preferences** window appears. Select **Abdominal Respiration** from the left menu and the **Abdominal Respiration** property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Sensor ID</td>
<td><strong>P1</strong> is the <strong>default abbreviation</strong> assigned to the <strong>Pneumatic 1</strong> sensor control. The <strong>P1</strong> sensor produces the <strong>Abdominal Respiration Trace</strong>. You can change a sensor's abbreviation by typing two new characters in the <strong>Sensor ID</strong> field in the <strong>Abdominal Respiration</strong> property page of the <strong>Preferences</strong> dialog.</td>
</tr>
<tr>
<td>Enable the</td>
<td>Displays the selected sensor's trace and sensor control on the screen.</td>
</tr>
</tbody>
</table>
### Setting Administrator Preferences

The LXSoftware lets you customize the way the system operates. As such, only LXSoftware users with administrator privileges may make changes to the administrator preferences. If the current user does not have administrator privileges, then the administrator preferences menu entry will not be displayed.

To change the default administrator preferences, select Preferences from the Tools menu. The Preferences window appears. Select Administrator from the left menu and the Administrator property page appears.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sensor trace</td>
<td></td>
</tr>
<tr>
<td>Make the trace more visible (Bold)</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>Displays the color of the sensor trace. Use the drop down arrow to select another color for the trace.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> If you do not like the basic colors, you can create your own. Click here for instructions.</td>
</tr>
<tr>
<td>Startup Gain (0-10)</td>
<td>Use the arrows to increase or decrease the startup gain value.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select OK. To close the property sheet and ignore any changes, select Cancel.
The following system options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable raw DAS data saving during recording</td>
<td>Select to set all data received from the DAS to be saved in individual sensor files. These files can then be reviewed using a third-party program such as Microsoft Excel. The files are stored in individual directories within the exam folder. These directories are named ChartN.raw, where 'N' is replaced with the chart number. The sample rate for the saved data is 120 samples per second.</td>
</tr>
<tr>
<td>Enable raw chart data saving during recording</td>
<td>Select to set all chart data to be saved in individual sensor files. These files can then be reviewed using a third-party program such as Microsoft Excel. The files are stored in individual directories within the exam folder. These directories are named ChartN.dat, where 'N' is replaced with the chart number. The sample rate for the saved data is always 30 samples per second.</td>
</tr>
<tr>
<td>Enable countermeasure data saving during recording</td>
<td>Select to enable saving data required for the Countermeasure Detection algorithm. Countermeasure detection requires the Lafayette Countermeasure Detection System (Model 76876US) available from Lafayette Instrument Company.</td>
</tr>
<tr>
<td>Enable series-based examinations</td>
<td>Select this checkbox to enable series-based examinations. In series-based examinations, the term &quot;Exam&quot; is replaced with the term &quot;Series&quot; throughout the LXSoftware user interface. This terminology more closely matches the methodology currently taught by the Defense Academy for Credibility Assessment (DACA). The LXSoftware application must be</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Display gray background during logon and screen lock</td>
<td>Select to display a gray background that covers the entire screen background during logon or when the screen lock is active.</td>
</tr>
<tr>
<td>Require examiner review of all charts during computerized scoring</td>
<td>When selected, the user must review all chart question sets during the question tagging and component dropping phase of computerized scoring. If this checkbox is not selected, the user is not required to review the charts prior to scoring them.</td>
</tr>
<tr>
<td>Require system self-test at startup</td>
<td>Select to force the system to perform a self-test of the major components of the system during the initial startup sequence.</td>
</tr>
<tr>
<td>Require User ID and password to access the system</td>
<td>Select to require user to enter a valid User ID and password to access the system. A default User ID may be specified in the Administrator Preferences that will auto-fill the User ID during a logon sequence, requiring entry of the password only.</td>
</tr>
<tr>
<td>Default User ID</td>
<td>A default User ID may be specified in the Administrator Preferences that will auto-fill the User ID during a logon sequence, requiring entry of the password only.</td>
</tr>
</tbody>
</table>
| Type of DAS | Select the type of DAS in use from the drop down list.  
- The LX5000 consists of individual DAS sensors connected to the computer via USB cables or via wireless Bluetooth technology. Multiple USB sensors can be connected to the computer, or daisy-chained together if needed.  
- The LX4000 connects to the computer via a USB cable.  
- The DAS Simulator simulates a functional DAS unit with a subject attached.  
- Select None if there is no DAS unit in use and the Simulator is not desired. |
| Data Rate (LX5000 only) | The data rate specifies how many measurements are taken for each sensor per second and may only be set for the LX5000 DAS. Select the DAS data rate from the drop down list.  
- 120 - Specifies that a measurement will be taken 120 times per second.  
- 240 - Specifies that a measurement will be taken 240 times per second.  
- 360 - Specifies that a measurement will be taken 360 times per second.  
Note: Setting the data rate to a faster rate will result in larger PF file sizes and will require more computer processing power. \textit{It is recommended that a data rate of 120 be used for wireless devices.} |

Click here to configure wireless devices.  
Follow this link to enable LX5000 wireless support and to search for wireless devices.  
Limit the number of audit log records  
The audit trail lets you view a record of all Lafayette Polygraph System activities. Select the checkbox to limit the number of saved audit log records. The minimum is 5000 records. |

\textbf{Note:} To save the administrator preferences, select \textbf{OK}. To close the property sheet and ignore any changes, select \textbf{Cancel}. |
Setting Answer/Annotation Line Preferences

The LXSoftware lets you customize the way the system operates. To change the default answer/annotation line options, select Preferences from the Tools menu. The Preferences window appears. Select Answer/Annotation Line from the left menu and the Answer/Annotation Line property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Color</td>
<td>Displays the current color of the Answer/Annotation Line. Use the drop down arrow to select another color for this option. <strong>Tip:</strong> If you do not like the basic colors, you can create your own. <a href="#">Click here for instructions.</a></td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select OK. To close the property sheet and ignore any changes, select Cancel.
Setting Audio/Video Preferences

**Note**: For this feature to be enabled, a web cam, digital video camera, and/or microphone must first be attached to your system.

The LXSoftware allows you to customize audio/video settings. To enable LXSoftware audio/video capabilities and to change the default audio/video options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Audio/Video** from the left menu and the **Audio/Video** property page appears.

**Tip**: Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable LXSoftware audio/video capabilities</td>
<td>Select to enable audio/video capabilities within LXSoftware. To use this feature, a web cam, digital video camera, and/or microphone must first be attached to your system.</td>
</tr>
<tr>
<td>Capture audio and video</td>
<td>Select to store both audio and video when recording a chart.</td>
</tr>
<tr>
<td>Capture audio only and provide audio</td>
<td>Select to store audio when recording a chart, but only preview the video.</td>
</tr>
<tr>
<td>Video source: Hauppauge WinTV Capture</td>
<td></td>
</tr>
<tr>
<td>Audio source: NVIDIA nForce (TM) Audio</td>
<td></td>
</tr>
<tr>
<td>Enable Video Compression (Not recommended for older computers)</td>
<td></td>
</tr>
<tr>
<td>Code: WM/Video</td>
<td></td>
</tr>
<tr>
<td>Audio Capture Configuration (not applicable if using WM/Video codec): Advanced...</td>
<td></td>
</tr>
</tbody>
</table>

Use computer microphone instead of camera microphone (if using digital video camcorder)
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>provide live video preview</td>
<td>Select to capture audio only during an examination.</td>
</tr>
<tr>
<td>Capture audio without live video preview</td>
<td>Select to capture audio only during an examination.</td>
</tr>
<tr>
<td>Provide live video preview but do not capture audio or video</td>
<td>Select to display the audio/video window during chart recording to monitor the actions of the subject. However, audio/video data is not stored when chart recording is initiated.</td>
</tr>
<tr>
<td>Video Source</td>
<td>This drop down list shows the video recording devices detected by your system. Select the device you want to use to record video during an examination.</td>
</tr>
<tr>
<td>Audio Source</td>
<td>This drop down list shows the audio recording devices detected by your system. Select the device you want to use to record audio during an examination.</td>
</tr>
<tr>
<td>Configure</td>
<td>Enables you to configure system-specific settings for your audio/video device. Refer to your audio/video device documentation for more information.</td>
</tr>
<tr>
<td>Enable Video Compression</td>
<td>Select to enable audio/video compression. Compression reduces the file size of recorded audio/video data files. The compression process is resource intensive and is not recommended for older computers.</td>
</tr>
<tr>
<td>Codec</td>
<td>Use the Codec drop down list to select the type of compression used when compressing the audio/video data. Click here for more information.</td>
</tr>
<tr>
<td>Advanced</td>
<td>If WMVideo is selected as the codec, selecting the Advanced button will display the WMVideo configuration dialog. If any of the remaining codecs are selected, selecting the Advanced button will display the Codec Preferences dialog. Click here for more information.</td>
</tr>
<tr>
<td>Audio Capture Configuration Advanced…</td>
<td>Select the Advanced… button to enable and configure audio compression when the Capture audio and video option, Capture audio only and provide live video preview option, or Capture audio without live video preview option is selected. seitc the Advanced button will display the Codec Preferences dialog. Click here for more information.</td>
</tr>
<tr>
<td>Note:</td>
<td>If WMVideo is selected as the video codec, the audio capture configuration option is disabled. WMVideo has built-in audio and video compression.</td>
</tr>
<tr>
<td>Use computer microphone instead of camera microphone</td>
<td>If your computer has a built-in microphone, select this option to use the built-in microphone instead of your camera's microphone. (DVR only)</td>
</tr>
<tr>
<td>Resize window to fit video</td>
<td>Select to automatically resize the displayed video to fit the video window.</td>
</tr>
</tbody>
</table>

**Note:** To save the audio/video preferences, select OK. To close the property sheet and ignore any changes, select Cancel.
Configuring Audio/Video Compression

Compression reduces the file size of recorded audio/video data files. The compression process is resource intensive and is not recommended for older computers.

Enable Video Compression

Select this option to enable video compression when the Capture audio and video option is selected.

Video Codec

Use the Codec drop down list to select the type of compression used when compressing video data. If WMVideo is selected as the codec, selecting the Advanced button will display the Windows Media Preferences dialog.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use System Profile</td>
<td>Select to use a standard system compression profile.</td>
</tr>
<tr>
<td>Drop down list of standard system compression profiles</td>
<td>Select a compression profile from the drop down list of standard system profiles.</td>
</tr>
<tr>
<td>Description of compression profile</td>
<td>Description of the output data rate for the selected compression profile when a standard system profile is selected.</td>
</tr>
<tr>
<td>Use Custom Profile</td>
<td>Select to build a custom compression profile using the Windows Media Profile Editor.</td>
</tr>
<tr>
<td>Browse</td>
<td>Select to search for a previously defined custom compression profile.</td>
</tr>
</tbody>
</table>

If any of the remaining codecs are selected, selecting the Advanced button will display the Codec Preferences dialog.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Quality</td>
<td>Use the sliding bar to increase or decrease audio/video quality. Better quality results in larger data files.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Select to control the recorded frame rate of your selected video source.</td>
</tr>
</tbody>
</table>

**Audio Capture Configuration**

Select the **Advanced**… button to enable and configure audio compression when the **Capture audio and video** option, **Capture audio only and provide live video preview** option, or **Capture audio without live video preview** option is selected. The **Audio Preferences** dialog appears.

**Note** If **WMVideo** is selected as the video codec, the audio capture configuration option is disabled. **WMVideo** has built-in audio and video compression.
The **Audio Sampling Rate** allows you to change the quality of the recorded sound. A higher sample rate, measured in kiloHertz (kHz), provides better quality audio while producing larger file sizes. A higher bitrate, measured in bits, will provide more bandwidth and thus produce better quality audio, but will also produce larger file sizes. Audio can be recorded in either mono or stereo mode. Most PC microphones produce monaural sound.

After enabling audio compression, use the **Codec** drop down list to select the type of compression used when compressing audio data. The output file sizes for various compression codecs built into Windows XP are shown below. These numbers represent the output file size for typical audio that would occur during chart recording for a one minute chart.

**Note** These codecs may or may not be present on your system.

<table>
<thead>
<tr>
<th>Compression Codec</th>
<th>Output File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>No compression</td>
<td>2933 KB</td>
</tr>
<tr>
<td>WM Speech Encoder DMO</td>
<td>168 KB</td>
</tr>
<tr>
<td>WM Audio Encoder DMO</td>
<td>2437 KB</td>
</tr>
<tr>
<td>IMA ADPCM</td>
<td>901 KB</td>
</tr>
<tr>
<td>PCM</td>
<td>901 KB</td>
</tr>
<tr>
<td>Microsoft ADPCM</td>
<td>901 KB</td>
</tr>
<tr>
<td>DSP Group TrueSpeech</td>
<td>189 KB</td>
</tr>
<tr>
<td>Windows Media Audio V2</td>
<td>1245 KB</td>
</tr>
<tr>
<td>GSM 6.10</td>
<td>613 KB</td>
</tr>
<tr>
<td>CCITT A-Law</td>
<td>1527 KB</td>
</tr>
<tr>
<td>CCITT u-Law</td>
<td>1520 KB</td>
</tr>
<tr>
<td>MPEG Layer-3</td>
<td>335 KB</td>
</tr>
</tbody>
</table>
**Tip** The sound quality for each compression codec can vary, so experiment with the codecs available on your system to determine the one that best suits your desired output data size and sound quality.

What should I do next?

Once you have selected the desired audio/video settings for your system, you are ready to record audio/video during an examination.

**Setting Auxiliary Preferences**

The LXSoftware lets you customize the way the system operates. To change the default auxiliary options, select **Preferences** from the **Tools** menu. The **Preferences** window appears. Select the desired auxiliary sensor (**Aux 1**, **Aux 2**, or **Aux 3**) from the left menu and the desired auxiliary sensor property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Sensor ID</td>
<td>The abbreviation (two characters) that appears on the sensor control arrow to identify the sensor. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Preferences dialog.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auxiliary, or <strong>Aux 1</strong></td>
<td>is typically the Movement sensor. The default abbreviation (the two characters that appear on the sensor control) is <strong>AU</strong>.</td>
</tr>
<tr>
<td><strong>Aux 2</strong></td>
<td>is an auxiliary sensor. The default abbreviation (the two characters that appear on the sensor control) is <strong>A2</strong>. The Aux 2 sensor should be used as the input from the Countermeasure Detection System (Model 76876US) available from Lafayette Instrument Company.</td>
</tr>
<tr>
<td><strong>Aux 3</strong></td>
<td>is an auxiliary sensor. The default abbreviation (the two characters that appear on the sensor control) is <strong>A3</strong>.</td>
</tr>
<tr>
<td>Enable the sensor trace</td>
<td>Displays the selected sensor's trace and sensor control on the screen.</td>
</tr>
<tr>
<td>Make the trace more visible (Bold)</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>Displays the color of the sensor trace. Use the drop down arrow to select another color for the trace.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong>: If you do not like the basic colors, you can create your own. <a href="#">Click here for instructions.</a></td>
</tr>
<tr>
<td>Startup Gain (0-10)</td>
<td>Use the arrows to increase or decrease the startup gain value.</td>
</tr>
</tbody>
</table>

**Note**: To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

### Setting Background Preferences

The LXSoftware lets you customize the way the system operates. To change the default background options, select **Preferences** from the **Tools** menu. The **Preferences** window appears. Select **Background** from the left menu and the **Background** property page appears.

**Tip**: Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Color</td>
<td>Displays the color of the background. Use the drop down arrow to select another color for the background.</td>
</tr>
<tr>
<td><strong>Tip</strong>: If you do not like the basic colors, you can create your own. Click here for instructions.</td>
<td></td>
</tr>
<tr>
<td>Enable Chart Watermark</td>
<td>Select to choose a watermark and center it on the background of the chart.</td>
</tr>
<tr>
<td>File</td>
<td>Displays the location of the selected watermark file. Select the <strong>Browse</strong> button (folder icon) to search for a desired watermark file.</td>
</tr>
</tbody>
</table>

**Note**: To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

**Setting Caliper Preferences**

The LXSoftware allows you to customize caliper settings. To change the default caliper options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Calipers** from the left menu and the Calipers property page appears.

**Tip**: Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show caliper statistics dialog box when calipers are active</td>
<td>Select to show the caliper statistics dialog box when the calipers are active in the Chart Review window. Caliper statistics indicate the dimensions of the chart area selected by the calipers, the minimum, maximum, and average EDA (Electrodermal) Ohms, heart rate, respiration rate, and cuff pressure. Respiration line lengths are also automatically measured.</td>
</tr>
</tbody>
</table>
| Display line length measurements in millimeters instead of pixels | Select to display line length measurements in millimeters instead of pixels within the caliper statistics window.  
  **Note:** Your screen must be calibrated via the Screen Calibration Preferences (under the Tools menu) before waveforms can be measured in millimeters. |
| Select the color of the calipers:                   | Displays the current color of the calipers. Use the drop down arrow to select another color for the option.  
  **Tip:** If you do not like the basic colors, you can create your own. Click here for instructions. |
| Center calipers within the chart display          | Select to center the calipers within the chart display (Left = 50 pixels)                                                                 |

![Preferences dialog box for calipers settings](image)
### Setting Cardio Preferences

The LXSoftware lets you customize the way the system operates. To change the default Cardio options, select **Preferences** from the **Tools** menu. The **Preferences** window appears. Select **Cardio** from the left menu and the **Cardio** property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chart display</td>
<td>left of center, Right = 50 pixels right of center).</td>
</tr>
<tr>
<td>Place calipers on a specific question</td>
<td>Select to specify a question number upon which the calipers should be placed when first displayed.</td>
</tr>
<tr>
<td>Use default caliper width</td>
<td>Select to set caliper width to the default width of 100 pixels.</td>
</tr>
<tr>
<td>Set caliper width to question duration</td>
<td>Select to place the left caliper at the beginning of the question and the right caliper at the beginning of the next question.</td>
</tr>
<tr>
<td>Set caliper width to a fixed duration in seconds</td>
<td>Select to specify a specific time distance in seconds between the calipers.</td>
</tr>
<tr>
<td>Lock caliper width to prevent resizing</td>
<td>Select to lock the fixed duration of the calipers. Moving one caliper causes the other caliper to move an identical amount. While reviewing a chart, it is possible to override the caliper lock if needed. To override, grab the caliper handle at the caliper endpoint and slide the caliper to the desired location. This allows the calipers to be moved individually despite the locked setting.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Sensor ID</td>
<td>Cardio is the Cardiovascular sensor. The default abbreviation (the two characters that appear on the sensor control) is CA. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Cardio property page of the Preferences dialog.</td>
</tr>
<tr>
<td>Enable the sensor trace</td>
<td>Displays the selected sensor's trace and sensor control on the screen.</td>
</tr>
<tr>
<td>Make the trace more visible (Bold)</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
<tr>
<td>Use finger cuff</td>
<td>Select to use the finger cuff instead of the arm cuff for the cardiovascular sensor. The finger cuff should be inflated to between 90 and 100 mmHg.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>Displays the color of the sensor trace. Use the drop down arrow to select another color for the trace.</td>
</tr>
<tr>
<td>Tip</td>
<td>If you do not like the basic colors, you can create your own. Click here for instructions.</td>
</tr>
<tr>
<td>Startup Gain (0-10)</td>
<td>Use the arrows to increase or decrease the startup gain value.</td>
</tr>
</tbody>
</table>
Setting Chart Preferences

The LXSoftware lets you customize the way the system operates. To change the default chart options, select Preferences from the Tools menu. The Preferences window appears. Select Chart Settings from the left menu and the Chart Settings property page appears.

Tip: Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the grid</td>
<td>Select to enable the grid on the screen display.</td>
</tr>
<tr>
<td>Select the grid style</td>
<td>Select the desired chart grid style - Legacy, Dashes, or Solid - from the pull-down menu.</td>
</tr>
<tr>
<td>Select the grid color</td>
<td>Displays the current color of the grid. Use the drop down arrow to select another color for the option.</td>
</tr>
<tr>
<td>Display a vertical timeline for responses</td>
<td>Select to display a vertical line on displayed charts for each subject response.</td>
</tr>
<tr>
<td>Display a vertical timeline</td>
<td>Select to display a vertical line on displayed charts for each response.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>for annotations</td>
<td>annotation, or chart marking, made by the examiner.</td>
</tr>
<tr>
<td>Set question timer</td>
<td>Enter a value from 0 to 60 to indicate the minimum amount of time between question onsets. The timer may be overridden by double-clicking the question timer cylinder when recording a chart.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Polyscore requires 25 seconds between question onsets. Scoring charts with less than the minimum time between onsets may invalidate scoring results.</td>
</tr>
<tr>
<td>Start the question timer after answer is given</td>
<td>Select to start the question timer after the answer indication has been made. Otherwise, the question timer starts after the question has been asked.</td>
</tr>
<tr>
<td>Remember chart recording window size and sensor positions</td>
<td>Select to save the chart recording window size and sensor positions between LXSoftware sessions.</td>
</tr>
<tr>
<td>Reset to Default</td>
<td>Select to reset the chart recording window and audio/video preview window to their default sizes and positions. In addition, the sensor positions in the chart recording window will be reset to their default locations.</td>
</tr>
<tr>
<td>Color code question IDs</td>
<td>Select to color code question IDs to better identify the different types of questions in a question set.</td>
</tr>
<tr>
<td>Draw smooth chart traces</td>
<td>Select this option to draw smooth chart traces. Due to the significant processing requirements of this feature, it may be incompatible with slower computers.</td>
</tr>
<tr>
<td>Reduce screen flicker</td>
<td>Select this option to reduce the number of redraws during chart review and thus reduce the amount of screen flicker. Due to the significant processing requirements of this feature, it may be incompatible with slower computers.</td>
</tr>
<tr>
<td>Question Text Font:</td>
<td>Displays the current font for the question text in the Chart Display and Chart Review views.</td>
</tr>
<tr>
<td>Change Font...</td>
<td>Select to change the font for the question text in the Chart Display and Chart Review views. Selecting the Change Font... button opens the Font window, allowing you to select the desired font.</td>
</tr>
<tr>
<td>Reset to Default</td>
<td>Select the Reset to Default button to reset the question text font to its default font, font style, and size.</td>
</tr>
<tr>
<td>Chart Font:</td>
<td>Displays the current font for the chart in the Chart Display and Chart Review views.</td>
</tr>
<tr>
<td>Change Font...</td>
<td>Select to change the font for the chart in the Chart Display and Chart Review views. Selecting the Change Font... button opens the Font window, allowing you to select the desired font.</td>
</tr>
<tr>
<td>Reset to Default</td>
<td>Select the Reset to Default button to reset the chart font to its default font, font style, and size.</td>
</tr>
<tr>
<td>Window Arrangement:</td>
<td>Use the drop-down list to select how chart windows are positioned as they are opened (Maximize, Cascade, Tile Horizontally, Tile Vertically, or Legacy style).</td>
</tr>
</tbody>
</table>

**Note:** To save the chart preferences, select OK. To close the property sheet and ignore any changes, select Cancel.

Additional features of the chart may be customized within LXSoftware. Click on an item below to customize that feature.
Setting Chart Comments Preferences

The LXSoftware lets you customize the way the system operates. To change the default Chart Comments options, select Preferences from the Tools menu. The Preferences window appears. Select Chart Comments from the left menu and the Chart Comments property page appears.

Tip: Click on a setting to see a brief description at the bottom of the window.

The following options are supported:
### Setting Electrodermal Preferences - Manual & Detrended Mode

The LXSoftware lets you customize the way the system operates. To change the detrended mode options for Electrodermal Respiration, select Preferences from the Tools menu. The Preferences window appears. Select Electrodermal (EDA) - Detrended (or - Manual) from the left menu and the property page appears.

The Electrodermal detrending filter attempts to remove long-term trends, such as plunges and rises in the signal, without affecting short-term reactions. The filter design attempts to provide the re-centering capability of the existing automatic filter on the recovery side of a reaction while providing minimal attenuation during the rise side. It is possible to view both the detrended and manual electrodermal sensors simultaneously in both chart recording and chart review.

**Tip:** Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Sensor ID</td>
<td>ED is the Electrodermal sensor in detrended mode. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Preferences dialog.</td>
</tr>
<tr>
<td>Enable the sensor trace</td>
<td>Displays the selected sensor's trace and sensor control on the screen.</td>
</tr>
<tr>
<td>Make the trace more visible (Bold)</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>Displays the color of the sensor trace. Use the drop down arrow to select another color for the trace.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> If you do not like the basic colors, you can create your own. Click here for instructions.</td>
</tr>
<tr>
<td>Startup Gain (0-10)</td>
<td>Use the arrows to increase or decrease the startup gain value.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select OK. To close the property sheet and ignore any changes, select Cancel.
Setting Electrodermal Preferences - Manual Mode

The LXSoftware lets you customize the way the system operates. To change the manual mode options for Electrodermal Respiration, select Preferences from the Tools menu. The Preferences window appears. Select Electrodermal - Manual from the left menu and the property page appears.

The manual mode displays the low-pass filtered raw data as acquired from the data acquisition hardware. A low-pass filter is used to smooth the sensor trace and reduce signal noise.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Sensor ID</td>
<td>EM is the Electrodermal sensor in manual mode. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Preferences dialog.</td>
</tr>
<tr>
<td>Enable the sensor trace</td>
<td>Displays the selected sensor's trace and sensor control on the screen.</td>
</tr>
<tr>
<td>Make the trace more visible (Bold)</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
</tbody>
</table>
### Setting Examination Preferences

The LXSoftware lets you customize the way the system operates. To change the default examination options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Examination** from the left menu and the **Examination** property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace Color</td>
<td>Displays the color of the sensor trace. Use the drop down arrow to select another color for the trace. <strong>Tip:</strong> If you do not like the basic colors, you can create your own. Click here for instructions.</td>
</tr>
<tr>
<td>Startup Gain (0-10)</td>
<td>Use the arrows to increase or decrease the startup gain value.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

The following options are supported:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require entry of Personal History</td>
<td>Select to have the Personal History dialog box appear automatically when you create a PF. The dialog must be completed to continue.</td>
</tr>
<tr>
<td><strong>Note</strong>: If this check box is blank, the Personal History dialog box does not appear when you create a PF. If you want to access the dialog box, you must select Personal History from the Exam menu.</td>
<td></td>
</tr>
<tr>
<td>Require entry of Exam Information</td>
<td>When selected, you must have an active exam to start recording.</td>
</tr>
<tr>
<td><strong>Note</strong>: If this check box is blank, an exam will be automatically created for you if one does not exist.</td>
<td></td>
</tr>
<tr>
<td>Require question set for chart recording</td>
<td>When this check box is selected, a question set must be selected before chart recording can begin.</td>
</tr>
<tr>
<td>Generate examination database</td>
<td>Select to create an auxiliary Microsoft Access database containing all Personal History and Exam Information. The database file will be created when the Personal History and Exam Information are next modified or created. This database file can be merged with other PF database files, and the results analyzed using tools provided by Microsoft Access. Contact Lafayette Instrument Company for additional details regarding this feature.</td>
</tr>
<tr>
<td>Auto-select charts to score</td>
<td>When selected, all recorded charts are selected for automatic scoring when the scoring selection dialog is displayed.</td>
</tr>
<tr>
<td>Check spelling as you type in the PF notes window</td>
<td>Select to check text as it is entered into the PF Notes. Unrecognized words will appear with a red highlight. Right-clicking on a highlighted word will display a list of suggested alternate spellings. If you do not select this option, you may still perform a manual spell check at any time by selecting Check Spelling from the Tools menu.</td>
</tr>
<tr>
<td>Generate customized Final Report with extended field support</td>
<td>When selected, support is provided for a custom Final Report with extended field support. With extended field support, any field that appears in the examination database may be exported to the Final Report, as well as chart, question set, and PF Question Set information. This feature is available for Microsoft Word version 8 (Microsoft Office 97) or higher, or Corel WordPerfect version 9 (WordPerfect Office 2000) or higher. Two types of Final Report templates are provided with the LXSoftware. The first type of template was the only template available prior to LXSoftware version 8.0. It worked with Microsoft Word and Microsoft WordPad and performed a simple text replace of tagged values in the template to generate the Final Report. This template had a limited number of fields that could be exported from the LXSoftware and was not very flexible. The version 8.0 release introduced a more sophisticated form of Final Report generation that provides support for an unlimited amount of information that may be exported to the Final Report. For more details, see “Creating a Report.” Please note, Microsoft WordPad does not support Custom Final Reports with extended field support. If you already have a custom Final Report template that you were using prior to Version 8.0, and you do not require exporting additional fields, you do not have to select this option. Otherwise, it is recommended that this option be selected. A custom template is one that has been modified from the template provided by Lafayette Instrument Company and customized</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Final Report Word Processor</td>
<td>Select the word processor to use for automatic generation of the Final Report.</td>
</tr>
<tr>
<td>PF Directory Edit Box</td>
<td>Displays the working PF Directory. The PF directory is the location on disk where newly created PFs are stored. The drop-down box lists the last five selected PF directories. You can use the Browse button to display a graphical directory hierarchy from which to select the new PF Directory or you can type the directory name directly into the edit box. The PF directory will be created if necessary.</td>
</tr>
<tr>
<td><strong>Note</strong>: If a PF is currently open, the PF directory control will be disabled since the PF directory cannot be changed when a PF is open.</td>
<td></td>
</tr>
<tr>
<td>Browse PF Directory</td>
<td>Select this button to select the working PF Directory from a graphical directory hierarchy. The PF directory is the location on disk where newly created PFs are stored. The results of this selection will be displayed in the PF Directory edit field.</td>
</tr>
<tr>
<td><strong>Note</strong>: If a PF is currently open, the PF directory browse control will be disabled since the PF directory cannot be changed when a PF is open.</td>
<td></td>
</tr>
<tr>
<td>Use legacy Question Editor</td>
<td>Select to make the legacy Question Editor the default question editor in LXSoftware.</td>
</tr>
<tr>
<td>Auto-center all traces at the start of each chart</td>
<td>Select to automatically center all traces at the start of each chart.</td>
</tr>
<tr>
<td>Display the questions asked in the browser window.</td>
<td>This option is useful when performing examinations on hearing-impaired subjects. It allows displaying the question text in the LXBrowser window on a second monitor during chart recording. The question text will be displayed for the duration that either the space bar or <strong>Onset</strong> button is depressed during chart recording.</td>
</tr>
<tr>
<td>Open Browser…</td>
<td>Select to open the LXBrowser window.</td>
</tr>
<tr>
<td>Operate in Translator Mode</td>
<td>When Translator Mode is selected, the currently selected question text is displayed in yellow on an external monitor that may be viewed by the translator. This allows the translator some time to read the question text and perform the translation mentally. At question onset, the question text changes to a user-configurable color, which serves as a cue for the translator to begin asking the question to the subject. As the examiner moves between questions, the question text is always presented on the translator’s monitor.</td>
</tr>
<tr>
<td><strong>Note</strong>: To save the examination preferences, select <strong>OK</strong>. To close the property sheet and ignore any changes, select <strong>Cancel</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Setting Printing During Recording Preferences**

The LXSoftware lets you customize the way the system operates. To change the default printing options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Printing During Recording** from the left menu and the Printing During Recording property page appears.
Note: A number of the settings below are only available when the Pentax printer type is selected. These settings can be identified by clicking on the settings below for their descriptions.

Tip: Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print charts while recording</td>
<td>Select the check box if you want the charts to print while you’re recording.</td>
</tr>
<tr>
<td>Printer</td>
<td>From the Printer drop-down menu, select the name of the printer you are using. Examples of printers that support continuous printing are the Pentax PocketJet II and HP DeskJet banner printers.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Not all HP DeskJet printers support continuous printing. The printer must support banner printing and the PCL3 printer language. See your printer user manual for detailed printer specifications.</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>From the <strong>Type</strong> drop-down menu, select the type of printer that most closely reflects the printer specified in the Printer drop-down menu. The selected type informs the LXSoftware of the internal print driver to use during continuous printing.</td>
</tr>
<tr>
<td>Trace thickness</td>
<td>Changes the thickness of all the non-bold traces. The larger the number, the thicker and more visible the trace will be. <strong>Note:</strong> This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Bold trace thickness</td>
<td>Changes the thickness of all the bold traces. The larger the number, the thicker and more visible the trace will be. <strong>Note:</strong> This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Print the chart grid?</td>
<td>Select <strong>Yes</strong> if you want the grid to appear on the printed charts.</td>
</tr>
<tr>
<td>Grid line thickness</td>
<td>Change the thickness of the grid lines. The larger the number, the thicker and more visible the grid lines will be. <strong>Note:</strong> This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Print a vertical time-line for responses?</td>
<td>Select <strong>Yes</strong> to display a vertical line on printed charts for each subject response.</td>
</tr>
<tr>
<td>Response line thickness</td>
<td>Changes the thickness of the response vertical lines. The larger the number, the thicker and more visible it will be. <strong>Note:</strong> This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Print a vertical time-line for annotations?</td>
<td>Select <strong>Yes</strong> to display a vertical line on printed charts for each annotation, or chart marking, made by the examiner.</td>
</tr>
<tr>
<td>Annotation line thickness</td>
<td>Changes the thickness of the annotation vertical lines. The larger the number, the thicker and more visible the lines will be. <strong>Note:</strong> This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Gain-change line thickness</td>
<td>Changes the thickness of the gain-change vertical lines. The larger the number, the thicker and more visible the lines will be. <strong>Note:</strong> This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text font size</td>
<td>Select the text font size. A larger value prints out larger text and a smaller value prints out smaller text. <strong>Note</strong>: This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Print the chart comments if they exist?</td>
<td>Select <strong>Yes</strong> to print all chart comments on a separate page. Select <strong>No</strong> to prevent chart comments from being printed.</td>
</tr>
<tr>
<td>Page orientation</td>
<td>Select <strong>Portrait</strong> to print comments in portrait mode. Select <strong>Landscape</strong> to print comments in landscape mode.</td>
</tr>
<tr>
<td>Print the chart info after the chart?</td>
<td>Select <strong>Yes</strong> to print the chart info at the end of the chart. Select <strong>No</strong> to prevent the chart info from being printed.</td>
</tr>
<tr>
<td>Print the questions asked during recording?</td>
<td>Select <strong>Yes</strong> to print the questions asked during recording on a separate page. Select <strong>No</strong> to prevent the questions asked from being printed. <strong>Note</strong>: This setting is only available when the Pentax printer type is selected.</td>
</tr>
<tr>
<td>Page orientation</td>
<td>Select <strong>Portrait</strong> to print the questions asked in portrait mode. Select <strong>Landscape</strong> to print the questions asked in landscape mode. <strong>Note</strong>: This setting is only available when the Pentax printer type is selected.</td>
</tr>
</tbody>
</table>

**Note**: To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

**Setting Printing During Review Preferences**

The LXSoftware lets you customize the way the system operates. To change the default printing options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Printing During Review** from the left menu and the Printing During Review property page appears.

**Tip**: Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print the chart in color?</strong></td>
<td>If printing to a color printer and this option is selected, all chart colors will match the color settings specified in the Preferences. The background will always be printed in white. If this option is not selected, the chart will be printed in black and white.</td>
</tr>
<tr>
<td><strong>Print the chart grid?</strong></td>
<td>Select Yes if you want the grid to appear on the printed charts. 新增 Select No if you don't want the grid on the charts.</td>
</tr>
<tr>
<td><strong>Select the grid style</strong></td>
<td>Select the style of grid used during printing, either solid line or dashes.</td>
</tr>
<tr>
<td><strong>Print a vertical time-line for responses?</strong></td>
<td>Select Yes to display a vertical line on printed charts for each subject response.</td>
</tr>
<tr>
<td><strong>Print a vertical time-line for annotations?</strong></td>
<td>Select Yes to display a vertical line on printed charts for each annotation, or chart marking, made by the examiner.</td>
</tr>
<tr>
<td><strong>Print the chart comments if they exist?</strong></td>
<td>Select Yes to print all chart comments on a separate page. Select No to prevent chart comments from being printed.</td>
</tr>
<tr>
<td><strong>Page orientation</strong></td>
<td>Select Portrait to print comments in portrait mode. Select Landscape to print comments in landscape mode.</td>
</tr>
<tr>
<td><strong>Select where the chart info will be printed</strong></td>
<td>Select Before the chart to print all of the chart info on a separate page before the chart. Select Below the chart to print the info under the chart on each page.</td>
</tr>
<tr>
<td><strong>Select the paper type</strong></td>
<td>Select Sheet if the paper type is separate sheets of paper, perforated sheets, etc. Select Roll if the paper type is a continuous feed roll of paper.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print the questions asked during recording?</td>
<td>Select <strong>Yes</strong> to print the questions asked during recording on a separate page. Select <strong>No</strong> to prevent the questions asked from being printed.</td>
</tr>
<tr>
<td>Page orientation</td>
<td>Select <strong>Portrait</strong> to print the questions asked in portrait mode. Select <strong>Landscape</strong> to print the questions asked in landscape mode.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

### Setting Question Bar Preferences

The LXSoftware lets you customize the way the system operates. To change the default question bar options, select **Preferences** from the **Tools** menu. The **Preferences** window appears. Select **Question Bar** from the left menu and the **Question Bar** property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Color</td>
<td>Displays the current color of the Question Bar. Use the drop down arrow to select another color for this option.</td>
</tr>
</tbody>
</table>

**Tip:** If you do not like the basic colors, you can create your own. [Click here for instructions.]

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

---

**Setting Screen Calibration Preferences**

The LXSoftware lets you customize the way the system operates. To change the screen calibration, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Screen Calibration** from the left menu and that property page appears.

The property page allows you to calibrate screen measurements so that accurate measurements can be made in real units (millimeters) instead of pixels.

Carefully place a ruler near the computer screen. Use the arrow buttons to adjust the horizontal and vertical on-screen rulers until the measurements match the appropriate marks on the ruler.

**Note:** Use extreme care with LCD displays to avoid scratching the screen.

**Tip:** Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrate in inches</td>
<td>Select <strong>Calibrate in inches</strong> to calibrate the screen in inches.</td>
</tr>
<tr>
<td>Calibrate in centimeters</td>
<td>Select <strong>Calibrate in centimeters</strong> to calibrate the screen in centimeters.</td>
</tr>
<tr>
<td>Calibration arrows</td>
<td>Carefully place a ruler near the computer screen. Use the arrow buttons to adjust the horizontal and vertical on-screen rulers until the measurements match the inch marks on the ruler.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

### Setting Speech Synthesis Preferences

The LXSoftware lets you customize the way the system operates. To change the default Speech Synthesis options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Speech Synthesis** from the left menu and that property page appears.

The property page allows you to enable speech synthesis, as well as select the computerized voice to use, the speech speed, and the speech volume. When enabled, the computer will ask the questions during the examination and also during chart replay.
Note: Windows XP has a built-in speech capability. Additional voices, providing higher speech quality, may be purchased by contacting the Lafayette Instrument Company.

Tip: Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Computerized Speech Synthesis</td>
<td>Select to enable speech synthesis. When enabled, the computer will ask the questions during the examination and also during chart replay.</td>
</tr>
<tr>
<td>Sample text box</td>
<td>Enter sample text for the computer to speak using the selected voice, speed, and volume.</td>
</tr>
<tr>
<td>Voice:</td>
<td>Windows XP comes with built-in speech capability. Use the drop down list to select the desired voice. If additional voices have been installed, they will also appear in this drop-down list.</td>
</tr>
<tr>
<td>Speed:</td>
<td>Use the sliding arrow to control the speed of the selected computerized voice.</td>
</tr>
<tr>
<td>Volume:</td>
<td>Use the sliding arrow to control the volume of the computerized voice.</td>
</tr>
<tr>
<td>Speak</td>
<td>Select to have the computer speak the text entered in the sample box above.</td>
</tr>
<tr>
<td>Pause</td>
<td>Select to pause the computer’s speech of the sample text. Once selected, the Pause button changes to a Resume button. Select the Resume.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>button to have the computer continue speaking the sample text.</td>
</tr>
<tr>
<td>Stop</td>
<td>Select to have the computer stop speaking the sample text.</td>
</tr>
</tbody>
</table>

Please note that speech synthesis may also be enabled and configured if necessary during chart recording or chart playback by right-clicking on the question text within the chart window and selecting the **Speech** menu.

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

**Setting System Preferences**

The LXSoftware lets you customize the way the system operates. To change the default system options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **System Preferences** from the left menu and the **System Preferences** property page appears.

To change a setting, click on the row containing the setting to change, click on the down arrow to display a list of choices and select the new setting.

**Note:** Double-clicking on the second column rotates through the available options.

**Note:** Click on a setting to see a brief description at the bottom of the window.
Note: To save the system preferences, select OK. To close the window and ignore any changes, select Cancel.

The following system options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize application on startup</td>
<td>Setting this option to 'Yes' causes the application to fill the entire screen on startup. Setting to 'No' causes the application's size and position to be restored to the size and position when the application was last shutdown.</td>
</tr>
<tr>
<td>Auto-open chart manager</td>
<td>Set this option to 'Yes' to have the &quot;Chart Manager&quot; dialog automatically open when the application starts. The &quot;Chart Manager&quot; dialog allows the user to quickly find charts and manipulate their positions. See Managing Charts for further details.</td>
</tr>
<tr>
<td>Auto-open PF notes</td>
<td>Set this option to 'Yes' to have the &quot;PF Notes&quot; window automatically opened when a chart is opened that contains PF notes. This setting makes it easy to know that an examiner has entered notes because the window is automatically opened.</td>
</tr>
<tr>
<td>Auto-load a question set on startup</td>
<td>Set this option to 'Yes' to automatically load the last question set used during recording. Set to 'No' to not load any question set and force the examiner to always enter it. This prevents an examiner from accidentally using an old question set.</td>
</tr>
<tr>
<td>Prompt for a new series</td>
<td>Set this option to 'Yes' to have the examiner prompted for a new series when clicking on the &quot;Start&quot; button. The following conditions determine if the user is prompted:</td>
</tr>
</tbody>
</table>

Note: To save the system preferences, select OK. To close the window and ignore any changes, select Cancel.
Setting Thoracic Respiration Preferences

The LXSoftware lets you customize the way the system operates. To change the default Thoracic Respiration options, select Preferences from the Tools menu. The Preferences window appears. Select Thoracic Respiration from the left menu and the Thoracic Respiration property page appears.

Tip: Click on a setting to see a brief description at the bottom of the window.

The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>An existing PF was opened without the user creating a new series.</td>
<td></td>
</tr>
<tr>
<td>The question set name changed.</td>
<td></td>
</tr>
<tr>
<td>The question set text changed.</td>
<td></td>
</tr>
<tr>
<td>Set to ‘No’ to prevent the system from prompting for a new series.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Sensor ID</td>
<td><strong>P2</strong> is the default abbreviation assigned to the Pneumatic 2 sensor control. The <strong>P2</strong> sensor produces the <strong>Thoracic Respiration Trace</strong>. You can change a sensor's abbreviation by typing two new characters in the <strong>Sensor ID</strong> field in the <strong>Abdominal Respiration</strong> property page of the <strong>Preferences</strong> dialog.</td>
</tr>
<tr>
<td>Enable the sensor trace</td>
<td>Displays the selected sensor's trace and sensor control on the screen.</td>
</tr>
<tr>
<td>Make the trace more visible (Bold)</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>Displays the color of the sensor trace. Use the drop down arrow to select another color for the trace.</td>
</tr>
</tbody>
</table>

**Tip:** If you do not like the basic colors, you can create your own. Click here for instructions.

| Startup Gain (0-10)   | Use the arrows to increase or decrease the startup gain value.                                                                                 |

**Note:** To save the preferences, select **OK**. To close the property sheet and ignore any changes, select **Cancel**.

### Setting Toolbar/Menu Preferences

The LXSoftware lets you customize the way the system operates. To change the default Toolbar/Menu options, select **Preferences** from the **Tools** menu. The Preferences window appears. Select **Toolbar/Menu** from the left menu and the Toolbar/Menu property page appears.

To change a setting, click on the option to change in the left column. The available choices for that option will appear in the right column.

**Tip:** Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theme</td>
<td>Select the theme, which affects the appearance of all toolbars and menus.</td>
</tr>
<tr>
<td>Font</td>
<td>Select the font to be used for all toolbars and all menus.</td>
</tr>
<tr>
<td>Toolbar Icon Size</td>
<td>Select the size of the toolbar icons.</td>
</tr>
<tr>
<td>Show Toolbar Text</td>
<td>Set to Yes to display text under the toolbar icons.</td>
</tr>
<tr>
<td>Show Toolbar Tooltips</td>
<td>Displays on-screen descriptions of toolbar buttons when the mouse pointer pauses over them.</td>
</tr>
<tr>
<td>Show Shortcuts in Tooltips</td>
<td>Set to Yes to display shortcut keys in the toolbar tooltips.</td>
</tr>
<tr>
<td>Menu Icon Size</td>
<td>Select the size of the menu icons.</td>
</tr>
<tr>
<td>Menu Animation</td>
<td>Select the menu animation type, which affects what a menu does as it is being displayed.</td>
</tr>
<tr>
<td>Sort the Open PF menu items by date?</td>
<td>Select Yes to sort the Open PF popup menu by most recently modified file.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Restore the toolbar and menu settings to factory defaults.</td>
</tr>
</tbody>
</table>

**Customize Toolbar**

Use this dialog to show, hide, create, or delete toolbars. Additionally, a toolbar can be customized or reset to its default state.
• To show a toolbar, select the box to the left of its name. To hide a toolbar, clear the box. To add a button to a toolbar, click the **Commands** tab.

• Select **New...** to assign a name to a new, empty toolbar to which you can add buttons. User-defined toolbars created through this method may also be renamed or deleted.

• Select **Reset...** to reset the highlighted toolbar to its default state. If the highlighted toolbar is a user-defined toolbar, the function of this button is to delete the user-defined toolbar.

• To further customize the toolbar settings, select **Customize...**.

![Customize dialog](image)

**Toolbar Commands**

Use this dialog to add or modify command buttons on existing toolbars.

Select a toolbar from the Categories list to see a complete list of available commands for the selected toolbar category. To see other commands, click another category in the Categories list.

Drag the button from this dialog to any toolbar.

To remove a button from a toolbar without displaying this dialog, simply hold down the `<Alt>` key and simultaneously drag the button off the toolbar and drop it anywhere on the screen. To move a button to a different toolbar, drag the toolbar button as indicated above and drop it on the target toolbar.
Custom Final Report with extended field support

When this check box is selected in Examination Preferences, support is provided for a custom Final Report with extended field support. With extended field support, any field that appears in the examination database may be exported to the Final Report, as well as chart and PF Question Set information. This feature is available for Microsoft Word version 8 (Microsoft Office 97) or higher, or Corel WordPerfect version 9 (WordPerfect Office 2000) or higher.

Two types of Final Report templates are provided with the LXSoftware. The first type of template was the only template available prior to LXSoftware version 8.0. It worked with Microsoft Word and Microsoft WordPad and performed a simple text replace of tagged values in the template to generate the Final Report. This template had a limited number of fields that could be exported from the LXSoftware and was not very flexible.

The version 8.0 release introduced a more sophisticated form of Final Report generation that provides support for an unlimited amount of information that may be exported to the Final Report. For more details, see Generation of a Custom Final Report Template for Microsoft Word, or Generation of a Custom Final Report Template for Corel WordPerfect. Microsoft WordPad does not support Custom Final Reports with extended field support.

If you already have a custom Final Report template that you were using prior to Version 8.0, and you do not require exporting additional fields, you do not have to select this option. Otherwise, it is recommended that this option be selected. A custom template is one that has been modified from the template provided by Lafayette Instrument Company and customized to your individual needs.

Defining a Custom Color

19 When this check box is selected, an auxiliary Microsoft Access database will be created containing all Personal History and Exam Information. The database file will be created when the Personal History and Exam Information are next modified or created. This database file can be merged with other PF database files, and the results analyzed using tools provided by Microsoft Access. Contact Lafayette Instrument Company for additional details regarding this feature.
If you do not like the basic colors, create your own:

1. Select the More Colors... button in the Color dialog box. The Color Refiner box appears to the right of the Basic Colors palette.

![Color dialog box](image)

2. Click on the color and view it to make sure it is the correct color. Then drag the arrow in the vertical luminosity bar up or down to adjust the luminosity.

The color you’re creating appears on the left side of the Color/Solid box. Ignore the color on the right side, which simply shows the basic colors supported by your video card depending on your configuration.

**Tip:** If you know the correct values, you can skip the refiner box and type them in the Red, Green, and Blue or the Hue, Sat and Lum boxes.

3. Select the OK button to close the Color dialog box. The new color will be added to the Basic Colors palette.

**Preferences Look/Feel Summary**

The LXSoftware lets you customize the way the system operates. To view a look/feel summary of the current chart settings and make changes, select Preferences from the Tools menu. The Preferences window appears. Select Look/Feel Summary from the left menu and the Look/Feel Summary property page appears.

**Tip:** Click on a setting to see a brief description at the bottom of the window.
The following options are supported:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Displays the current color of the option in question. Use the drop down arrow to select another color for the option. <strong>Tip:</strong> If you do not like the basic colors, you can create your own. Click here for instructions.</td>
</tr>
<tr>
<td>Bold</td>
<td>Displays the sensor's trace in bold.</td>
</tr>
<tr>
<td>Enable</td>
<td>Select to enable the desired sensor(s).</td>
</tr>
<tr>
<td>Chart Preview</td>
<td>Previews the chart with the currently selected settings.</td>
</tr>
<tr>
<td>Thoracic Respiration</td>
<td>P2 is the default abbreviation assigned to the Pneumatic 2 sensor control. The P2 sensor produces the Thoracic Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Thoracic Respiration property page of the Preferences dialog.</td>
</tr>
<tr>
<td>Abdominal Respiration</td>
<td>P1 is the default abbreviation assigned to the Pneumatic 1 sensor control. The P1 sensor produces the Abdominal Respiration Trace. You can change a sensor's abbreviation by typing two new characters in the Sensor ID field in the Abdominal Respiration property page of the Preferences dialog.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EDA - Manual</td>
<td>The Electrodermal manual mode displays the low-pass filtered raw data as acquired from the data acquisition hardware. A low-pass filter is used to smooth the sensor trace and reduce signal noise. You can change a sensor’s abbreviation by typing two new characters in the Sensor ID field in the Electrodermal property pages of the Preferences dialog.</td>
</tr>
<tr>
<td>EDA - Detrended</td>
<td>The Electrodermal detrending filter attempts to remove long-term trends, such as plunges and rises in the signal, without affecting short-term reactions. The filter design attempts to provide the re-centering capability of the existing automatic filter on the recovery side of a reaction while providing minimal attenuation during the rise side. It is possible to view both the detrended and manual electrodermal sensors simultaneously in both chart recording and chart review. You can change a sensor’s abbreviation by typing two new characters in the Sensor ID field in the Electrodermal property pages of the Preferences dialog.</td>
</tr>
<tr>
<td>Cardio</td>
<td>Cardio is the Cardiovascular sensor. The default abbreviation (the two characters that appear on the sensor control) is CA. You can change a sensor’s abbreviation by typing two new characters in the Sensor ID field in the Cardio property page of the Preferences dialog.</td>
</tr>
<tr>
<td>Background</td>
<td>Displays the current color of the option in question. Use the drop down arrow to select another color for the option.</td>
</tr>
<tr>
<td>Answer/Annotation</td>
<td>Displays the color of the Answer/Annotation line. Use the drop down arrow to select another color for the line.</td>
</tr>
<tr>
<td>Question Bar</td>
<td>Displays the color of the Question Bar. Use the drop down arrow to select another color for the bar.</td>
</tr>
<tr>
<td>Enable Chart Watermark</td>
<td>Select this option to center a watermark on the background of the chart.</td>
</tr>
<tr>
<td>Browse button</td>
<td>Select the Browse button to search for a desired file.</td>
</tr>
</tbody>
</table>

**Note:** To save the preferences, select OK. To close the property sheet and ignore any changes, select Cancel.

**Working with the User List**

Only a system administrator can add, change, or delete users from the user list file.

To access the user list dialog box:

1. Select User List from the System menu. The User List dialog box appears. The User List dialog displays the list of current users for the LXSoftware.

**Tip:** Click on a setting to see a brief description at the bottom of the window.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User List box</td>
<td>Every user in the system is listed in this box. Browse through the list to identify examiners, supervisors, and system administrators. To change or delete user information, you must first select the user by clicking on his or her name. <strong>Tip:</strong> The fields in the User List dialog can be sorted by clicking on the column headings.</td>
</tr>
<tr>
<td>Add</td>
<td>See the topic &quot;Editing User Information&quot; for more information.</td>
</tr>
<tr>
<td>Edit</td>
<td>See the topic &quot;Editing User Information&quot; for more information.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select this button to delete a user from the list of users who may access the LXSoftware.</td>
</tr>
<tr>
<td>Print</td>
<td>Select this button to print the list of authorized users along with a summary of their user logon information.</td>
</tr>
<tr>
<td>PF Access</td>
<td>For security purposes, you can limit the PFs an examiner may access. See the topic &quot;Limit Access to a PF&quot; for more information.</td>
</tr>
</tbody>
</table>

**Editing User Information**

The User Information dialog box displays information about a registered user of the LXSoftware.
Adding a user
1. Type an ID in the User ID field. You may use up to 10 characters.
2. Type the user's full name in the User Name field. You may use up to 50 characters.
3. Type a password in the Password field. You may use up to 20 characters; however, the password must be at least six characters.
   
   **Note:** Only alphanumeric characters are allowed (i.e., characters and numbers).

4. Retype the password in the Password Verification field.

5. Check the user's Access Privilege:
   
   - **Examiner:** Lowest access authority. Examiners may perform all core functionality; however, they can be denied access to those PFs restricted to a specific examiner.
   
   - **Supervisor:** Same privileges as an Examiner, but allowed access to all PFs.
   
   - **Administrator:** Highest access authority. In addition to Examiner privileges, system administrators may edit the user list, view the audit trail, establish certain system settings, and view any PF in the system.

6. Click the Add button.
Register fingerprint

To allow users to login to LXSoftware with their fingerprint instead of their user credentials, users must first register their fingerprint within the User List dialog. To register a fingerprint, click the Fingerprint checkbox.

User Fingerprint Scan

A fingerprint may be scanned that allows a registered LXSoftware user to logon simply by scanning his or her fingerprint without entering a user ID and password.

Tip: Click on a setting to see a brief description at the bottom of the window.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fingerprint Display</td>
<td>The user’s scanned fingerprint is displayed here.</td>
</tr>
<tr>
<td>Accept</td>
<td>Select this button to accept the scanned fingerprint as the user’s logon fingerprint.</td>
</tr>
<tr>
<td>Decline</td>
<td>Select this button to decline using the scanned fingerprint as the user’s logon fingerprint.</td>
</tr>
<tr>
<td>Retry</td>
<td>Select this button to clear the fingerprint and restart the fingerprint scanning process.</td>
</tr>
</tbody>
</table>

**Limit Access to a PF**

At any time, you can grant one examiner access to a specific PF and deny all other examiners access to that PF.

*Note:* Users with Administrator or Supervisor status can always access any PF.

To limit access to an open PF:

1. From the User List window, click the **PF Access** button. The PF Access dialog box appears.
Note: Since you are limiting access to a specific PF, that PF must be open.

2. Type the User ID of the examiner to whom you want to grant access authority. All other users with Examiner status will not be able to access this PF.

3. Click OK to grant authority to this examiner. Click Cancel to ignore the change.

Working with the Audit Trail

The audit trail lets you view a record of all Lafayette Polygraph System activities. The audit trail is available only if the security option is enabled and only if you're a system administrator.

To view the audit trail file:

1. Select Audit Trail from the System menu. The Audit Trail window appears:
Note: To filter out unnecessary information, you can limit what appears in the audit trail window.

**Configuring the Audit Trail**

To limit the list of audit trail entries by user ID, event type or date/time:

1. From the Audit Trail window, click the **Configure** button. The **Configure Audit Trail** dialog box appears.
2. Make your selections.

3. Click **OK** to save your selections. Click **Cancel** to ignore them. You return to the Audit Trail window.

### Exiting the Lafayette Polygraph System

Upon exiting, the application automatically closes any open windows and saves the PF information (polygraph file) to disk.

**Note:** Never turn off the power to the PC without first logging off. Doing so may destroy data or damage the disk drive.

To log off the system:

1. Select **Logoff** from the **File** menu. A confirmation dialog box appears, prompting you to verify you want to log off.

2. Select the **Logoff** button. When you log off, the Logon dialog box appears. You can either choose **Quit** to exit the system or do nothing and let another user log on.

**Tip:** To save a step: if you know you want to exit the system, choose **Exit** from the **File** menu instead of **Logoff**.

### Troubleshooting

- **Select a PF for Chart Recording dialog box**
- **Select an Exam for Chart Recording dialog box**
General Problems

During the self-test, a dialog box appears stating the DAS is not available:

Ensure the cabling between the DAS and workstation has been connected properly. Ensure that the correct DAS type is specified in the Administrator Preferences.

The password is not accepted as entered:

Check with the System Administrator and validate the user ID/password pair. Check spelling.

Cannot deactivate screen lock function with the password as entered:

The password entered does not correspond to the user ID displayed in the dialog box. Re-type the password or contact the System Administrator to verify the user ID/password pair.

One or more sensor data lines fail to appear even though the subject is hooked up:

Make sure the sensor connectors are firmly in place for each of the DAS connectors. Select the center button on the Chart toolbar to center traces around the sensor controls.

All chart lines appear normal on the screen except the cardio trace:

Make sure the cardio bladder has been inflated. Check that the cardio pressure is between 50 mmHg and 135 mmHg.

PF files cannot be moved to the secondary drive:

Make sure the disk is not locked (i.e., write-protected). Remove the disk and make sure the write-protect tab is closed (unlocked).

A dialog box appears stating a certain PF is corrupt:

Contact the System Administrator to archive that PF file to floppy disk or CD. Contact your distributor or Lafayette Instrument Company for instructions on recovering information stored in the PF.

A dialog box appears stating the command could not be completed because there is not enough memory:

Close any open charts or other files and try the operation again. If scoring, choose fewer charts to score simultaneously.

A dialog box appears stating memory is low and some commands are disabled:

Close any open charts or other files and try operation again.

Information is sent to the printer but there is no printer output:

Ensure the printer is turned on and is online. Check the printer paper supply.